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What is a WebCTRL® system? 

The WebCTRL® building automation system offers an intuitive user interface and powerful tools to help 

facility managers keep occupants comfortable, manage energy conservation measures, identify key 

operational problems, and analyze the results. The web-based WebCTRL® system can be accessed 

from anywhere in the world through a web browser. On a workstation or mobile device, you can perform 

building management functions such as:  

 adjust setpoints and other control parameters 

 set and change schedules 

 graphically trend important building conditions  

 view and acknowledge alarms 

 run preconfigured and custom reports on energy usage, occupant overrides, and much more    
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A typical WebCTRL® system 

A WebCTRL® system uses a network of microprocessor-based controllers to control heating, air 

conditioning, lighting, and other facility systems. A web-based server communicates with these 

controllers and generates the WebCTRL® interface that the user can access through a web browser. 

Through the interface, you can gather information, change operating properties, run reports, and 

perform other building management functions on a single building, an entire campus, or a network of 

facilities that stretch around the globe. 

   

  

A typical WebCTRL® system may include: 
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The WebCTRL® client uses a web browser to access the WebCTRL® Server application as a website. 

Access and security options may include: 

 

 

 

 
 

WebCTRL® editions and optional packages 

A WebCTRL® system is available in 3 editions:  Standard, Advantage, and Premium.  

  

 WebCTRL® edition 

 Feature Standard Advantage Premium 

Unlimited simultaneous users    

Multiple operating systems and databases    

Mobile devices    

Custom graphics and dashboards for equipment, system, 

floorplan and campus visualization 
   

Alarms    

The following alarm actions: 

 Send SNMP trap  

 Web service request 

 Write property  

 Write to database  

 Requires 

Advanced 

Alarming 

Package 

Requires 

Advanced 

Alarming 

Package 

Trends    

Hierarchical schedules    
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 WebCTRL® edition 

 Feature Standard Advantage Premium 

Time-lapse    

Third-party integration    

Secure server access using TLS    

International languages (International English, Brazilian 

Portuguese, Canadian French, French, German, Italian, 

Japanese, Korean, Russian, Traditional and Simplified 

Chinese, Spanish, Swedish, Thai, Vietnamese) 

   

Reports:    

     Run preconfigured reports    

     Schedule reports    

     Import custom reports    

     Create custom reports (current and legacy) 

     
 Requires 

Advanced 

Reporting 

Package 

 

Discovery and communication with Carrier Open and 

CCN controllers 
 Requires 

WebCTRL® 

Superset 

Package 

Requires 

WebCTRL® 

Superset 

Package 

Points (all input and output points regardless of vendor) 200 500 Unlimited 

Supports licensed add-ons   *  

Advanced security features  Requires 

Advanced 

Security 

Package 

Requires 

Advanced 

Security 

Package 

    

 

  

*  Does not support the Automated Demand Response add-on. 

 

 

 

 

 

 

 

Optional WebCTRL® packages 
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Package Features 

Advanced Reporting* Report Manager that lets you create: 

  Custom reports 

  

A legacy-style report designer for creating the following reports: 

 Equipment Values (page 145) 

 Trend Samples (page 147) 

  

Advanced Security  Location-dependent operator access (page 158) 

 Requirement of operator comments and operator verification prior to 

accepting system changes (page 161) 

  

Advanced Alarming The following alarm actions: 

 Send SNMP Trap (page 79) 

 Web Service Request (page 81) 

 Write Property (page 82) 

 Write to Database (page 83) 

In addition to running an alarm action when an alarm or return-to-normal 

occur, alarm actions can be set to run:  

 After a delay period  

 Based on a schedule group's occupancy status 

WebCTRL® Superset Allows discovery of and communication with Carrier Open and CCN 

controllers. 

Multi-CCN Allows for mulltiple CCN Bus 0's for a WebCTRL system that has the 

WebCTRL Superset optional package. See the CCN Integration Guide for 

information on using this feature. 

  

*  These features are included in WebCTRL® Premium. This package can be purchased for WebCTRL® 

Advantage.  

  

NOTES   

 An optional package is enabled when you install a license (page 191) that provides the optional 

package. 

 What you can see and do in the WebCTRL® interface depends on your system's edition, optional 

packages installed, and which privileges have been assigned to you. 

 

 

 

 

 

 

 

 
 

WebCTRL® tools 

A WebCTRL® system includes the following tools. 
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Design Tools 

Use... To... 

EIKON® Create control programs and Properties pages. 

ViewBuilder Create graphics, touchscreens, and BACview® screens. 

SiteBuilder 

 

Create and modify the system database and associate control 

programs and graphics with equipment. 

Third-Party BACnet Utility Use discovered BACnet information to choose and address 

microblocks for third party BACnet integration. 

EquipmentBuilder Generate the following files from a library of pre-defined 

applications.  

 Control program (.equipment) 

 Graphic (.view) 

 BACview® file (.bacview), if applicable to the equipment 

 Sequence of operation (.odt) 

 Visio schematic (.vdx) 
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Start-up, Commissioning, and Service Tools 

Use... To... 

Field Assistant Service or start up and commission a piece of equipment or a 

partial network of controllers. 

Test & Balance Calibrate airflow in VAV zone controllers, commission air 

terminals, and override reheat and terminal fans. 

Virtual BACview® Let your laptop serve as a local interface to a single piece of 

equipment.  
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What's new in v7.0 

What's new in the WebCTRL® application 

   

Feature Improvement 

v7.0 cumulative patch #3  

Color maps (page 127) When a color map graphic is viewed in Time-Lapse, the color map will 

now ignore report data and show thermographic colors. 

v7.0  

Custom reports (page 105) Custom reports are now created and managed through the new Report 

Manager. 

You can export one or more custom reports to a file so that they can be 

imported into another system. 

A custom report can provide data for the following new items on a 

Graphics page: 

 Data table (page 128) 

 Chart (page 132) 

 Color map (page 136) 

See What's new in the ViewBuilder application (page 3) for more 

information on the above items. 

NOTES   

 Data in a data table, chart, or color map does not change when the 

graphic is viewed in Time-lapse. 

 To support upgraded systems, you can still create and access 

legacy (v6.5 and earlier) custom reports (page 143). 

Scheduled Reports (page 

142) 

You can set up a report to run on a recurring basis. The report is saved 

as a file (PDF, CSV, or XLS), and you can choose to have it automatically 

emailed to someone. 

Default Email Server 

Configuration settings 

(page 181) 

The Email Server Configuration settings, used by scheduled reports and 

the Send Email alarm action, are now located on the System Settings > 

General tab. 

Send Email alarm action 

(page 77) 

This alarm action can use the default Email Server Configuration 

settings defined in System Settings, or you can enter settings specific 

to the alarm action.  

New FDD alarm categories 

(page 92) 

The WebCTRL® application now has two new alarm categories, FDD 

Comfort and FDD Energy. 

Send Web Service Request 

alarm action (page 81) 

This new alarm action sends a web service request to a third-party 

server when an alarm occurs. 

Disabling the Schedules 

feature (page 181) 

You can disable the Schedules (page 43) feature in System Settings so 

that Schedules are no longer visible in the WebCTRL® interface for 

systems that do not use them. 
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Feature Improvement 

Improved Foreign Device 

Registration 

If your system requires that WebCTRL® be registered as a foreign 

device to a BBMD, you can now define a second BBMD in case the first 

one fails. 

System Statistics (page 

181) 

The System Statistics button on the General tab of System Settings now 

includes the following totals: 

 Number of controllers 

 Number of controllers that can run control programs 

 Number of points, regardless of vendor 

Re-authentication of 

operator for 21 CFR Part 

11 (page 161) 

If an operator is required to record a reason for making system 

changes, the operator is now required to re-enter their system 

password in the box where they record the changes. 

Run External Program 

alarm action (page 73) 

This alarm action can now be set up only when running WebCTRL® 

Design Server. 

Add-ons (page 189) By default, the WebCTRL® application now allows only signed add-ons 

that are supported by Automated Logic®. This default can be 

overridden in SiteBuilder. See What's new in the SiteBuilder application 

(page 4). 

NOTE  Some previously installed add-ons may not run after upgrade. 

See the "After the upgrade" in the WebCTRL® v7.0 Upgrade Guide for 

conditions and solutions. 

Security enhancements  The WebCTRL® login page no longer shows customer identifying 

"Licensed To" and "For use at" information, but the customer 

information is still available in the About WebCTRL box. 

 Apache Tomcat web server has been upgraded to v7.0.82. 

 The WebCTRL® application has been upgraded to Java 8 update 

144. 

64-bit server The WebCTRL® v7.0 application will run only on a server with a 64-bit 

operating system. If you have a previous WebCTRL® version that is 

running on a 32-bit server, you will need to upgrade your server before 

installing v7.0. 

2 new optional packages 

(page 3) 
 The WebCTRL® Superset package allows the discovery of and 

communication with Carrier Open and CCN controllers. 

 The Multi-CCN package allows for multiple CCN Bus 0's for a 

WebCTRL® system that has the WebCTRL® Superset optional 

package. See the CCN Integration Guide for information on using 

this feature. 

WAP device support This has been removed from the WebCTRL® application. Smart phone 

support introduced in v6.5 replaced this functionality. 
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What's new in the ViewBuilder application 

  

Feature Improvement 

v7.0 cumulative patch #3  

Color maps When a color map graphic is viewed in Time-Lapse, the color map will 

now ignore report data and show thermographic colors. 

v7.0  

Data tables (page 128) 

and charts (page 132) 

These new controls on a Graphics page pull data from a WebCTRL® 

report. The chart control allows you to specify a line chart, pie chart, 

horizontal bar chart, or vertical bar chart.  

    

               Data table                               Vertical bar chart 

Color maps (page 136) A Graphics page color map shows specified colors for various conditions 

that are defined in a WebCTRL® report.  

 

Default graphic size The default graphic size in ViewBuilder is now 1666 x 849 pixels. 

Local Variables ViewBuilder now preserves local variables through cut/copy and paste, as 

well as when importing a .viewsymbol. 

Layers   ViewBuilder now preserves layers when importing a .viewsymbol.  

 If cutting/copying a selection assigned to layers, you must hold Shift 

while pasting in a new file to preserve layer assignments. 
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Feature Improvement 

Downloading a Custom 

Equipment Touch file 

If a .touch file contains many screens or large images that cause the file 

to become too large for the controller's memory, you can download only 

the name of the .touch file to the controller instead of the entire file. You 

will then need to manually copy the .touch file to your device. 

  

 

 
 

What's new in the SiteBuilder application 

  

Feature Improvement 

v7.0 cumulative patch #3  

Hierarchical systems You can now add a link from one child system to another child system so 

that the second child system appears in the first child system's 

navigation tree. 

HTTP redirect to HTTPS If you enable web server ports for Both HTTP and HTTPS, you can 

optionally elect to have HTTP requests automatically redirected to 

HTTPS.  

v7.0  

Improved security settings To increase security, the WebCTRL® application defaults to the following 

settings: 

 If your system is set to use TLS, the WebCTRL® application 

automatically uses TLS 1.2. 

 The WebCTRL® application requires SOAP applications to run over 

HTTPS. 

 The WebCTRL® application allows only add-ons that have been 

approved by Automated Logic®. 

NOTE  If needed, you can override these defaults in SiteBuilder; 

however, doing so will lessen the security of your system. 

  

 

 
 

What's new in the EIKON® application 

 

Feature Improvement 

Support for the following new optional features has been added to EIKON®. When released, you can 

download them from https://accounts.automatedlogic.com/dowload under Software Products and 

Updates > v7.0 installs and updates. 

Improved Edit Order Provides more flexibility and reduces the time needed to create 

property pages for equipment.  

Translation Assistance Tool Simplifies the process of creating non-English control programs. 
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Running WebCTRL® Server 

The WebCTRL Server application communicates with the system's controllers and accesses and 

maintains the system database. You view and edit the system in client web browsers. WebCTRL Server 

must be running for an operator to log in from a web browser. 

The application's Current Users, Connections, and Output tabs let you monitor the status of the system. 

Output information is continually archived to WebCTRLx.x\logs\< date >\core.txt. 

  

NOTE  The instructions below are for a system that has been designed and set up. While designing a 

system, you can run the WebCTRL® application without communicating with the system's controllers. 

See Options for running a WebCTRL® system. 

 

 
 

To start the WebCTRL® system 

1 Click Start > All Programs > WebCTRL x.x > WebCTRL Server. 

 TIP  If you run the WebCTRL Server application as a Windows® service, your computer can 

automatically start the application every time the computer starts. See Running WebCTRL Server 

as a Windows service (page 198). 

2 Open a web browser on one or more client computers. 

3 Verify that your web browser is set up to display the WebCTRL® interface. See Setting up 

WebCTRL® client devices and web browsers (page 174). 

4 Type the WebCTRL® server's address in the web browser's address field.  

NOTE  You can type http://localhost if WebCTRL Server and the web browser are running 

on the same computer. 

5 Enter a Name and Password. 

 

 
 

To send a message to logged in operators 

Messages are delivered immediately to WebCTRL® client web browsers. You can send multiple 

messages, but the operator must click Ok for the first message before the next message can be 

delivered. If the web browser window is minimized, the message is not visible. 

1 On the WebCTRL Server application's Current Users tab, click  beside the user you want to 

send a message to. Or, click Notify All Users. 

2 Type a message. 

3 Click OK. 

 

 
 

To log off an operator 

From the WebCTRL Server application 

NOTE  The operator will be logged off without warning. 

1 On the WebCTRL Server Current Users tab, right-click the operator, then select Log Off User. 

2 Click Yes. 
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From the WebCTRL® interface 

NOTE  The operator will be logged off without warning. 

1 In the WebCTRL® interface, press Ctrl+M. 

2 Type whoson in the manual command field. 

3 Obtain the ID number of the operator you want to log off. 

4 Press Ctrl+M. 

5 Type logoffuser x (where x is the ID number). 

6 Click OK. 

 

 
 

To shut down a system 

1 In the WebCTRL Server application, select Server > Shut Down. 

2 Optional:  Select a delay option, then edit the Notification message. 

3 Click Shut Down. 
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Getting to know the WebCTRL® interface 

  

Computer and large-screen mobile interface 

 

 
 

Small-screen mobile interface 

Most of the WebCTRL® interface is the same on small-screen mobile devices except for the differences 

shown below. 
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 When you click  to hide the tree, the button changes to . 

 Help and Print are in the  menu. 

  

  

NOTES 

 After you log in, you will see the page defined as your starting location on the My Settings page. To 

change your opening page, see To change My Settings (page 156). 

 Privileges control what an operator can see or do in the WebCTRL® system. If you cannot see or do 

something that you read about in Help, ask your System Administrator to check your privileges. 

 

 
 

Navigation trees 

The WebCTRL® interface has 4 navigation trees. 

Geographic tree 

This tree lets you navigate through the WebCTRL® interface using the system's geographic layout. 

Network tree 

This tree lets you navigate through the WebCTRL® interface using the system's network layout. 

Schedule Groups tree 

On this tree, you can create groups that can consist of areas, equipment, or other groups. You can then 

assign a schedule to the entire group instead of the individual items. See To apply a schedule to a 

group of items (page 45). 

System Configuration tree 

Most of the items on this tree are used for the setup and maintenance of your system.  

  

My Settings Lets you change settings that are specific to you such as your password, 

viewing preferences and contact information. See To change My Settings 

(page 156). 

System Settings Contains the system-wide settings that control the way the WebCTRL® 

system runs. See System Settings (page 181). 

Operators 

Privilege Sets 

Operator Groups 

Lets your system administrator define operators and what they can see 

and do in the WebCTRL® interface. See Operator access (page 149). 

Categories Lets you define categories for schedules (page 49), alarms (page 92), 

graphics (page 20), properties, trends (page 57), and reports (page 126). 

Categories allow you to view or control groups of similar items. 

Scheduled Reports Shows any report that was scheduled on the report's page. See To manage 

scheduled reports (page 143) for details. 

Alarm Templates See If you upgraded alarms from v2.0 or earlier (page 94). 
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Connections Lets you set up, start/stop, and troubleshoot your network connections. 

See Setting up networks. 

Services Shows internal processes of the WebCTRL® application for 

troubleshooting. 

License Administration Lets you update your WebCTRL® license. See To register your WebCTRL® 

software (page 191). 

Update Click Update to select and apply patch, service packs, drivers, language 

packs, graphics libraries, and Help updates. 

Hierarchical Servers If your system has hierarchical servers, this page shows the servers that 

your server is connected to. 

Client Installs Lets you install applications that are to run on client computers. 

 

 
 

Navigating the system 

NOTE  Use only the WebCTRL® interface to navigate; do not use the web browser’s navigation buttons. 

  

To navigate to an item in the system 

1 Select an item on the Geographic  or Network  tree. 

NOTE  The Schedule Groups  and System Configuration  trees are used to set up your 

system. 

2 Use the action buttons and their drop-down menus to navigate to specific types of information 

about the selected tree item. 

3 Use the tabs to filter the information further. 

 

To navigate using links  

Click links to jump to related pages. 

  

On a Graphics page On a Properties page 
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Tree icons and hover text 

The navigation tree displays an icon to the left of each item to denote the type of item. For example: 

  System   Area       Equipment 

To select custom equipment icons in the WebCTRL® interface, right-click the equipment on the 

Geographic  or Network  tree, select Configure, then select the Icon. You can also select 

custom icons in the EIKON® application. 

  

Optional icons  

You can display the following icons to denote locations on the Geographic  tree where items were 

created or assigned. 

  Schedules 

 

  Schedule Groups 

  Trend Graphs 

 

  Reports 

  Alarm Actions 

 

  Privileges 

  

To turn on optional icons: 

1 Right-click the Geographic  tree. 

2 Select Tree Display Options. 

3 Select the desired Tree Icons. 

4 Click Accept. 

  

Optional hover text 

If you turn on hover text, you can hold the cursor over a system, area, or equipment icon to display 

information about its item. The information displayed depends on which hover text options you select. 

  

 

  

To turn on hover text: 

1 Right-click the tree. 

2 Select Tree Display Options. 

3 Select the desired Tree Hover Text. 

4 Click Accept. 
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To show, hide, or resize the navigation tree 

  

On a computer or large screen mobile device 

Click  at the top of the navigation tree to hide or show the tree.  

Click and drag the tab on the right side of the tree to adjust its width. 

 

 

  

On a small-screen mobile device 

Touch  at the top of the navigation tree to hide the tree. Touch  to 

show it. 

Double-tap the arrow on the right side of the tree to widen the tree. Double-tap again to return to the 

original size. 

 

 

 
 

Zooming in and out 

On a computer 

 To zoom in and out on the WebCTRL® interface: 

○ Hold down Ctrl and press + or -. Press Ctrl+0 to return to 100%. 

○ Hold down Ctrl while rolling your mouse wheel. 

○ Use your web browser's zoom functions. 

 If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the 

action pane. Select Scale to Fit again to return the graphic to its original size.  
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On a mobile device 

Apple® iPad and iPhone 

 Double-tap to zoom in/out. 

  

Microsoft® SurfaceTM 

 Pinch-zoom works on individual frames, instead of the whole screen. So, you can zoom and scroll 

the navigation pane and action pane separately. 

 If browser text is too small, use Ctrl + to increase Internet Explorer's zoom level, then reload the 

page. 

 

GoogleTM NexusTM and Nexus Lumia  

 Pinch-zoom to zoom in/out. 

 

 
 

Using right-click menus 

  

On a computer  

You can right-click the following items to select options: 

 

A tree item  The action pane 
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A property A trend 

 

 

  

On a mobile device 

To access the right-click menu for: 

 A tree item–Select the item first, then touch and hold the item for several seconds. 

 The action pane–Touch and hold the item for several seconds. 

NOTE  For iPhones and iPads, touch and hold your finger on the item to bring up the right-click menu, 

then drag your finger to the menu option that you want without lifting your finger.  

 

 
 

To print the action pane 

  

On a computer 

Click  at the top of the page to print the contents of the action pane. Set the print orientation to 

Landscape in the Print dialog box.  

 TIP  To print a Graphics page that exceeds the size of the action pane, right-click the graphic and 

select Scale to Fit. 

   

On a mobile device 

Touch  and then select Print. 
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Colors and status in the WebCTRL® interface 

The following colors indicate equipment status on floor plans, equipment property pages, and some 

reports.  

  

Color Color Name Status Code Condition Indicated 

 Mustard none In equipment when running WebCTRL Design Server 

 Purple 0 or 15 In a controller—non-operational or no 

communications 

In equipment—a hardware or software error 

 Charcoal 14 In a controller—a download is required or is already in 

progress 

In equipment—a controller has stopped 

 Coral 13 Control program error 

NOTE  If a zone controlled by a U line controller 

shows coral on a floorplan, the controller may be 

offline. 

 Red 2 or 9 Heating or cooling alarm 

 Orange 8 Maximum cooling 

 Dark blue 3 Maximum heating 

 Yellow 7 Moderate cooling 

 Light blue 4 Moderate heating 

 Gray 1 Unoccupied/inactive 

 White 10 Occupied/active 

 Light green 6 Free cooling 

 Green 5 In a controller—operational or operational read only 

In equipment—No heating or cooling 

 

 
 

Colors and setpoints 

Thermographic colors indicate how much a zone’s actual temperature differs from its setpoints.  

Five conditions may affect a zone’s thermographic color:  

 Setpoint adjust 

 Timed local override (TLO) 

 Optimal start 

 Demand level 

 Hysteresis 

In the examples below, a zone’s heating occupied setpoint is 70° and its cooling occupied setpoint is 

74°. 
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If you 

normally 

see... 

when the zone 

temp is... 

but... then you will 

see... 

green 

 

72.5° someone adjusts the setpoints (for example, with a 

setpoint adjust of two degrees, the new setpoints 

would be 68 and 72°) 

yellow 

 

gray 

 

73° 

(unoccupied) 

someone presses the Override button on a zone 

sensor to use the occupied setpoints 

green 

 

gray 

 

77° 

(unoccupied) 

the zone is in optimal start and is ramping up to its 

occupied setpoint in the few hours before occupancy 

an occupied 

color 

yellow 

 

75°  the zone’s electric meter is in demand level 2 with 

relaxed setpoints of 68 and 76° 

green 

 

green 

 

73.5° cooling began when the temperature rose above 74° 

and the temperature has not yet dropped beyond the 

1° hysteresis (to 73°) 

yellow 
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Working with equipment 

You can view and adjust equipment operation from the following pages: 

  

 

Graphics pages (page 17) 

You can view and adjust your essential building 

controls on most Graphics pages. 

 Thermographic floor plans indicate the 

temperature of zones compared to their 

effective setpoints. 

 

 Equipment graphics show the current 

status of mechanical equipment and often 

include an adjustable setpoint control or 

other editable properties. 

 

Properties pages (page 22)  

Each piece of equipment and each microblock 

has a Properties page. You can view and adjust 

more equipment properties on a Properties 

page than on its corresponding Graphics page. 
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Logic pages (page 25)  

Logic pages show the control program for a 

piece of equipment. Use the sequence of 

control and yellow status values on the Logic 

pages for troubleshooting your mechanical 

equipment. 

 

Microblock pop-ups 

To open a microblock pop-up where you can 

view and change properties: 

 Click a microblock on a Logic page. 

 Click the bold, underlined microblock name 

on a Properties page. 

 Right-click a value and then select Details. 

  

 

 
 

Graphics pages 

You can view and adjust your system from Graphics pages, which include navigation maps, floor plans, 

and equipment. 

 

Some typical items that may appear on a graphics page are: 

 Button or switch to turn equipment on or off 

 Input field to set a property value 

 Drop-down list to select a state 
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 Interactive zone sensor to override an unoccupied schedule 

 Setpoint graph to adjust setpoints (page 37) 

 Trend graph to view trend (page 52) information 

 Link to jump to another WebCTRL® page or to the Internet  

 A data table, chart, or color map that pulls information from a custom report (page 127).  

NOTES 

 Right-click a value, then select Details to view and change properties in the microblock pop-up.   

 Right-click a value, then select Global Modify (page 27) to view and change the property in other 

control programs.   

 A yellow dashed box around a value indicates the value is locked.  

 If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the 

action pane. Select Scale to Fit again to return the graphic to its original size. 

 When a chart that is based on a report is displayed on a Graphics page, you can hover over various 

points on the chart to see values. You can also click on each item in the legend to turn that 

information on and off. See Using a custom report as the source for a Graphics page (page 127) 

for more information on a chart. 

  

 

 
 

To attach a graphic in the WebCTRL® interface 

1 On the navigation tree, right-click the item that you want to attach a graphic to, then select 

Configure. 

2 Equipment graphic only:  If the system has other control programs of this type, select which control 

programs you want to change.  

 

NOTES   

○ If the control program is in an IP router, the second option will change the graphic for all 

control programs of this type only on the IP network. 

○ If the control program is on the network below an IP router, the second option will not change 

the graphic for the router's control programs of this type. 

3 Do one of the following: 

  

If the graphic is...  

In the Views Available list a.  Select the graphic, then click Attach. 

b.  Click Accept. 
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If the graphic is...  

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 NOTES   

 Select a graphic in the Attached list to edit the following information for the graphic: 

○ Display Name–The name that appears in the Graphics button drop-down list 

○ Category–The name of the category that multiple graphics may be sorted into in the Graphics 

button drop-down list 

NOTE  Changes to Display Name or Category apply only in the WebCTRL® interface and are 

not retained if you export source files. 

○ Reference Name–The name that is used to create links to the graphic in ViewBuilder 

○ Default View–Sets the selected graphic as the default view if the tree item has multiple 

graphics. The default graphic is bolded in the Attached list. 

NOTE  The default graphic is initially set in SiteBuilder. 

○ Included in download–Equipment graphics only. Select to have the .view file included in an All 

Content download so that it can be uploaded by Field Assistant. The graphic will have  

beside it in the Attached list. Requires 4.x or later drivers.  

  

 You can click Delete Unused at the bottom of the Views section to delete all unattached graphic 

files from your system. 

 

 
 

To edit a graphic on a WebCTRL® client 

On a WebCTRL® client, you can get a copy of a graphic from the server, edit it, then put it back on the 

server. 

  

To get the graphic  

1 On the WebCTRL® Geographic  tree, right-click the item that the graphic is attached to, then 

select Configure. 

2 At the bottom of the Views section, click Edit Existing. 

3 Select the graphic you want to edit. 

4 Click Save 

5 Browse to the folder you want to put the file in. 

6 Click Save. 

7 Click Close. 

8 Click Close again. 

  

To put the edited graphic back on the server 

1 On the WebCTRL® Geographic  tree, right-click the item that the graphic is attached to, then 
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select Configure. 

2 At the bottom of the Views section, click Add New. 

3 Browse to select the .view file. 

4 Click Open. 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 

 
 

To organize multiple graphics for a tree item 

In the WebCTRL® interface, you can create categories and assign graphics to them so that the 

Graphics button drop-down menu has the graphics arranged by category. This is typically done in 

ViewBuilder or SiteBuilder. See "To define WebCTRL® navigation" in ViewBuilder Help and "To attach 

graphic files" in SiteBuilder Help. 

  

To add a Graphics category in the WebCTRL® interface 

1 On the System Configuration  tree, click    to the left of the Categories folder, then select 

Graphic. 

2 Click Add. 

3 Type the Category Name and Reference Name. 

4 Optional:  Select a privilege so that only operators with that privilege can access graphics in the 

category. 

5 Click Accept. 

  

NOTES   

 To edit a category, select the category, make your changes, then click Accept. 

 To delete a category, select the category, click Delete, then click Accept. 

  

To assign a graphic to a category in the WebCTRL® interface 

1 On the Geographic  tree, right-click the item that the graphic is attached to, then select 

Configure. 

2 Under Views, select the graphic in the Attached list. 

3 Select the category in the Category field. 

4 Click Accept. 
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To control equipment using an interactive zone sensor 

An equipment graphic may include an interactive zone sensor that provides you with the following 

control.  

 

If the sensor is a...      You can... 

ZS  

 
  

  

 Click  to raise the setpoint or  to lower the setpoint.  

 Click    to override the schedule and put the zone in an occupied 

state. To cancel an override, continue clicking  until the display 

shows 0. 

 See that the zone is in an occupied state when the green LED is lit. 

 

RS Standard, Plus, or Pro  

 
  

  

 Click the WARMER or COOLER button to adjust the setpoint.  

 Click the MANUAL button to override the schedule and put the 

zone in an occupied state. 

 Click the INFO button to cycle through the following information: 

 Outside air temperature, if enabled in the control program 

 Override time remaining 

 Heating setpoint 

 Cooling setpoint 

 See the Occupied/Unoccupied state in the display. 
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If the sensor is a...      You can... 

RS Pro-F  

 
  

  

 Click the WARMER or COOLER button to adjust the setpoint.  

 Click the MANUAL button to override the schedule and put the 

zone in an occupied state. 

 Click the INFO button to cycle through information such as: 

 Outside air temperature 

 Override time remaining 

 Heating setpoint 

 Cooling setpoint 

 Click the FAN button to adjust the fan speed. 

 Click the MODE button to perform customer-specific functions. 

 See the Occupied/Unoccupied state in the display. 

  

LogiStat 

 
  

  

 Click  to raise the setpoint or  to lower the setpoint.  

 Click  to override the schedule and put the zone in an occupied 

state. 

 See that the zone is in an occupied state when the red LED is lit. 

 

 

 

 
 

Properties pages 

Properties pages are automatically generated from control programs created in the EIKON® 

application. Use Properties pages to: 

 View the status of a piece of equipment. See Colors and status in the WebCTRL® interface (page 

14).  

 View or change the equipment or microblock properties currently stored in the controller 

 Commission equipment 

 

 
 

To view or edit properties 

1 Select a piece of equipment or a microblock on the Geographic  or Network  tree, then 

click Properties. 

NOTE  You must resolve any condition described in red text at the top of the page before a 

Properties page can obtain current information from its controller. 
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2 To change a property: 

  

 
  

3 Click Accept. 

  

NOTES  

 Right-click a value, then select Details to view and change properties in the microblock pop-up. 

 Right-click a value, then select Global Modify (page 27) to view and change the property in other 

control programs. 

 A yellow dashed box around a value indicates the value is locked.  

 

 
 

Point types 

A point name on the Properties page is followed by a code that tells you the point type. The table below 

describes each code. 

  

         

 

Code Point type 

AI Analog Input 

ANI Analog Network Input 

ANI2 Analog Network Input 2 

ANO Analog Network Output 

ANO2 Analog Network Output 2 

AO Analog Output 

ASVI BACnet Analog Sensed Value Input 
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Code Point type 

AV Analog Value 

BAI BACnet Analog Input 

BALM BACnet Alarm 

BAO BACnet Analog Output 

BAV BACnet Analog Value 

BBI BACnet Binary Input 

BBO BACnet Binary Output 

BBV BACnet Binary Value 

BFM Floating Motor 

BI Binary Input 

BLSTAT LogiStat Zone Sensor with Optional OAT Display 

BMSV BACnet Multi-State Value 

BNI Binary Network Input 

BNI2 Binary Network Input 2 

BNO Binary Network Output 

BNO2 Binary Network Output 2 

BO Binary Output 

BPTA Pulse to Analog Input 

BPWM Pulse-Width Output 

BRS RS Sensor 

BRSF RS Sensor Fan 

BSVI BACnet Binary Sensed Value Input 

BTLO Timed Local Override 

BTRN Trend Log 

BV Binary Value 

DI Digital Input 

DO Digital Output 

EVT BACnet Alarm 

LAN AI LAN Analog Input 

LAN AO LAN Analog Output 

LAN DI LAN Digital Input 

LAN DO LAN Digital Output 

LSTAT LogiStat Zone Sensor 

POLLAVG Average Analog Properties 
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Code Point type 

POLLMAX Maximum Analog Properties 

POLLMIN Minimum Analog Properties 

POLLTOT Total Analog Properties 

PTA Pulse to Analog Input 

TLO Timed Local Override 

 

 
 

Logic pages 

The Logic page shows the control program for a piece of equipment. The live data (yellow text) is 

updated every few seconds and when you click the Logic button. The control program uses exact 

property values for its calculations, but values are rounded to 2 decimal places when displayed on the 

Logic page. 

 TIP  Click anywhere on the Logic page, then use your keyboard's Page Up, Page Down, and arrow 

keys to scroll through the page. 

NOTE  If you find an unexpected value on a Properties page or a Logic page, you can use the Logic page 

to troubleshoot. 

 

 
 

To view a Logic page 

1 Select a piece of equipment on the Geographic  or Network  tree. 

2 Click Logic. 

3 Click a microblock to view its details. 

 

 
 

To locate a microblock, section, or label 

1 Right-click the Logic page, then select Jump To. 

2 Do one of the following: 

○ On the Microblock or Section tab, select an item to have it located and highlighted. 

○ On the Label tab, select a label to display a reduced logic page outlined in yellow that shows all 

instances of the label. A red box indicates an output label; a yellow box indicates an input 

label. Click a red or yellow box to jump to that label in the full-size logic page. 

 

NOTE  You can also click a label on the full-size Logic page to display the reduced Logic page.  

 

 
 

To change properties, alarms, or trends 

1 Click a microblock on the equipment’s Logic page. 

2 In the microblock pop-up, click the Properties, Alarms, or Trends button. 
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3 Change properties, alarms, or trends for that microblock in the same way that you would make 

changes on a regular Properties (page 22), Alarms, or Trends (page 52) page. 

4 Click Accept. 

  

NOTE  Right-click a value, then select Global Modify (page 27) to view and change the property in other 

control programs. 

 

 

 

 
 

Using a Logic page to troubleshoot 

The WebCTRL® application monitors your system and provides feedback. If you get unexpected 

feedback, you can use a Logic page as a troubleshooting tool. On the Logic page, work your way 

backward (right to left) through the sequence in the control program to discover what caused the 

problem. See Microblock Reference to understand what each microblock in the sequence is doing. 

  

Unexpected feedback Possible cause 

Space temperature reads 

excessively high or low 
 The sensor has a short (or open) circuit. Verify wires are 

properly connected at the sensor and controller. 

 A sensor is missing or configured incorrectly. Open the sensor 

or input microblock from the Logic page to verify its 

configuration. 

Equipment displays an 

unexpected color - effective 

setpoints are different than the 

programmed setpoints 

NOTE  Equipment operates using effective setpoints. Open the 

Setpoint microblock from the Logic page and check the following: 

 Hysteresis 

 Demand Level 

 Optimal Start 

 Timed Local Override (TLO) 

 Setpoint Adjust 

Gaps in trend data on trend 

graph 

Usually gaps result if network communication was disrupted or a 

point was temporarily disabled. 

If the gap is not the result of interrupted communication, send 

reports more frequently. From the Logic page, open the trend 

microblock that displayed the gap in data, then decrease the 

notification threshold so that it is approximately 40% of the buffer 

size (allocated memory size) for that microblock. 

The WebCTRL® application is 

not receiving alarms from a 

BACnet alarm microblock 

Locate the microblock on the Logic page. If the color square on the 

microblock is black, the alarm is disabled. To enable it: 

1 Click the microblock.  

2 In the microblock pop-up, click the Alarms button.  

3 On the Enable/Disable tab, select Potential alarm source. 
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Unexpected feedback Possible cause 

The equipment is on when I 

expect it to be off, or off when I 

expect it to be on 

Use the Logic page to determine whether the program is sending 

an unexpected signal and why, or if the problem is with the physical 

equipment. For example, the On-Off-Auto (OOA) switch on the 

controller for that equipment may be locked in the On (Hand) 

position. 

Sensor value on the Properties 

page does not match the 

reading from handheld sensor 

Calibrate the sensor.  

On the Logic page, check to see if the output point is locked on. 

 

 

 

 
 

Changing multiple microblock properties 

Two WebCTRL® features, Global Modify and Global Copy, allow you to view and change multiple 

microblock properties at the same time. 

 CAUTION  Global Modify and Global Copy are convenient for making widespread changes in your 

system. But, because they do not take into account the operation of individual equipment, your 

changes could produce undesired results in your equipment or system operation. Use with caution 

because these features do not have an Undo function. 

 TIP  Click  to copy a microblock's reference path to the clipboard so you can paste it into 

another field or application. 

 

 
 

To use Global Modify 

Use the Global Modify feature to: 

 View a microblock’s full path, control program name, and the privileges required to change its 

properties. 

 View or change a single property in several control programs at one time. 

 View errors on Graphics and Properties pages. 

  

1 Browse to any page that displays the property you want to view or change. 

2 Do one of the following to open Global Modify: 

○ Alt+click the property (Ctrl+Alt+click if Linux). 

○ Right-click the property and select Global Modify. 
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3 Make changes to the Control Program field, if needed. 

NOTES 

○ Use wildcards in the Control Program field to broaden the search. 

For example: 

vav* matches vav, vav1, vavx, vav12345 

vav*z matches vavz, vav1z, vavxz, vav12345z 

vav*1*2 matches vav12, vavabc1xyz2 

vav?? matches vav11, vav12, vavzz, but does not match vav, vav1, vav123 

* matches any control program 

○ Click Show Advanced to view the location, value, and privileges associated with this property.4 

  

 

  

4 Select the tree item that you want to search under for every occurrence of that microblock in other 

control programs. 

5 Click Find All. 

6 Select the properties in the list that you want to change. 
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7 Do one of the following: 

a) Type a New Value to the right of each selected item. 

b) Select Enable All, type a new value in b, then click Set All To. 

c) Select Enable All, type a new value in c, then click Change All By. 

 

8 Click Apply Changes. 

NOTE  To modify several properties in multiple control programs at the same time, use Global Copy. 

 

 

 
 

To use Global Copy 

Use Global Copy to copy any or all of the following from one control program to other equipment using 

the same control program: 

 Embedded trend graph settings 

 Custom trend graphs 

 Custom reports 

 Other editable properties to other pieces of equipment using the same control program. 

  

1 On the Geographic  or Network  tree, right-click the piece of equipment that has the 

properties you want to copy, then select Copy Control Program Properties. 

2 Click OK when you see This will copy this control programs properties to other control programs of 

the same type. Continue?. This opens the next screen and does not lock in any changes. 

3 In the Global Copy dialog box, select the items that you want to copy. 

4 Select the area on the tree containing similar control programs that you may want to copy these 

properties to, then click Search. 

All instances at that level and below are listed in the expanded lower window. 

5 Check or uncheck items as needed. 
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6 Do one of the following: 

○ Check Skip bad values to copy all values except a bad value (it cannot be copied because you 

do not have the necessary privilege, the property to be copied is undefined, etc.).  

○ Uncheck this field to prevent any values from being copied if a bad value is found. 

7 Click Apply Changes, then close the Global Copy dialog box.  

 

 

 
 

Downloading to controllers 

If you make any of the following changes, you must download the new data from the WebCTRL® 

application to the affected controllers.  

  

In the WebCTRL® 

interface 

 Change or reload a control program 

 Change or reload a driver 

 Change a schedule 

NOTE  A schedule change automatically downloads unless you uncheck 

Automatically download schedules on each change on the My Settings 

page. 

 Change a touchscreen or BACview® file 

 Check or uncheck a .view file's Included in download option 

In SiteBuilder  Add a device 

 Add equipment 

 Change or reload a control program 

 Set an object instance 

 Change or reload a driver 

 Assign or unassign equipment 

 Check or uncheck a .view file's Included in download option 

  

The WebCTRL® application automatically marks the affected controllers as requiring a download. You 

can download these controllers from the Downloads page (page 31) or Properties page (page 32) for 

the controller, the equipment, or a microblock.  

When the WebCTRL® application marks a controller for download, it determines what information 

needs to be downloaded based on the type of information that changed. See Download Options (page 

31). 

  

NOTES   

 A property change in the WebCTRL® interface is automatically downloaded to the controller. If the 

download fails, the controller is added to the Downloads page with the reason for the failure. 

 To see who downloaded a controller last, go to the Network  tree, select the controller, then 

do one of the following: 

○ Go to Reports > Network > Controller Status, then click Run. 

○ View Downloaded by on the Properties page. 

○ Click Module Status on the Properties page. 
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Download Options 

When the WebCTRL® application marks a controller for download, it determines what information 

needs to be downloaded based on the type of information that changed. Below are the options that can 

be downloaded. 

 

This option... Downloads... 

All Content •  The names and executable portion of the driver and control programs 

•  The names and full content of Equipment Touch and BACview® files 

•  The names of any .view files that are marked to be included in a  

    download 

•  Parameters 

•  Schedules 

NOTE  An All Content download also: 

•  Synchronizes the controller's time to the WebCTRL® server. 

•  Overwrites trends in the controller. 

•  Restarts the controller. 

Only Schedules All schedules that are not set for automatic download 

Only Parameters All editable properties 

Only BBMDs BBMD tables (.bdt file) that you have updated but have not yet written to the 

controller 

 

NOTES   

 An All Content download clears trend, history, and alarm data from the affected controllers. At the 

beginning of the download process, trends that have the Trend Historian enabled are saved to the 

system database. 

 You can choose to have the All Content option download the full source files. On the WebCTRL® 

Network  tree, select a controller, then enable Download Source Files on the Properties page. 

 

 
 

To download from the Downloads page 

The Downloads page shows any controllers that the WebCTRL® application marked for download. But 

if needed, you can add other controllers to the list.  

  

To download: 

1 On the Network  tree, select an item to download controllers at and below that item. 

2 Click Downloads.  

3 Click  to the left of a Location to see controllers that require a download. 

4 Optional:  To add controllers to the list: 

a) Click Add. 

b) Select the controller(s). 

NOTE  Use Ctrl+click or Shift+click to select multiple controllers. 

c) Select a Download Option (page 31). 

d) Click Add, then click Close. 
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5 Select the controllers that you want to download.  

NOTES   

○ Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers. 

○ A network's controllers download in the order shown. To change the order, select a 

controller(s), then drag and drop or click Move to Top or Move to Bottom. 

EXCEPTION  If a controller's router requires a download, it will download first regardless of its 

position on the Download page. 

6 Click Start.  

   

NOTES 

 Click Hold to stop pending  downloads. Active downloads  cannot be stopped. 

 Up to 5 routers can download simultaneously. 

 A controller is removed from the list when its download is complete. 

 Icons in the Tasks column indicate the following: 

  

 Active—The WebCTRL® application is downloading to the controller. 

 Pending—You initiated the download, and the controller is waiting for its turn to 

download. 

 Failed—The download failed. See If a controller fails to download (page 32). 

 On Hold—Indicates either of the following: 

•  The controller requires a download 

•  You clicked Hold to stop a pending  download. 

  

 Click  in the upper left-hand corner to view a log of download activity in the current session. 

Copy to Clipboard lets you copy the text to paste it into another application. 

 To remove an item from the download list, right-click the item, then select Remove selected tasks. 

 

 
 

To download from a Properties page 

If a controller requires a download, a red download message and a Download button appear at the top 

of the Properties page for the controller, the equipment, or a microblock. Click the button to start the 

download. 

Downloading from the Properties page downloads All Content to the controller. 

 

 
 

If a controller fails to download 

A controller that fails to download appears on the Downloads page with this icon .  

1 Review the reason for the failure: 

○ Hold your cursor over the failed task to see hover text giving the reason.  

○ Click  in the upper left-hand corner of the page to see information on all failed downloads. 

Copy to Clipboard lets you copy the text to paste it into another application. 

2 Correct the problem that caused the failure. 

3 Select the controller on the Downloads page, then click Start. 
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Checking controller status 

On the WebCTRL® Network  tree, you can select a network, router, site, or the system, and then 

click the Devices button to: 

 View the status of controllers (page 33) 

 View controller information such as address, model, driver, and .view files included in download 

 Download or upload to resolve a mismatch (page 36) 

 Troubleshoot network communication 

 Download or upload files for Field Assistant 

  

NOTES 

 Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers. 

 Click Hold to stop pending  downloads or uploads. Active downloads  or uploads  cannot 

be stopped. 

 Icons in the Tasks column indicate the following: 

  

 Active—The WebCTRL® application is downloading to the controller. 

 Active—The WebCTRL® application is uploading from the controller. 

 Pending—You initiated the download, and the controller is waiting for its turn to 

download. 

 Failed—The download failed. See If a controller fails to download (page 32). 

 On Hold—Indicates you clicked Hold to stop a pending  download. 

  

 Click  in the upper left-hand corner to view a log of activity on the Devices page in the current 

session. Copy to Clipboard lets you copy the text to paste it into another application. 

  

 

 
 

Status messages 

On the WebCTRL® Network  tree, you can select a router, network, site, or the system to view the 

status of controllers. On the Devices page, the Status column shows a description of the controller's 

current state. Hold your cursor over that description to see hover text with a more detailed description. 

If multiple conditions exist, the WebCTRL® interface displays the message with the highest priority. 

The table below shows all possible messages. The message color indicates the following: 

Black—In process 

Red—An error occurred 

Blue—Requires action from the user 
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Status column 

message 

Hover text message  Notes 

      

Black messages:     

Downloading The controller is downloading, 

communications may be disabled. 

 

Pending This controller is waiting to be 

processed. 

 

Processing clipping Clipping operation is in progress. Do 

not make changes as they may 

corrupt your system. 

 

Uploading The controller is uploading, 

communications may be disabled. 

 

      

Red messages:     

Communications  

Error 

Cannot communicate with this 

controller. 

 

Connection  

Disabled 

The connection for this controller has 

been disabled. 

Occurs if someone stopped the 

connection. This includes stopping a 

connection, using the No Connect 

connection, or running WebCTRL 

Design Server. 

Connection Error The connection for this controller 

failed to start. 

Occurs if the connection is 

misconfigured or failed to start. 

Download Failed (Message depends on the cause of 

the failure.) 

  

Error  An unknown error has occurred.   

Missing Files Upload failed. Server is missing 

source files. 

  

Not Uploadable This controller is not configured for 

content upload. 

Occurs if you attempt to upload a 

controller with a pre-4.x driver. 

Out of Service This controller is out of service. Out of Service is checked on the 

controller's Properties page. 

Unsupported  

controller 

Controller does not support content 

upload. 

  

      

Blue messages:     

Controller Replaced This controller has been replaced by 

another controller of the same type in 

the field. 

4.x driver only 

Download All Content Please download all content to the 

controller. 
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Status column 

message 

Hover text message  Notes 

Download Parameters To download parameters, highlight 

row and select "Parameters" from the 

Download Action menu and click 

"Download". 

 

Download Schedule To download schedules, highlight row 

and select "Schedules" from the 

Download Action menu and click 

"Download". 

 

Driver Parameter 

Mismatch 

Driver parameter differences 

detected. Upload parameters from the 

controller or download parameters to 

the controller. 

 

Parameter Mismatch Control Program parameter 

differences detected. Upload 

parameters from the controller or 

download parameters to the 

controller. 

See Handling parameter 

mismatches (page 36). 

Program Mismatch Content differences detected. Upload 

all content from the controller or 

download all content to the controller. 

4.x or later driver 

Unprogrammed 

controller 

This is a programmable controller. To 

add control programs, click on the 

"Add Control Program" button at the 

top of the screen. 

 

Upload All Content Please upload all content from the 

controller. 

 

      

General messages:     

 This controller is ok.   

Cancelled  The last operation on this controller 

was cancelled. 
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Handling parameter mismatches 

A parameter mismatch occurs when a value in a controller does not match the value in the WebCTRL 

Server application. This can be a driver or control program value.  

Use either of the following methods to handle mismatches in your system. 

  

 Method 1: Check Always resolve parameters on mismatch on the System Settings > 

Communications tab to have the WebCTRL® application automatically upload if a value was 

changed in the controller or automatically download if a value was changed in the WebCTRL® 

interface. 

  

 Method 2:  Uncheck Always resolve parameters on mismatch so that you can evaluate a 

mismatch to determine the correct value.  

  

To find mismatches in your system 

If your system uses Method 2, you can find mismatches in the following places: 

○ The Devices page > Manage tab > Status column will show Parameter Mismatch. 

○ The Properties page for a controller, driver, control program, or point will show one of the 

following red messages at the top of the page stating: 

Control Program parameter differences detected. 

Driver parameter differences detected. 

Parameter download required. 

 

The value that has a discrepancy will appear with a purple box around it. Hover your cursor 

over the field to see: 

  

or 

 

○ Go to Reports > Equipment > Parameter Mismatch, and then click Run to get a report of any 

existing mismatches in your system. 

   

NOTE  The Downloads page > Tasks column will show Resolve Parameters for any mismatches 

that your system discovered in the 3 places listed above. 

  

 

To resolve a mismatch 

1 Go to one of the following:  

○ Devices page - Click the Parameter Mismatch link 

○ Properties page that shows one of the red messages above 
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2 Click one of the following: 

○ Resolve to let the WebCTRL® application download changes made in the WebCTRL® interface 

or upload changes made in the controller. Click the Details button to see what the discrepancy 

is and whether Resolve will download or upload parameters. See NOTE below. 

 

○ Upload to upload the parameters from the controller to the WebCTRL® application 

○ Download to download the parameters from the WebCTRL® application to the controller 

  

NOTE  On the Devices page with Show Control Programs unchecked, if a controller has 

simultaneous mismatches in the driver and control program, clicking Details will show that a 

control program mismatch exists but it will only show details for the driver mismatch. You must go 

to the control program in the tree to see details of that mismatch. However, clicking Resolve will 

resolve both mismatches. 

  

 

 
 

Setpoints 

Use setpoints to set temperature values that control the HVAC equipment. The WebCTRL® interface 

shows the color green when a zone is within the desired temperature range determined by the heating 

and cooling setpoints. 

 Programmed setpoints are set and changed by operators. See To change programmed setpoints 

(page 38). 

 Effective setpoints reflect the impact of other system conditions on the programmed setpoints, 

such as setpoint adjustments, demand reduction adjustments, and hysteresis. Effective setpoints 

control the equipment.  

Besides manually adjusting setpoints, you can use the following cost-saving strategies (page 162) to 

adjust setpoints automatically: 

 Optimal Start 

 Demand Control 

 Setpoint Optimization 
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To change programmed setpoints 

1 Navigate to a setpoint control in one of the following places: 

○ The zone temperature section of a Properties page 

○ The setpoint microblock pop-up on a Logic page 

○ A Graphics page (Click a setpoint trend graph control to access the editable setpoint bar.) 

2 On a programmed setpoint bar, click the segment or the gap between segments you want to 

change. 

3 Type new values in the Heating and Cooling fields. 

 TIP  You can click and drag a segment or a gap between segments to change setpoints. 

4 Click Accept. 

 

 
 

Optimal Start 

Optimal Start gradually moves the unoccupied setpoints toward the occupied setpoints as the occupied 

time approaches. The actual equation that a controller uses to calculate Optimal Start is nonlinear. An 

approximation of the equation is shown below. 

calculated capacity =
design temp – OAT

design temp – 65°
x capacity at 65°

 

 

Refining Optimal Start saves energy in the following ways: 

 Removing guesswork from preheating or precooling zones 

 Ensuring that zones reach the ideal comfort range just as people arrive 

 Preventing equipment from running unnecessarily during unoccupied periods 

  

You can adjust the Optimal Start routine in the control program's setpoint microblock.  

1 On the Geographic  tree, select the equipment that you want to change. 

2 Click Properties. 
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3 Adjust the following fields located below the setpoint graph. 

 

Field Notes 

Heating Capacity 

Cooling Capacity 

The maximum rate (in °F/hr) that the zone temperature could be changed 

by heating or cooling if the outside temperature were 65°F. 

For example, if it takes 2 hours for a zone to warm up from 65°F to 72°F, 

the heating capacity is 3.5°F/hr 

NOTE  Use 5°/hr as a starting point if you are unsure of actual capacities. 

Heating Design Temp 

Cooling Design Temp 

The most extreme outside winter and summer temperatures at which the 

equipment must run 100% of the time to maintain the zone temperature 

at a comfortable level. 

ASHRAE determines design temperatures based on the geographic 

location of the building. 

  

NOTE  A Setpoint microblock with Learning Adaptive Optimal Start functionality automatically adjusts 

the heating and cooling capacities to optimize efficiency. 

 

Learning Adaptive Optimal Start 

If you are using the Learning Adaptive Optimal Start feature and a zone does not reach the ideal 

temperature range by the time occupancy begins or reaches it too soon, then the heating or cooling 

capacities of the equipment are automatically adjusted up or down for the next unoccupied period. 

 

 

 

When the Learning Adaptive Optimal Start routine runs, adjustments are made based on the color that 

is achieved when occupancy begins. Adjustment amounts are defined for thermographic colors in the 

control program's setpoint microblock.  

For example, the heating capacity for a zone is 5° per hour. When the zone becomes occupied, the 

zone temperature is 1° below the occupied setpoint, indicating a need for additional heat. Because the 

zone temperature was low by 1°, the learned heating capacity will be decreased by the Less than 

Heating setpoint value. If the value is 0.06, the learned heating capacity will be adjusted to 4.94° for 

the next optimal start period. The setpoint adjustment will begin sooner in the next unoccupied period. 

If you need to change the adjustment values in the Learning Adaptive Optimal Start routine: 

1 On the Geographic  tree, select the equipment that you want to change. 

2 Click Properties. 

3 Adjust the color fields between the Zone Setpoints graph and the Effective Setpoints graph.  

  

 CAUTION  When using Learning Adaptive Optimal Start, be sure that all equipment is properly 

maintained so that your system does not “learn” to compensate for dirty filters or loose fan belts. 
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 TIP  After your system has run for at least a year, you may want to turn off learning in your control 

program, and change the Heating Capacity and Cooling Capacity in your control program to match the 

learned heating or cooling capacity shown on the Properties page.  

   

Fields Notes 

Color fields The amount of adjustment the system makes for the color that is 

achieved at the beginning of occupancy. 

Learned cooling and  

heating capacity 

The rate (in °F/hr) that the zone temperature can change by heating or 

cooling at an outside temperature of 65°F. 

Actual or  

adjusted capacity 

The actual heating or cooling capacity of the equipment at an outside 

temperature of 65°F. 

  

 
 

Demand Control 

Demand Control is a cost-saving strategy that saves energy while maintaining comfort in the following 

ways: 

 Controlling energy use to avoid peak demand, ratchet, or time of use utility charges 

 Maintaining ventilation at relaxed setpoints rather than shutting down equipment (as with load 

shedding or duty cycling) 

Before you can use Demand Control effectively, you must: 

 Obtain details regarding past energy usage and peak demand, ratchet, and time of use charges 

from your energy provider. 

 Understand the demand profiles of the zones you are controlling. 

Demand Control can be customized at the zone level. For example, you may relax the setpoints in some 

zones, like break rooms and closets, by a few degrees, but you may not want to relax setpoints in 

computer rooms at all. 
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A Setpoint microblock that has the Demand Limiting enabled uses a demand control strategy to 

conserve energy by relaxing setpoints as the demand level rises. In the EIKON® application, you define 

the amount that setpoints will be adjusted or relaxed based on the demand level.  

 
  

 
  

 

To define Demand Control properties 

1 On the Geographic  or Network  tree, select the electric meter. 

2 On the Properties page, expand the Demand Level Parameters section. 

3 Type the Start and End time to define the time period that you want demand control to be in effect 

for this zone. 
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4 Type kilowatts per hour (kW/hr) in the Level columns to define the amount of power that the 

demand must exceed before the WebCTRL® system calls for a higher demand level. 

NOTE  Levels are defined in the electric meter control program in the EIKON® application. You can test 

the Demand Levels by locking the meter to a value. 

In the example below, during Period 4, defined as 12:00 (noon) to 16:00 (4:00 p.m.), if the demand 

exceeds 800 kW/hr, the WebCTRL® system will use Demand Level 1 setpoints. If the demand exceeds 

1000 kW/hr, the WebCTRL® system will use Demand Level 2 level setpoints and so on. 

 

 

 

 
 

Setpoint Optimization 

Setpoint Optimization, also known as Trim and Respond, saves energy by calculating the setpoint of a 

piece of equipment based on the number of heating or cooling requests it receives from other 

equipment. 

You must put a Setpoint Optimization microblock in a control program to receive Total, Average, 

Minimum, or Maximum microblock outputs from linked equipment. 
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Schedules 

Using schedules, your equipment can maintain one set of setpoints during occupied periods to provide 

comfort, and it can maintain a different set of setpoints during unoccupied periods to reduce energy 

consumption. Schedules are a WebCTRL® system's most effective cost-saving strategy (page 162). 

You can apply a schedule to a tree item or to a group of tree items. 

 

When you apply a schedule to a tree item, the schedule affects 

equipment at and below the area or equipment where the 

schedule was added. 

 

When you apply a schedule to a schedule group, the schedule 

affects all pieces of equipment in the group. 

For example, a school board meets every third Tuesday of the 

month and uses the lobby, main conference room, break room, 

and restrooms. You can create a schedule group to control these 

different areas with a single schedule. 

  

NOTES   

 When multiple schedules affect a tree item, the net result is the Effective schedule (page 47). 

 Do not include preheating or precooling time in your schedules. Optimal Start (page 38), another 

cost-saving strategy, automatically calculates and controls precise preheating and precooling 

routines.   

 If you are using hierarchical servers, when you add or change a schedule on the parent server, the 

schedule is automatically downloaded to the corresponding location on the child server(s). 

 If your system has no need to run schedules, you can turn off this feature. First, delete any existing 

schedules. Then go to the System Settings > General tab (page 181), and check the box Disable 

Schedules feature. 
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To view schedules 

1 Select a Geographic  tree item. 

2 Click Schedules, then the View tab. 

3 Optional:  Click a white Effective bar to view all the schedules that contribute to the resulting 

schedule. If the item has multiple schedules, the schedule closest to the Effective bar has the 

highest priority. You set a schedule's priority when you create the schedule. 

  

NOTES 

 You can display icons and hover text on the Geographic  tree that show where schedules have 

been created. See Tree icons and hover text (page 10). 

 You can also view schedules on the following detailed, printable schedule reports. These reports 

are accessible from the Schedules page Reports tab or from the Reports button drop-down menu. 

  

This report... allows you to... 

Schedule Instances Find every schedule with its location that is entered at and below a 

selected tree item. This report can help you discover newly added 

and conflicting schedules. 

Effective Schedules View all equipment that may be scheduled and the net result of all 

schedules in effect for a selected date and time. See Effective 

schedules (page 47). 

 

 
 

Setting up schedules 

   
 

To apply a schedule to equipment 

WebCTRL® schedules are typically based on zone occupancy. See Using schedule categories (page 49) 

if you want to create a schedule based on conditions other than occupancy. 

1 On the Geographic  tree, select the area or equipment you want to schedule. 

2 Select Schedules > Configure tab. 

3 Click Add. 

4 Select a Priority. A schedule's priority determines whether affected zones will use occupied or 

unoccupied setpoints. 

  

Select... For... 

Normal A typical occupied period 

Holiday An unoccupied period that overrides a Normal schedule 

Override An occupied period that overrides a Holiday schedule 

  

5 Select a Type. See table below. 

6 Type a schedule name in the Description field (50 characters maximum). 

7 Enter desired values in the fields below Description. 
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8 On the graph, change a time segment's Start and End times by doing one of the following: 

○ Click the segment, then type the times in the Start and End fields. 

○ Click and drag either end of the segment or the entire segment.  

9 Optional:  Click Add Time Period to add one or more segments to the schedule. Or, select a 

segment and click Delete Time Period to delete that segment. 

10 Click Accept. 

  

Select this Type... To use the schedule... 

Weekly Every week on the specified days 

Date On a single, specified date 

Date Range Between 2 specified dates 

Date List On multiple, specified dates 

Wildcard For a repeating pattern (For example, the second Tuesday of every month) 

NOTE  Wildcard schedules do not work with Automated Logic® legacy 

equipment. The WebCTRL® interface will indicate if you apply a schedule 

to legacy equipment. 

Continuous Continuously between 2 specified dates/times 

Dated Weekly 

 

On specified weekdays between a start date and an end date (for example, 

the summer break in the school year) 

NOTE  To use a Dated Weekly schedule with an ExecB controller, you must 

use the 1.71:032 (or later) ExecB driver. 

 

 NOTES   

 To automatically download all schedules that you create or change, go to My Settings (page 156) 

and check Automatically download schedules as you create them. If you want to manually 

download schedules, uncheck Automatically download... and then see Downloading system 

changes to controllers (page 30). 

 When you apply a schedule to an item on the Geographic  tree, the schedule affects that item 

and all children of that item. If you do not want an item to be affected by schedules from a higher 

level, check Ignore Schedules above this level on the Schedules > Configure tab. 

 

 
 

To apply a schedule to a group of items 

You must create a group, then add members (areas, equipment, or other groups) to the group before 

you can apply a schedule to it. 

1 On the Schedule Groups  tree, select Scheduling Groups. 

Optional:  If you have created folders to organize your groups, select the appropriate folder. See "To 

organize groups using folders" below. 

2 Click Add Group. 

3 Type a name for the new schedule group in the Name field. 

4 Optional:  Change the default Reference name. A group's reference name must be unique 

throughout the system. 

5 Click Accept. 
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6 Click Add Members to Group. 

7 On the Members page, select the areas, equipment, or other groups that you want to add to the 

group from the tree on the right. Use Ctrl+click, Shift+click, or both to select multiple items. 

8 Click Add. 

 TIP  Use the Raise and Lower buttons to reorder items in the Members list. Changing the order 

is for your viewing convenience and does not affect the system. 

9 Click Accept. 

10 Click the Schedules button, then Configure. 

11 Add a schedule to the group. See To apply a schedule to equipment (page 44). 

  

NOTE  When using hierarchical servers, you can place a server link in a schedule group on the parent 

server. This automatically creates a schedule group with the same name on the child server(s). This 

group includes only the top-most area node of the child server. However, from the child server you can 

edit the group to add other members.  

  

To organize groups using folders 

You can create folders and sort your groups into them to organize the Schedule Groups  tree. For 

example, a large school system that has a group for each school may want to create an Elementary 

School folder, a Middle School folder, and a High School folder, and put the appropriate groups in each 

folder. 

 
  

To create folders and add groups to them: 

1 On the Schedule Groups  tree, select Scheduling Groups. 

2 Click Add Folder. 

3 Type a name for the new folder in the Name field. 

4 Optional:  Change the default Reference name. 

5 Click Accept. 
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6 Repeat steps 1–4 for each folder that you want to add. 

7 Do one of the following to add a group to a folder: 

○ If you have already created the group, drag and drop it into the appropriate folder in the tree 

on the Scheduling Groups page, then click Accept. 

○ Select the folder in the tree on the Scheduling Groups page, then click Add Group to add a new 

group inside the folder. 

  

NOTE  You can also add a folder to a folder, or drag and drop a folder into another folder. 

 

 
 

To edit or delete a schedule 

1 Do one of the following: 

○ On the Geographic  tree, select the tree item where the schedule was defined, then select 

Schedules > Configure tab. 

○ On the Schedule Groups  tree, expand Scheduling Groups, then select the group that has 

the schedule you want to edit or delete. 

2 Select the schedule you want to edit or delete. 

3 Edit the fields you want to change or click Delete. 

4 Click Accept. 

NOTE  Expired dated schedules are automatically deleted from the database at 3:30 AM every day. But 

expired schedules remain in the controller until the next time schedules are downloaded to the 

controller. You can change the deletion time on the Scheduled Tasks tab of the System Settings (page 

181) page. 

 

 
 

Effective schedules 

The effective schedule that you see on the Schedules > View tab can be the result of multiple 

overlapping schedules. 
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The following schedule features can influence an item's effective schedule. 

  

Feature Description 

  

Hierarchy 

  

A schedule applied to an item on the WebCTRL® tree affects that item and all of its 

children. A child item's effective schedule could be the result of multiple schedules 

applied at different levels above it. To change a child item's effective schedule: 

 Add a schedule at the child that overrides the current schedule. See the Priority 

feature below.  

 Set the child to ignore the parent schedules. To do this, select the child item on the 

tree, then go to Schedules > Configure. Select the schedule, then click Ignore 

Schedules above this level. You can then add a different schedule for the child. 

 

Any schedule change that you make to an item affects it and all of its children. 

  

Priority You must assign one of the following priorities to every schedule. 

  

Use... For... 

Normal  A typical occupied period 

Holiday An unoccupied period that overrides a Normal schedule 

Override An occupied period that overrides a Holiday time 

 

EXAMPLE  For a school, you define: 

 A Normal schedule that has it occupied every Monday–Friday, 6 am–5 pm 

 A Holiday (unoccupied) schedule for the week of Spring Break 

 An Override schedule on the first day of Spring Break from 9 am–1 pm for the 

cafeteria only where a teacher's meeting will be held. 
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Feature Description 

Type You must assign one of the following types to every schedule.* 

Weekly 

Date 

Date Range 

Date List 

Wildcard 

Continuous 

Dated Weekly 

See To apply a schedule to equipment (page 44) for a description of each type. 

EXAMPLE  For a school, you define the following 3 schedules: 

 Full calendar year:  Normal, Weekly, Monday–Friday, 6am–5pm 

 Summer months:  Holiday, Continuous, 12am June 1st –11:59pm August 31st 

 Work days in summer months:  Override, Dated Weekly, Monday–Thursday, 

9am–2pm 

  

*  If you do not see one of the types listed above, on the System Configuration  tree, 

select Categories > Schedule. Select the Occupancy category, then the Priority. Under 

Schedule Types, select the missing type, then click Accept. 

  

Using the Priority and Type options, you can often accomplish the effective schedule you need in 

several different ways. For example, the effective schedule resulting from the 3 schedules described 

above for Type could also be accomplished with the following schedules: 

School year:  Normal, Dated Weekly, Monday–Friday, September 1st–May 31st, 6am–5pm 

Summer months:  Normal, Dated Weekly, Monday–Thursday, June 1st–August 31st, 9am–2pm 

 

 
 

Using schedule categories 

Occupancy is the only default schedule category. It is a binary schedule category that allows a zone or 

piece of equipment to be defined as On when a space is occupied and Off when it is unoccupied. 

You can add custom schedule categories to handle other conditions if the equipment’s control program 

includes a Time Clock microblock. For example, you can add a multi-state schedule category to control 

lights: on during work hours, off at night, and dim for janitorial work. 

 

 
 

Creating a custom schedule category 

1 Create the custom schedule category in the EIKON® application. See "To use custom alarm and 

schedule categories" in EIKON® Help. 

2 In the EIKON® application, select the new category from the Schedule Category droplist in a the 

schedule microblock. 

3 Create the same custom schedule category in the WebCTRL® interface. The Reference Name must 

be identical to the category's name in the EIKON® application. See "To add a custom schedule 

category in the WebCTRL® interface" below. 
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To add a custom schedule category in the WebCTRL® interface 

 TIP  Study the default Occupancy category to understand the various properties you need to set 

when adding a new schedule category. 

  

PREREQUISITES 

 Add the custom schedule category in the EIKON® application. See "To use custom alarm and 

schedule categories" in EIKON® Help. 

 In the EIKON® application, select the new category from the Schedule Category droplist in a Time 

Clock microblock. 

  

1 On the System Configuration  tree, click    to the left of the Categories folder, then click 

Schedule. 

2 Click Add. 

3 Enter values or add items for the fields in each section of the page. See table below. 

NOTE  The fields that you see depend on selections you made in previous sections. 

4 Click Accept. 

 

Field Notes 

Category Name The name used in the WebCTRL® interface 

Reference Name  Must be unique in the database, be lowercase, and not 

contain any spaces.  

 This name must be identical to the name of the custom 

schedule category that you added in the EIKON® application. 

 Do not use occupancy as the reference name. 

Allowed Type Replace Undefined with one of the following: 

 Boolean: binary (on/off, true/false) condition 

 Multi State: list of integer-defined states. For example, 1=off, 

2=on, 3=dim 

Default Value Displays what schedule value is in effect for times not specified by 

the schedule. To set this value, in the Allowed Values table, select 

the value that you want to use as the default, then click the Make 

Default OK button. 

Allowed Values If you selected Boolean above, select True Value or False Value. 

If you selected Multi State, click the Add Value button to create 

each schedule state. 

Allowed Value Description The name used in the WebCTRL® interface. 

Pattern Type none, dark, or 

/_common/lvl5/graphics/patterns/xxx.gif,  

where xxx.gif is any .gif file in the 

webroot\_common\lvl5\graphics\patterns folder. 
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Field Notes 

Priority Description The name used in the WebCTRL® interface. 

Index Represents this priority’s relative level of importance within this 

schedule category. The WebCTRL® application automatically 

assigns the priority index, which is zero for the first priority level. 

The higher the index value, the higher the priority of the schedule 

type relative to other schedules. BACnet limits the number of 

priority indices to 16. 

Color Color of the schedule bar on the Schedules page.  

Schedule Types The Weekly type is available for Index 0 only. 

The Allow Wildcards and Partial Day options affect all selected 

schedule types. 

Default Schedule The default schedule used when this category is selected. Create 

the schedule by adding segments for each state until every hour 

in the 24-hour schedule is covered by a segment.  

EXCEPTION  If you selected Partial Day in the Schedule Types 

field, you do not have to add segments for the entire 24-hour 

period. 

 

 
 

To view, edit, or delete a schedule category 

1 On the System Configuration  tree, click    to the left of the Categories folder, then click 

Schedule. 

2 In the table, select the category you want to edit or delete. 

3 Edit the fields or click Delete. 

4 Click Accept. 
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Trends 

The WebCTRL® system can read and store equipment status values over time and then display this 

information in a trend graph to help you monitor the equipment’s operation.  

  

 
  

You can collect trend data for any point value in the WebCTRL® system. The controller reads point 

values at intervals that you define and then stores that data in the controller. A controller has limited 

memory for storing trend data, so you can set up historical trending to archive the trend data from the 

controller to the WebCTRL® database. A trend graph can display data from the controller and the 

database, or it can display only data stored in the database. 

After you set up the desired points for trend data collection (page 52), you can:  

 View built-in trend graphs that show a single point (page 54) 

 Create custom trend graphs with multiple points (page 55)  

  

 
  

 

 

 
 

To collect trend data for a point 

Before you can see a point's trend graph, you must enable trending for that point and then define how 
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you want the controller to collect the point's data. This can be done in the EIKON® application or you 

can do it in the WebCTRL® interface using the instructions below. 

NOTE  I/O microblocks have trending capability built-in, and you enable trend logging in the I/O 

microblock. Any other microblock value must have a trend microblock attached in the control program, 

and you enable trend logging of the value in the trend microblock.  

  

To set up a point's trending in the WebCTRL® interface: 

1 On the Geographic  tree, select the equipment that has the point you want to trend. 

2 Click the Trends button drop-down arrow, select Disabled Points, then select the point. 

3 On the Enable/Disable tab, check Enable Trend Log. 

4 Enter information in the appropriate fields. See table below. 

5 Click Accept. 

 TIP  You can set up all trends for a piece of equipment at once on the Trend Sources tab of the 

equipment's Properties page. 

  

Field Notes 

Sample every _:_:_ 

(hh:mm:ss)  

Records the point’s value at this interval. 

NOTE  Set trend intervals for U line controllers to one minute or 

greater. U line controllers are designed to meet low end, high volume 

terminal control applications and are not suited to very short trend 

intervals. 

Sample on COV 

(change of value) 

Records the point’s value only when the value changes by at least the 

amount of the COV Increment. 

NOTE  Use this method for a binary point or for an analog point that 

has infrequent changes in value. 

Max samples The maximum number of samples that you want the controller to 

store. 

CAUTION  Changing the value in Max samples will delete all of the 

point's trend samples currently stored in the controller. Click the 

Store Trends Now button before changing the value to transfer the 

trend data from the controller to the system database. 

NOTES 

 Trending consumes memory in the controller. The amount of 

memory available depends on the type of controller. Each 

trended point consumes 48 bytes of memory plus 10 bytes for 

each trend sample. Each trend microblock consumes 416 bytes 

of memory plus 10 bytes for each trend sample. 

 Click Reset to delete all samples currently stored in the controller. 

The above sample and memory allocation fields together define trend data storage in the controller in 

terms of hours. 

EXAMPLE  If you set these fields so that samples are collected every 5 minutes for a maximum of 

120 samples, the controller will store 600 minutes (5 x 120) or 10 hours of trend data. 

Stop When Full Check this field to stop trend sampling when the maximum number 

of samples is reached. 

Enable trend log at specific 

times only 

Collects trend data for the specific period of time you define in the 

time and date fields. 
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Field Notes 

Enable Trend Historian Archives trend data to the system database. 

Store Trends Now Writes all trend data in the controller to the system database without 

having to enable trend historian. 

Write to historian every __ 

trend samples  

Writes all trend data in the controller to the system database each 

time the controller collects the number of samples that you enter in 

this field. This number must be greater than zero and less than the 

number entered in the field Max samples. The number of trends 

specified must be accumulated at least once before the historical 

trends can be viewed. 

Trend samples accumulated 

since last notification 

Shows the number of samples stored in the controller since data was 

last written to the database. 

Last Record Written to 

Historian  

Shows the number of trend samples that were last written to the 

database. 

Keep historical trends for __ 

days 

This is based on the date that the sample was read. Select the first 

option to use the system default that is defined on the System 

Settings > General tab. Select the second option to set a value for 

this trend only. 

Delete Deletes all trend samples stored in the database for the item 

selected on the Geographic  tree. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the 

BACnet object. Although the Object Name field can be edited, it is not 

recommended. The Notification Class is set to 1 to receive alarms 

generated by Automated Logic® controllers. 

 

 

NOTES 

 You can use Global Copy (page 27) to copy trend properties to other pieces of equipment that use 

the same control program. 

 Run a Trend Usage report (page 103) to view trend configurations. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Viewing a built-in, single-point trend graph 

1 On the Geographic  tree, select the equipment whose trend you want to view. 
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2 Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you 

want to view. 

3 Select the View tab. See Using trend graphs (page 58). 

  

NOTE  On the Configure tab, you can: 

 Enable/disable the grid. 

 Set the time range for the X axis. For example, enter 7 days to see the data for the last week. 

 Turn off autoscaling so that you can define a range for the Y-axis 

 Type a Y-axis label that will appear on the right side of the graph. 

 

 
 

Creating a custom trend graph 

When creating a custom trend graph, you can select up to 16 points. If you select more than 4 points or 

points with different units, the WebCTRL® application splits the data into subgraphs. Each subgraph 

can show a maximum of 4 points with similar units.  

 

  

NOTES    

 You must enable trending for points that you want to include in the custom trend graph. See To 

collect trend data for a point (page 52). 

 You can display icons and hover text on the Geographic  tree that show where custom trend 

graphs were created. See Tree icons and hover text (page 10). 

 

 

 
 

To create a custom trend graph 

1 On the Geographic  tree, select the area or equipment where you want to see the graph. 
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2 Click the Trends button drop-down arrow, then select New Trend Graph. 

NOTE  If the Trends button does not have a drop-down arrow, the New Trend Graph page is already 

displayed. 

3 In the tree on the New Trend Graph page, use Ctrl+click or Shift+click to select the points (16 

maximum) that you want to see on a graph.  

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point 

(page 52). 

4 Click Save. 

5 Optional:  If your system has trend categories defined, you can select a Category for this trend. For 

more information on trend categories, see Adding trend categories (page 57). 

6 Type a Name for the graph that will appear at the top of the graph and in the Trends button 

drop-down list. 

7 Click OK.  

8 Select: 

○ The View tab to see the custom trend graph. See Using trend graphs (page 58). 

○ The Configure tab to edit the trend graph. See To edit a custom trend graph (page 56). 

 

 
 

To edit a custom trend graph 

1 On the Geographic  tree, select the area or equipment where you created the graph. 

2 Select the Trends > Configure tab. On this page, you can: 

○ Change the name of the custom trend graph 

○ Enable/disable the grid 

○ Set the time range for the X axis 

○ Edit a subgraph's Y-axis label that will appear on the right side of the graph 

○ Turn off autoscaling so that you can define a range for the Y-axis 

○ Add/delete subgraphs (see instructions below) 

○ Add/delete points (see instructions below) 

○ Change a point's name on the graph 

○ Change a binary point's active/inactive text on the graph 

○ Click Delete Trend Graph to delete the entire custom trend graph 

  

To add a subgraph to a custom trend graph 

1 Click Add below the Subgraphs list. 

2 Type a Y-axis label. 

3 Click Add below the Points list. 

4 Select a point in the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point 

(page 52). 

5 Repeat steps 3 and 4 to add up to 4 points to the subgraph. 

6 Click Accept. 

NOTE  To delete a subgraph, select it in the Subgraphs list, click Delete below the list, and then click 

Accept. 

  

To add a point to a subgraph 
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1 Select the subgraph in the Subgraphs list. 

2 Click Add below the Points list. 

3 Select a point from the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point 

(page 52). 

4 Click Accept. 

NOTE  To delete a point, select the appropriate subgraph, select the point, click Delete below the Points 

list, and then click Accept. 

 

 
 

Adding trend categories 

A point trend graph is in the Enabled or Disabled category in the Trends button drop-down menu.  

 
  

You can create additional categories for your custom trend graphs. 

1 On the System Configuration  tree, click    to the left of Categories, then select Trend. 

2 Click Add. 

3 Type the Category Name and Reference Name. 

4 Optional:  Select a privilege so that only operators with that privilege can access trends in the 

category. 

5 Click Accept. 

 

 NOTES   

 To edit a category, select the category, make your changes, then click Accept. 

 To delete a category, select the category, click Delete, then click Accept. 
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Using trend graphs 

 

  

NOTES   

 A gray triangle at the top of a graph indicates a note from the system. Hover your cursor on the 

triangle to see which of the following occurred: 

○ Equipment received a time synchronization from its network router or from the WebCTRL® 

application.  

○ Trend Historian has been enabled or disabled.  

○ Trend Log has been enabled or disabled. 

The trend object ID of a third-party trend source has been changed. For information only, you do not 

need to do anything. 

 Click  at the top of the WebCTRL® page to print the graph. You may need to set your printer's 

orientation to Landscape. 

 Toolbar options are also accessible by right-clicking a trend graph.  

 You can check Display gap in graph line for missing data on an individual trend graph page, or you 

can go to the System Settings > General tab (page 181) to set this for all future trend graphs. 
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To view trend data in a spreadsheet program 

You can save trend data as csv data that you can open in a spreadsheet program such as Microsoft® 

Excel®. 

1 On the Trends > View tab, select  > Save as CSV data. 

2 Save the data (.zip file) wherever you want. The .zip file contains the following: 

○ A .csv file for each trend source (point). The filenames match the point names. 

○ A Combined folder containing a file with the combined data for all of the graph's trend sources. 

3 Open the .csv file in a spreadsheet program. 

  

NOTES 

 You will need to convert the data in the spreadsheet's Time column to a readable date/time 

format. 

 If you use Microsoft® Excel® on a Mac and the converted date shows the wrong year, do the 

following: 

1. In Excel, go to File > Options > Advanced. 

2. Scroll down to the section When calculating this workbook, and then uncheck Use 1904 date 

system. 
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Alarms 

An alarm is a message sent from an alarm source (usually a microblock in a control program) to the 

WebCTRL® application to notify you that certain conditions exist, such as a piece of equipment has 

stopped running or a temperature is too high. When the WebCTRL® application receives an alarm, it 

displays information about the alarm on the Alarms page. It can also perform alarm actions to inform 

personnel of the condition and to record information about the alarm. An alarm source can also send a 

return-to-normal message when the alarm condition returns to its normal state. 

  

 

  

Alarm sources and the alarms they generate are assigned to categories, such as HVAC Critical or HVAC 

Maintenance, to help you work with related alarms.  

The application engineer usually sets up alarm sources in the EIKON® application. In the WebCTRL® 

interface, you can: 

 View, troubleshoot, acknowledge, and delete alarms  (page 61) 

 Set up the alarm actions that the WebCTRL® application performs (page 67) 

 Edit alarm sources that were set up in the EIKON® application or set up new alarm sources to 

generate alarms (page 88) 

 Customize alarms by changing the category or message (page 91) 

  

NOTE  Besides the alarms that you set up, the WebCTRL® application has built-in system and 

equipment alarms.  
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Viewing, troubleshooting, acknowledging, and deleting alarms 

The WebCTRL® Alarms page displays alarms as they are received. If desired, an operator can set 

options on the My Settings page to have the WebCTRL® application play an audio file when an alarm is 

received. 

An alarm's setup may require that it be acknowledged and/or the alarm condition returned to normal. 

The alarm, its return to normal, and any other alarms related to the incident are referred to as an alarm 

incident group. The WebCTRL® application closes an alarm incident group when all of the following 

have occurred: 

 You acknowledge the alarm (if required) 

 The WebCTRL® application receives a return-to-normal (if required) 

 The WebCTRL® application performs all alarm actions defined for the group 

You should delete alarms from your system as they are closed because large quantities of stored 

alarms can reduce the efficiency of your system. 

 

 
 

To view alarms in the WebCTRL® interface 

 Click  at the top of the page to see all alarms in the system.  

or 

 Click the Alarms button and then select an item on the navigation tree to see all alarms at and 

below that level.  
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NOTES   

 The WebCTRL® tree can show 10 levels. If an alarm source is deeper than 10 levels, the alarm is 

reassigned to the system level. 

 Alarms generated by the WebCTRL® application appear at the system level. 

 Alarms generated by controllers appear at the system level on the Geographic tree, but in the 

network hierarchy on the Network tree. 

 An alarm's details include a path to the alarm source. Each section of the path is a link to that 

location. For example, in the path East Wing/RTU-4/SSP_LO, East Wing links to the East Wing 

graphic, RTU-4 links to the equipment graphic, and SSP_LO links to the microblock's Properties 

page. 
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 You may see any of the following alarms icons in the WebCTRL® interface:  

 

Access control Red = Critical

Blue = Maintenance

Gray = General

Grayed out = Closed

These icons... Indicate...

Fire system

Lighting system

General alarm

System

Unknown

FDD

General message

Controller alarm

HVAC

Icon color indicates...

FDD comfort

FDD energy

 
  

 

 
 

To control which alarms you see 

   

Use these tools... To control the Alarms list 

 

  

Click the arrow buttons to display other alarms. 

 
  

Type a date and time or click  to select a date. 

Then click Go to show up to 50 alarms since that 

date/time. 

When finished, click  to display the 50 newest 

alarms or  to display the oldest 50 alarms. 
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Use these tools... To control the Alarms list 

 

Date–Sorts list by date/time the alarms were 

generated with the most recent at the top. 

To Do–Shows only alarms that require one or more 

actions before they are closed. 

Incident Group–Sorts alarms by incident. For 

example, an alarm and its return-to-normal form an 

incident group. Brackets indicate a group. 

 
  

 
  

Select the alarm categories that you want to see in 

the alarms list. Use Ctrl+click, Shift+click, or both to 

select multiple categories, or check Show all 

categories. 

 

 
 

To troubleshoot an alarm 

You can select an alarm's checkbox and then click  to open the Alarms time-lapse showing the 

1-hour period in which the alarm occurred. You can step backward or forward through the time-lapse at 

1-minute intervals to see what other alarms occurred at each minute during that hour. You can also go 

to the Graphics or Trends time-lapse to see what else happened when the alarm occurred. See 

Time-lapse (page 101) for information on this feature. 

 

 

 

 

 

 

 

 

 

 

 

 
 

To acknowledge alarms 
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You must acknowledge alarms that have been set up to require acknowledgment. An alarm shows if it 

needs to be acknowledged. 

 
  

The table in the upper left corner of the page shows how many alarms need acknowledgment at the 

current location (Here) and in the entire system (Total). This table also shows how many alarms need a 

return-to-normal and how many are closed.  

 
  

To acknowledge an alarm 

1 On the Alarms page > View tab, select the checkbox of an alarm that shows Acknowledge. 

2 Click the Acknowledge button. 

  

To acknowledge all alarms in the alarms database for selected categories 

1 On the Alarms page > View tab in the left-hand column, select the categories whose alarms you 

want to acknowledge.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All 

checkbox. 

2 Click Advanced. 

3 Click Acknowledge All. 

 TIP  Acknowledging many alarms simultaneously can take a long time. Acknowledge alarms as they 

occur to avoid long waits.  

 

 
 

To delete alarms 

You should delete alarms from your system as they are closed because large quantities of stored 

alarms can reduce the efficiency of your system. To save alarm information before deleting, select 

Alarms > Reports tab > Alarms, then click the Run button. 

  

To delete an alarm 

1 On the Alarms page > View tab, select an alarm's checkbox. 

2 Click Delete. 

  

 

 

 

To delete all alarms in the alarms database for selected categories 
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1 On the Alarms page > View tab in the left-hand column, select the categories whose alarms you 

want to delete.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All 

checkbox. 

2 Click Advanced. 

3 Click Delete All. 

  

To delete all closed alarm incident groups in the alarms database 

An incident group is all alarms related to a particular incident. For example, an alarm and its 

return-to-normal form an alarm incident group. An incident group is considered closed when all alarms 

in the group are closed. 

1 On the Alarms page > View tab in the left-hand column, select the categories whose alarms you 

want to delete.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All 

checkbox. 

2 Click Advanced. 

3 Click Delete Closed Incidents. 

  

NOTES 

 To have the WebCTRL® application automatically delete alarm incident groups a specified number 

of days after the groups close, select this option on the System Settings > Scheduled Tasks (page 

187) tab. 

 Also on the System Settings > Scheduled Tasks tab, you can set the WebCTRL® application to 

archive alarm information to a text file as alarms are deleted.  

 An alarm source may be set up to generate an alarm and a return-to-normal. If an alarm occurs but 

the WebCTRL® application never receives the return-to-normal, you can select the alarm and then 

click Force Normal so that the alarm can be closed. Force Normal has no effect on the alarm 

condition that generated the alarm. 

 

 
 

To receive audible notification of alarms 

You can set up the WebCTRL® application to play an audio file on your workstation when it receives a 

critical or non-critical alarm.  

1 On the System Configuration  tree, select My Settings. See To change My Settings (page 

156). 

2 On the Settings tab, select Non-critical alarms or Critical alarms to be notified of each type of 

alarm.  

3 In the Sound File field, type the path to the sound file. 

  

When an alarm triggers the audio file to play, you can click  and then select: 

 Snooze to temporarily stop the sound for 5 minutes 

 Silence to stop the sound 

The alarm sound is silenced until another alarm that triggers a sound is received. 
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Setting up alarm actions 

The WebCTRL® application can perform alarm actions listed below to notify personnel of an alarm or to 

record information about the alarm. You can assign alarm actions to an alarm source, a category of 

alarm sources, alarm sources from a certain location, or a combination of these criteria.  

The alarm actions are: 

 Alarm Popup 

 Print 

 Propagate To Server 

 Run External Program 

 Send Alphanumeric Page 

 Send E-Mail   

 Send SNMP Trap * 

 Send Web Service Request * 

 Write Property * 

 Write to Database * 

 Write to File 

  

*  Available only in WebCTRL® Premium and WebCTRL® Advantage with the Advanced Alarming 

package. 

  

To see a report of each alarm action defined in your system and how it is configured, go to Reports > 

Alarms > Alarm Actions. 

  

See the following topics for a description of each alarm action. 

 

 
 

To assign alarm actions to alarm sources 

To assign alarm actions to multiple alarm sources 

Although you can assign an alarm action to a single alarm source, you typically assign an action to 

multiple alarm sources at the area or equipment level. The alarm action applies to all instances of the 

alarm sources at the selected location and below. Click an action’s Edit button to make any changes. 

To assign an alarm action to alarm sources: 

1 On the Geographic  or Network  tree, select the area, equipment, or controller containing 

the alarm sources. 

2 On the Alarms page > Actions tab, follow the 3 steps on the screen.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple items. 

3 Click Add. 

4 Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm 

action below for field descriptions. 

5 Click Accept. 

After you have assigned alarm actions to an alarm source, simulate the alarm (page 90) to check your 

work. If an alarm action fails, the WebCTRL® application receives an alarm for the failed action. 

NOTES   

 Click View Selected Sources to view or change settings for each alarm. 

 You can display icons and hover text on the Geographic  tree that show where alarm actions 

have been created. See Tree icons and hover text (page 10). 
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To assign an alarm action to a single alarm source 

1 On the Geographic  or Network  tree, select the alarm source (microblock). 

2 On the Alarms page > Actions tab, click the drop-down arrow, then select an alarm action. 

3 Click Add. 

4 Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm 

action below for field descriptions. 

5 Click Accept. 

 

 
 

Alarm Popup 

The Alarm Popup alarm action pops up a message on any computer with a Windows® operating 

system that is running the WebCTRL® Alarm Notification Client application. 

  

Field Notes 

To Operator 

To Group 

Select individual operators or operator groups who should receive alarm 

notification. 

Generate alarm if 

delivery fails 

Check this field to generate a System Info alarm if the popup recipient is not 

currently running the Alarm Notification Client application. 

Message text Use punctuation, spaces, or returns to format the text. To add live data to the 

text, select field codes (page 95) from the Append Field Code list. 

Append Field Code Add field codes (page 95) to the message text if desired.  

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 
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Using the Alarm Notification Client application 

The Alarm Notification Client application must be running on each client computer (Windows only) that 

should receive popup notifications. Keep the application minimized to the right side of the Windows 

task bar. The window will pop up with a message when an alarm occurs. 

Select an alarm message, then click  to open the WebCTRL® interface displaying the piece of 

equipment that generated the alarm. A grayed out alarm indicates that it was acknowledged in the 

WebCTRL® interface. 

If the Alarm Notification Client is set up to play a continuous alarm sound, you can silence an alarm by 

clicking Silence!, by pressing Ctrl+S, or by acknowledging the alarm in the WebCTRL® interface. 

 

 
  

Button Notes 

 Opens the WebCTRL® interface displaying the equipment that generated the alarm. 

NOTES   

 If WebCTRL Server is to use https (SSL), you must do the following to enable 

communication between the server and Alarm Notification Client. In SiteBuilder, go to 

Configure > Preferences > Web Server. For Enabled Web Server Ports, select Both 

HTTP and SSL or SSL only. In the Server Connection field described below, enter the 

number of the SSL port.  

 If WebCTRL Server is v6.0 and an Alarm Notification Client is an earlier version, you 

will have to log in when you click . 

 
Copies the selected alarm information to the clipboard. 

 Removes the alarm information from the alarm popup list. Removing items from this list 

has no effect on the alarms list in the WebCTRL® interface. 

 View information about the server connection. 

 
On this tab... You define... 

 Server 

Connection 

The WebCTRL® server and port, and the WebCTRL® operator name 

and password 

NOTES   

 If you upgraded Alarm Notification Client to v6.0, you will need to 

reenter your operator name and password on this tab while Alarm 

Notification Client is connected to the WebCTRL Server 

application. 

 The default port is TCP 47806. If you change this, you must also 

change the Port field in the WebCTRL® System Settings. See "To 

set up the WebCTRL Server application to support Alarm Popup 

clients" below.  
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Button Notes 

 Browse To The WebCTRL® page that you want to see first when browsing to the 

equipment 

 Notification 

Sounds 
 If you want to hear a sound when an alarm occurs 

 Which sound you want to hear for each type of alarm.  

NOTE  A Connection Failure occurs when the Alarm Notification 

Client loses communication with the WebCTRL Server application.  

 Whether you want the sound to continue until silenced 

NOTE  If multiple types of alarms occur simultaneously, the 

application plays the sound of the most critical alarm (Connection 

Failure first, then Critical, then Normal). 

 

To set up the WebCTRL Server application to support Alarm Popup clients 

1 On the System Configuration  tree, select System Settings. 

2 On the General tab, select Enable support for Alarm Notification Clients to connect to this server. 

3 If the server has more than one network interface adapter, type in the Restrict to IP Address field 

the IP address that the Alarm Notification Client application will connect to. You must specify the 

same IP address in the Server field in the Alarm Notification Client. 

4 Use the default port or specify a different port. You must specify the same port in the Port field in 

the Alarm Notification Client. 

5 Click Accept. 

NOTE  If the Alarm Notification Client application is not on the local network and will access WebCTRL® 

alarms through a NAT router, you must port forward the TCP port you defined in step 4 above. 

  

To install the Alarm Notification Client application 

Follow the steps below on each client computer that should receive alarm popups. 

PREREQUISITE  Enable support for Alarm Popup client in System Settings. See above topic. 

1 On the System Configuration  tree, click Client Installs. 

2 Select Alarm Notification Client. 

3 Click Run, then follow the on-screen instructions to install the Alarm Notification Client application. 

After you click Done, the application starts automatically. 

4 In the Settings dialog box, enter appropriate values. You can also click  to open this box. See the 

table above for a description of each setting.  

NOTE  You can lock the Settings so that a user cannot edit them. See To lock a client's Settings 

feature below. 

5 Click OK. 

6 Minimize the Alarm Notification Client window. 

  

To lock a client's Settings feature 

To prevent a user from editing the Settings  :  

1 Right-click Alarm Notification Client in the Windows Start menu. 

2 Select Properties.  
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3 On the Shortcut tab, type -lockconfig at the end of the Target path. 

 

 

 
 

Print 

The Print alarm action prints alarm information. 

  

Field Notes 

Text Printing Select to use the WebCTRL® server's local dot-matrix printer. Text Printing will 

not print to a network printer.  

In the Port Name field, type the computer port that the printer is connected 

to. In the Line Width field, type the number of characters to be printed per 

line. 

Prints multiple alarms per page. 

Graphics Printing Select to use the WebCTRL® server's default printer (local or network printer).  

Prints one alarm per page to the WebCTRL® server's default printer. 

Text to Print Use punctuation, spaces, or returns to format the text. To add live data to the 

text, select field codes (page 95) from the Append Field Code list. 
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Field Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

 

 
 

Propagate To Server 

The Propagate To Server alarm action sends the selected alarm to the parent server in a system with 

hierarchical servers. 

  

Field  Notes 

Message text The alarm message that is sent to the parent server. 

Append Field Code Add field codes (page 95) to include live data in the Message text field.  
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Field  Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

 

 
 

Run External Program 

The Run External Program alarm action starts a program or batch file on the server. 

NOTE  You must be running WebCTRL Design Server to set up this alarm action. 

  

Field  Notes 

Command Line The path of the executable file on the WebCTRL® server followed by the path 

of the output file. 

EXAMPLE: 

c:\windows\notepad.exe c:\WebCTRL\webroot\alarms.txt 

Append Field Code Add field codes (page 95) to the Command Line field.  

EXAMPLE: 

c:\reports\run_report.bat $Generation_time$$To_State$ 

This starts a batch file on the server and uses the alarm’s generation time 

and state as values. 

Synchronize Tells the WebCTRL® application to wait for the external program to finish 

running before initiating the next Run External Program alarm action. 
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Field  Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

 

 
 

Send Alphanumeric Page 

The Send Alphanumeric Page alarm action sends a page to one or more alphanumeric pagers or sends 

text messages to cell phones. The pager or phone must be able to accept e-mail. 

  

Field Notes 

To Type the address(es) that you want to send the alarm to. To enter multiple 

addresses, type a space or press Enter after each address. 

From Enter a valid address if required by your mailserver. 

Mail Host The mailserver's address. This can be an IP address or a system name, such 

as mail.mycompany.com. 

Mail Host Port Change this field if using a port other than the default port 25. 

Mail Host Security 

Options 

Select the type of security the mailserver uses. 

 Cleartext – Uses the SMTP protocol to send as clear text over TCP/IP 

 Secure SSL – Uses SSL, a communication protocol that provides data 

encryption 

 Secure TLS – Uses TLS, but does not begin encryption until the 

WebCTRL® application issues STARTTLS command 
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Field Notes 

Specify Mail User For 

Mail Host 

Authentication 

Select if your mailserver requires a username and password. 

Send mail as MIME 

attachment 

Select if your mailserver allows only MIME attachments. 

Message Text Use punctuation, spaces, or returns to format the text. To add live data to the 

text, select field codes (page 95) from the Append Field Code list. 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for 

a schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

  

NOTE  You should not assign this alarm action to frequently-occurring alarms as this may cause 

problems on your network or the Internet. 

  

To secure mailserver communication using SSL or TLS 

Before the WebCTRL® application sends an email using SSL or TLS, it requests an SSL certificate from 

the mailserver. If the certificate that the WebCTRL® application receives is in its list of trusted 

certificates, it sends the email. If the certificate is not in the list, the WebCTRL® application generates a 

system alarm indicating that the email alarm action failed. If this occurs, you will need to add the 

mailserver's certificate to the WebCTRL® application's list of trusted certificates. 

1 Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help. 

2 Put the file on the WebCTRL® server. 

3 On the WebCTRL® server, click the Windows® Start button. 
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4 In the Search programs and files field, type the following command:  

 

C:\WebCTRL<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts 

-alias smtpserver -keystore webserver\keystores\certkeys -file 

<file_path> 

 

replacing: 

<x.x> with the system's version number 

<file_path> with the full path and file name of the certificate file 

5 The information for the smtpserver key is displayed and you are prompted to trust this certificate. 

Type yes. 

  

NOTE  If your mailserver is using SSL or TLS, the WebCTRL® server is running antivirus software, and 

the email alarm action fails because it cannot find an SSL certificate, do one of the following: 

 Disable scanning of outgoing SMTP traffic in the antivirus software. See your antivirus software's 

Help for assistance. 

 Obtain the antivirus software's SSL certificate and install it on the WebCTRL® server using the 

above procedure. 

  

To set up a dial-up networking connection 

The WebCTRL® application can use a dial-up internet connection through a modem to deliver e-mail for 

the Send E-mail or Send Alphanumeric Page alarm action.  

To set up the dial-up connection: 

1 Set up your modem to dial out to your Internet Service Provider. See your modem documentation. 

2 On the WebCTRL® server, open Internet Explorer®. 

3 Select Tools or  > Internet Options.  

4 On the Connections tab, click Setup. 

5 Follow the instructions in the wizard. See Windows Help for assistance. 

6 In a text editor such as Windows Notepad, open WebCTRLx.x\webroot\<system>\ 

system.properties. 

7 At the end of the file, type the following line:  

         repactions.connection.name=<name of connection> 

where <name of connection> is the ISP name you entered in the wizard in step 2. 

8 Open Internet Explorer, then select Tools > Internet Options > Connections tab. 

9 If the box under Dial-up and Virtual Private Network settings shows more than one connection, 

select the connection that you just created, then click Set Default. 

10 Select Always dial my default connection. 
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Send E-mail 

The Send E-mail alarm action sends a message to one or more e-mail accounts. The alarm action can 

also run a report and attach it to the e-mail as a PDF, HTML, or XLS file. 

     

Field Notes 

To and 

CC 

Type the address(es) that you want to send the alarm to. To enter multiple 

addresses, type a space or press Enter after each address. 

Subject Enter the text that you want to appear on the Subject line of the email. The 

subject can include field codes (page 95). 

Use default email 

server configuration 

Check this field to have this alarm action use the email server configuration 

settings defined on the System Settings > General tab. Uncheck to enter 

settings specific to this alarm action. 

    From Enter a valid address if required by your mailserver. 

    Mail Host The mailserver's address. This can be an IP address or a system name, such 

as mail.mycompany.com. 

    Mail Host Port Change this field if using a port other than the default port 25. 

    Mail Host 

    Security Options 

Select the type of security the mailserver uses. 

 Cleartext (SMTP) – Uses the SMTP protocol to send as clear text over 

TCP/IP 

 Secure SSL (SMTP with SSL) – Uses SSL, a communication protocol that 

provides data encryption 

 Secure TLS (STARTTLS) – Uses TLS, but does not begin encryption until 

the WebCTRL® application issues STARTTLS command 

    Specify Mail 

    User For Mail 

    Host 

    Authentication 

Select if your mailserver requires a username and password. 

Send mail as MIME 

attachment 

Select if your mailserver allows only MIME attachments. 

Message Text Use punctuation, spaces, or returns to format the text. To add live data to the 

text, select field codes (page 95) from the Append Field Code list. 

Attach Report Select to attach a report to the e-mail, then select the Report and the 

Format. The attached report will include the date and time. For example, 

Alarm Sources 2017 Jan 01 1230. 

NOTE  The Report Name field shows a custom report only if it is accessible at 

the current level. 

Run as shows the name and login name of the operator creating the alarm 

action. The report will be run using the privileges and report options of this 

operator. 

 TIP  You may want to create a new operator with limited privileges for 

this purpose. 
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Field Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for 

a schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

 

  

NOTE  You should not assign this alarm action to frequently-occurring alarms as this may cause 

problems on your network or the Internet. 

 

To secure mailserver communication using SSL or TLS 

Before the WebCTRL® application sends an email using SSL or TLS, it requests an SSL certificate from 

the mailserver. If the certificate that the WebCTRL® application receives is in its list of trusted 

certificates, it sends the email. If the certificate is not in the list, the WebCTRL® application generates a 

system alarm indicating that the email alarm action failed. If this occurs, you will need to add the 

mailserver's certificate to the WebCTRL® application's list of trusted certificates. 

1 Get a copy of the certificate file from the mailserver. Ask your Network Administrator for help. 

2 Put the file on the WebCTRL® server. 

3 On the WebCTRL® server, click the Windows® Start button. 

4 In the Search programs and files field, type the following command:  

 

C:\WebCTRL<x.x>\bin\java\jre\bin\keytool.exe -import -trustcacerts 

-alias smtpserver -keystore webserver\keystores\certkeys -file 

<file_path> 

 

replacing: 

<x.x> with the system's version number 

<file_path> with the full path and file name of the certificate file 
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5 The information for the smtpserver key is displayed and you are prompted to trust this certificate. 

Type yes. 

  

NOTE  If your mailserver is using SSL or TLS, the WebCTRL® server is running antivirus software, and 

the email alarm action fails because it cannot find an SSL certificate, do one of the following: 

 Disable scanning of outgoing SMTP traffic in the antivirus software. See your antivirus software's 

Help for assistance. 

 Obtain the antivirus software's SSL certificate and install it on the WebCTRL® server using the 

above procedure. 

  

To set up a dial-up networking connection 

The WebCTRL® application can use a dial-up internet connection through a modem to deliver e-mail for 

the Send E-mail or Send Alphanumeric Page alarm action.  

To set up the dial-up connection: 

1 Set up your modem to dial out to your Internet Service Provider. See your modem documentation. 

2 On the WebCTRL® server, open Internet Explorer®. 

3 Select Tools or  > Internet Options.  

4 On the Connections tab, click Setup. 

5 Follow the instructions in the wizard. See Windows Help for assistance. 

6 In a text editor such as Windows Notepad, open WebCTRLx.x\webroot\<system>\ 

system.properties. 

7 At the end of the file, type the following line:  

         repactions.connection.name=<name of connection> 

where <name of connection> is the ISP name you entered in the wizard in step 2. 

8 Open Internet Explorer, then select Tools > Internet Options > Connections tab. 

9 If the box under Dial-up and Virtual Private Network settings shows more than one connection, 

select the connection that you just created, then click Set Default. 

10 Select Always dial my default connection. 

 

 
 

Send SNMP Trap 

 

NOTE  To see if your system has this optional package, click , then select About. You have this 

package if Enabled Features shows Adv. Alarming. 

  

The Send SNMP Trap alarm action sends an SNMP trap in response to receiving an alarm. Traps 

contain the text created in the Text to send as the SNMP Trap field in the alarm action dialog box. You 

can configure up to five SNMP servers to receive traps. 

NOTES   

 WebCTRL® supports SNMP v1. 

 Each SNMP server you want to receive these traps must have SNMP monitoring equipment 

installed. If problems arise with your SNMP connection or receiving traps, contact your IS 

department. 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

80 

 

 This alarm action uses Port 162 to send SNMP traps. To use a different port, open 

WebCTRLx.x\webroot\<system_name>\system.properties in a text editor such as Notepad. In the 

line #snmp.trap.port = 162, delete # at the beginning of the line and change 162 to the port you 

want to use. If you make this change while the WebCTRL Server application is running, you must 

restart it to have the change take effect. 

   

Field Notes 

Network Address** The network address of the SNMP server receiving the SNMP trap. 

Community Name** The community name that the SNMP server belongs to. 

Comment The physical location of the SNMP server. This field is optional. 

Trap number** If the network administrator has configured trap numbers, type a unique 

number from 1 to 127. 

NOTE  The same trap number is used for all messages from this alarm action. 

Text to send as the 

SNMP Trap 

255 character limit. Type punctuation, spaces, or returns after the entries to 

format the message. You can customize this text by selecting field codes 

(page 95) from the Append Field Code list.  

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation.  

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group.  

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under PerformAction, select If schedule group <your new group> is 

Unoccupied. 

 ** Ask your network administrator for this information. 

 

 

 

 

 

 

 
 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

81 

 

Send Web Service Request 

 

The Web Service Request alarm action sends a web service request to a third-party server when an 

alarm event occurs. For example, the WebCTRL® application could send a request to a work order 

system so it could create a work order for someone to respond to the alarm condition. 

  

Field Notes 

Destination Address The URL of the server that will receive the request.  

Example:  https://192.168.168.102/workorder/bas 

Web Service Action Select the type of web service request required by the target server:   

GET or POST 

Content Type If you selected POST in the previous field, select the format required by the 

target server: 

Application/json   or   /x-www-form-urlencoded 

Web Service Request 

Parameters 

Optional–Create a parameter for each piece of information that the target 

server requires. You should be able to find information about required 

parameters in the target server's documentation. 

     Parameter Name Enter a name for the parameter. For example, Parm1 or Date.  

Click Add Parameter. 

     Value Text required for the parameter. To add live data to the request, select a 

field code (page 95) from the Append Field list.  

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been 

acknowledged or has not returned to normal. Use this option for alarm 

escalation.  

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined 

for a schedule group.  

EXAMPLE  To have one alarm action performed during work hours and 

a different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to 

it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> 

is Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under PerformAction, select If schedule group <your new group> 

is Unoccupied. 
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Write Property 

 

NOTE  To see if your system has this optional package, click , then select About. You have this 

package if Enabled Features shows Adv. Alarming. 

  

The Write Property alarm action writes a specified value to a BACnet property. You typically set up 2 

alarm actions, the first writes a value when the alarm occurs and the other writes a value when the 

return-to-normal occurs. 

   

Field Notes 

Expression Type the path to the target property. To get the path, right-click the property 

on a Properties page, then select Global Modify. The Geographic Location 

field in the Advanced section shows the path. Click  to copy it. 

NOTES  

 A BACnet Parameter microblock's present value cannot be written to 

directly. However, you can change the present value by writing to the 

relinquish_default property, or to the priority_array/priority16 property. For 

example, change 

#rtu-1/vfd_ovrde/present_value  to 

 #rtu-1/vfd_ovrde/relinquish_default,   or 

#rtu-1/vfd_ovrde/priority_array/priority16. 

 Do not use a BACnet address in this field. 

Value to Write Type the value you want to write to the microblock property. Type 0 or 1 for a 

binary property. 

Append field code to 

value 

Select field codes (page 95) to add this information to the Value to Write 

field. 
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Field Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation.  

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group.  

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under PerformAction, select If schedule group <your new group> is 

Unoccupied. 

 
 

Write to Database 

 

NOTE  To see if your system has this optional package, click , then select About. You have this 

package if Enabled Features shows Adv. Alarming. 

  

The Write to Database alarm action stores alarm information in a table in the WebCTRL® alarm 

database or in a custom database. Third-party applications can access the alarm information for 

building maintenance management or alarm analysis. For example, an application can perform actions 

such as triggering a stored procedure or running a report.  

  

Writing to the WebCTRL® alarm database 

When you add the Write to Database alarm action, by default the WebCTRL® application writes alarm 

information to the write_db_ra table in the WebCTRL® alarm database. The following table describes 

the information that is written to the database and gives the column name and data type that you will 

need to access the alarm information from a third-party application. 

  

Description Column Name Data type 

Alarm generation time EVENT_TIME_ Datestamp 

Path to the alarm source  

Example:  #slm/m073 

SOURCE_PATH_ String 
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Description Column Name Data type 

Display name path to the alarm source 

Example:  Atlanta Office/R&D Facility/Second Floor/VAV 2-1/Z

one Temp 

DISPLAY_NAME_ String 

Alarm state 

Example:  OFF NORMAL, LOW LIMIT, HIGH LIMIT 

EVENT_STATE_ String 

Alarm text as defined in the Text to write to the database field 

on the alarm action page. You can add live data to the text by 

selecting field codes (page 95) from the Append Field Code 

list.  

RA_TEXT_ String  

  

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation.  

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for 

a schedule group.  

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under PerformAction, select If schedule group <your new group> is 

Unoccupied. 

  

NOTES 

 To keep the database table from growing too large, you must delete old entries using a third-party 

database application. You cannot view, edit, or delete entries in the WebCTRL® interface. 

 If your system uses an Access or Derby database, you cannot open the database in a third-party 

application while the WebCTRL® or SiteBuilder application is running. 
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Writing to a custom database 

The WebCTRL® application can write alarm information to the following types of custom databases. 

The custom database does not have to be the same type as the WebCTRL® database. 

 SQL Server 

 MySQL 

 PostgreSQL 

 Oracle 

You may create a table in an existing third-party database or create a new database. 

Using your database management tool, create a table in your custom database that includes fields for 

each alarm field code to be written to the table. Each field length in the table should be as long as the 

longest value to be written to that field. 

To set up writing to a custom database instead of the WebCTRL® alarm database, check Specify 

Custom Database on the Alarms page Actions tab, then enter information in the remaining fields. See 

table below. 

  

Field Notes  

Text to write to the 

database 

The text is made up of field codes (page 95) that add live data to the text. You 

can select additional field codes from the Append Field Code list.  

NOTE  To write the text in this field to the custom database, you must include 

the Report Text field code ($report_text$) in the Database Insert String field 

described below.  

Database Connect 

String 

For database type... 

SQL Server 

MySQL 

PostgreSQL 

Oracle 

The connect string format is... 

jdbc:odbc:<odbc_alias> 

jdbc:mysql://<host>:<port>/<instance> 

jdbc:postgresql://<host>:<port>/<instance> 

jdbc:oracle:thin@<host>:<port>/<instance> 

where: 

<host> is the database server name/IP address 

<port> is the port number for the database 

<instance> is the database name in the database 

server 

<odbc_alias> is the name of the ODBC data source 

Database Login and 

Password 

The login and password to connect to the database. 
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Field Notes  

Database Insert 

String 

Use the following format: 

Insert into <TABLE_NAME> (<column1_name>, <column2_name> ...) values 

(<$field_code1$>, <$field_code2$>, ...) 

Example: 

Insert into WebCTRL_ALARMS (TIME_, LOCATION_, TO_STATE_, TEXT_) values 

($generation_time$, $location_path$, $to_state$, $report_text$) 

NOTES 

 You can add field codes (page 95) to the Insert String using the Append 

Field Code list.  

 If you add a timestamp type field code (for example, $generation_time$), 

you should have the data go into a timestamp data type field in the 

custom database. Otherwise, you must use field code formatting (page 

95) to format the time. 

 You can add only one Database Insert String per alarm action. 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged 

or has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule 

group or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the 

same as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. 

Under Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 
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Write to File 

The Write to File alarm action can do either of the following: 

 Record alarm information in a standard ASCII text file that you can view and edit using a text editor 

such as Windows® Notepad. 

 Write a WebCTRL® report to a file. 

    

Field Notes 

File Name Path to the file you want to write to such as 

c:\WebCTRLx.x\webroot\alarms.txt. 

 If you do not specify a path, the file is written to the system folder.  

 If you type a path that does not exist, the WebCTRL® application will create 

the necessary folders.  

 You can write to one of the following:  

-  a file on the server 

-  a networked computer if you map the network drive. Use  

   the drive mapping in the path from the server to the computer. 

 The path name may contain field codes (page 95). 

Write alarm data Select to record alarm information in a text file. 

Select Append to add new alarm information to the end of the file instead of 

writing over existing data. 

NOTE  Because you can append new alarm information to the end of the file, 

this file can become very large. You must back up and delete this file 

frequently if you are using this alarm action with many alarms. 

In the Text to write to the file, enter the information you want to record for an 

alarm. Use punctuation, spaces, or returns to format the text. To add live data 

to the text, select field codes (page 95) from the Append Field Code list. 

Write a report Select to write a WebCTRL® report to a file, then select the Report and the 

Format. 

NOTE  The Report Name field shows a custom report only if it is accessible at 

the current level. 

Run as shows the name and login name of the operator creating the alarm 

action. The report will be run using the privileges and report options of this 

operator. 

 TIP  You may want to create a new operator with limited privileges for this 

purpose. 
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Field Notes 

Perform Action By default, the WebCTRL® application performs an alarm action when the 

alarm source generates an alarm and when it returns to normal. Under 

Perform Action, you can choose to run the alarm action: 

 Only when the alarm source generates an alarm or when it returns to 

normal. 

 After a specified amount of time if the alarm has not been acknowledged or 

has not returned to normal. Use this option for alarm escalation. * 

 If the alarm occurs during the occupied hours defined for a schedule group 

or run if the alarm occurs during the unoccupied hours defined for a 

schedule group. * 

EXAMPLE  To have one alarm action performed during work hours and a 

different alarm action performed after work hours: 

1. Create a schedule group (page 45), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the same 

as the work hours. 

3. Create the alarm action that is to be performed during work hours. 

Under Perform Action, select If schedule group <your new group> is 

Occupied. 

4. Create the alarm action that is to be performed after work hours. Under 

Perform Action, select If schedule group <your new group> is 

Unoccupied. 

*  Available only if you have the Advanced Alarming package. 

 

 
 

Setting up an alarm source in the WebCTRL® interface 

The application engineer usually sets up alarm sources in the EIKON® application. In the WebCTRL® 

application, you can: 

 Edit an existing alarm source’s settings or set up a new alarm source to generate alarms. 

 Set up all alarms for a piece of equipment at once on the Alarm Sources tab of the equipment's 

Properties page. 

 Simulate an alarm to test its setup. 

 

Two types of microblocks generate alarms in control programs. 

 Alarm microblocks include logic that takes into account conditions such as space occupancy. 

 I/O point microblocks can generate an alarm when the present value exceeds defined limits 

(analog) or when the present value changes to an off-normal state (binary). This type of microblock 

is typically set up for analog points to generate alarms for sensor failure. 

Alarm microblocks and I/O microblocks can have similar names. So, when you are going to enable an 

alarm source, first look for an alarm microblock on the Geographic  or Network  tree.  

  

This type of microblock... Appears on the Geographic or Network tree as... 
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To set up, edit, or disable alarm sources 

To set up, edit, or disable a single alarm source 

1 On the Geographic  or Network  tree, select the alarm source (microblock). 

2 Click Alarms, then select the Enable/Disable tab. 

3 Make changes to the fields as needed. The fields can vary for different types of alarm sources. See 

table below. 

4 Click Accept. 

 TIP  To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm 

Sources. 

  

Field Notes 

Potential alarm source Check to enable the alarm source to generate alarms. Uncheck to disable 

the alarm source. 

Alarm Check to have the alarm source generate an alarm when the specified 

conditions occur.   

 For a binary input, enter the conditions for generating an alarm. 

 For an analog input, type the low and high limits that, when exceeded, 

will generate an alarm.  

 

Deadband  The amount inside the normal range by which an alarm 

condition must return before a return-to-normal notification is generated. 

EXAMPLE 

 

NOTE  If Status is checked, the alarm condition currently exists. 

Return to Normal Check to have the alarm source generate a return-to-normal when the 

alarm condition returns to a normal state. 

Alarm requires 

acknowledgment 

Check to have the WebCTRL® application require that an operator 

acknowledge the alarm. 

Return requires 

acknowledgment 

Check to have the WebCTRL® application require that an operator 

acknowledge the return-to-normal. 

Classified as critical This property determines the color of the system-wide alarm button when 

the alarm comes in. 

 = Critical       = Non-critical 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

90 

 

Field Notes 

Event State The current state of the alarm source can be: 

 Normal—value is normal 

 Off normal—the value is not normal (binary only) 

 Fault—the alarm source microblock may be misconfigured 

 High Limit—the value exceeds the normal range (analog only) 

 Low Limit—the value is below the normal range (analog only) 

BACnet 

Configuration: 

  

Dial on alarm 

  

  

  

Check to have this alarm immediately delivered through a modem 

connection. 

NOTE  When monitoring your system through a modem connection, 

non-critical alarms are stored in the gateway until one of the following 

happens:  

 a critical alarm occurs 

 the gateway is contacted by the WebCTRL® application  

 the gateway buffer is full, at which time all alarms are sent to the 

WebCTRL® application  

Notification Class Do not change this field. 

 

To set up, edit, or disable multiple alarm sources simultaneously 

1 On the Geographic  or Network  tree, select the area, equipment, or controller containing 

the alarm sources.  

2 Click Alarms, then select the Enable/Disable tab. 

3 In step 1, select the categories that contain the alarm sources. 

NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select 

All. 

4 In step 2, select the alarm sources. 

5 Make appropriate changes in step 3. 

6 Click Accept. 

NOTE  Click View Selected Sources to view or change settings for each alarm. 

 

 
 

To simulate an alarm 

To test the setup of an alarm source and its alarm actions (page 67), you can simulate an alarm or its 

return-to-normal. 

1 On the Geographic  tree, select the alarm source ( , but not ) whose alarm you want to 

simulate. 

2 On the Alarms > Enable/Disable tab, check Enable next to Alarm or Return to Normal. 

3 Click Simulate next to Alarm or Return to Normal. 

4 Select the equipment on the tree, then select the View tab to see the alarm. 
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To view all instances of an alarm source 

To find all instances of an alarm source at and below a selected area: 

1 On the Geographic  or Network  tree, select an area. 

2 Select the Message, Actions, Enable/Disable, or Category tab. 

3 Select an alarm source from the list in step 2. 

4 Click View Selected Sources. 

Each path in the dialog box links to the alarm source microblock.  

NOTE  You may be able to change settings that relate to the tab you selected. 

 

 
 

Customizing alarms 

Each alarm source has an alarm message, category, and template defined in the EIKON® application. 

You can change messages and categories in the WebCTRL® application.  

 

 
 

Alarm messages 

An alarm message is the information that appears on the Alarms page View tab for an alarm. An alarm 

message can consist of 3 parts. 

  

 
  

You can edit Text only at the alarm source in the EIKON® application.  

Prefix and Details are hierarchical. They apply at the location where they are added and to all its 

children. For example, you could enter Details at the system level to show the acknowledge time for 

alarms in the HVAC Critical category. The acknowledge time would then be in any HVAC critical alarm 

message in the system. 

NOTE   An alarm action can have a different message from the alarm message seen on the View tab. To 

edit the message for a particular alarm action, see Setting up alarm actions (page 67). 

  

To edit the message for an alarm source 

1 On the Geographic  tree, select the alarm source (microblock). 

2 Click Alarms, then select the Messages tab. 

NOTE   Sample Alarm Message and Sample Return Message show the messages as they are 

currently defined. 
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3 Do the following as needed: 

○ Edit the Text for Alarm or Return. You can add live data to the text by selecting field codes 

(page 95) from the Append Field Code list. 

○ Click the Edit button to edit Message Prefix or Message Details. 

○ In the drop-down list to the right of Message formation, select Add new prefix to beginning of 

message or Add new details to end of message, then click Add. 

4 Click Accept. 

  

To add a Prefix or Details for multiple alarm sources 

1 On the Geographic  or Network  tree, select the area, equipment, or controller containing 

the alarm sources. 

2 Click Alarms, then select the Messages tab. 

3 In step 1, select the categories that contain the alarm sources whose messages you want to edit. 

NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select 

All. 

4 In step 2, select the alarm sources. 

5 In step 3, select Add new prefix to beginning of message or Add new details to end of message. 

6 Click Add. 

7 Type text and add field codes as needed. 

8 Click Accept. 

 

 
 

Alarm categories 

Alarm categories sort related alarm sources and their alarms into groups such as HVAC Critical and 

Access Control General. Alarm categories let you: 

 View, acknowledge, or delete selected categories of alarms (page 61) received by the WebCTRL® 

application 

 Assign alarm actions (page 67) to selected categories of alarm sources  

 Set up alarm sources (page 88) in selected categories 

Each alarm source is assigned to an alarm category in either the EIKON® application or in the 

WebCTRL® interface. See "To use custom alarm and schedule categories" in EIKON® Help. 

In addition to the default alarm categories in your system, you can create custom categories if needed. 

If you create a custom category in the EIKON® application, you must create the same category in the 

WebCTRL® interface. The Reference Name must be identical in both applications. 

  

To assign alarm sources to a category in the WebCTRL® interface 

1 On the Geographic  or Network  tree, select the area, equipment, or controller containing 

the alarm sources. 

2 Click Alarms, then select the Category tab. 

3 In step 1, select the category that currently contains the alarm sources. 

NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select 

All. 

4 In step 2, select the alarm sources whose category you want to change. 

5 In step 3, select a category from the drop-down list, then click Change. 
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6 Click Accept. 

  

To add a custom alarm category  

1 On the System Configuration  tree, click    to the left of Categories. 

2 Click Alarm. 

3 Click Add. See table below. 

4 Click Accept. 

 

Field Notes 

Reference  

Name  

Must be unique in the database, be lowercase, and not contain any spaces. This name must be 

identical to the name of the custom alarm category that you added in the EIKON® application. 

Icon Type /_common/lvl5/graphics/event_categories/<file_name>.gif, replacing 

<file_name> with the name of the icon file you want to use.  

  

The event_categories folder contains the following alarm icons:  

  

 Icons used in the WebCTRL interface: 

accesscontrol_*.png

Icons File name

firesystem_*.png

lightingsystem_*.png

general_alarm_*.png

unknown_*.png

fdd_*.png

general_message_*.png

module_alarm.png

system_critical_error.png

system_error.png

system_info.png

system_error_closed.png

hvac_*.png

fdd_comfort.png

fdd_energy.png

 

Icons available for custom categories: 

Icons File name
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Field Notes 

   

*Represents critical, maintenance, general, or closed 

  

NOTE  You can create your own 24 x 24 pixel icon (.gif or .png) and store it in the event_categories 

folder. However, your custom file will not be transferred during a WebCTRL® upgrade, so you will 

need to copy the file to the new install directory after the upgrade. 

  

 

 
 

If you upgraded alarms from v2.0 or earlier 

All v2.5 and later alarms use one template called Universal. This template lets you define your alarm 

message text, the critical setting, and the required acknowledgments at the alarm source in the 

EIKON® or WebCTRL® application. 

Templates in upgraded systems 

If you upgraded your system from v2.0 or earlier, the alarm sources retained their existing templates 

and existing alarm settings. If the existing alarm sources contain little or no customization to the alarm 

settings, Automated Logic® recommends that you change all of the alarms to use the Universal 

template. If the alarm sources had customized alarm settings, continue using the existing templates. 

To assign a different template to alarm sources 

PREREQUISITE  The Alarms Template tab must be visible. If it is not, on the System Configuration  

tree, select Privilege Sets, then check Maintain Alarm Templates. 

1 On the Geographic  tree, select the piece of equipment containing the alarm sources to be 

changed. 

2 Click Alarms, then select the Template tab. 

3 Follow the 3 steps on the screen. 

NOTE  Use Ctrl+click, Shift+click, or both to select multiple items. 

4 Click Change. 

5 Click Accept. 

 TIP  To change all alarms in the system simultaneously, go to the system level and then select all 

categories and all alarm sources on the Templates tab. 

To add an alarm template 

1 On the System Configuration  tree, select Alarm Templates. 

2 Click Add. 

3 Select Source-based (a v2.5 template) or Stand-alone (a pre-v2.5 template), then click OK. 

4 Edit the template fields as needed. See table below. 

5 Click Accept. 
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Field Template Type Notes 

Reference Name All Must be unique in the database, be lowercase, and not 

contain any spaces. This name must be identical to the 

name of the template in the EIKON® application. 

Display Name All The name that will appear in the WebCTRL® interface for 

this template. 

Alarm Message Source-based The message text displayed on the View tab or in the alarm 

action when an Alarm requires acknowledgment. 

Return Message Source-based The message text displayed on the View tab or in the alarm 

action when a return-to-normal requires acknowledgment. 

Fault Message Source-based The message text displayed on the View tab or in the alarm 

action when a Fault requires acknowledgment. 

Critical Stand-alone Select if this is a template you will use with a critical alarm. 

Acknowledgement 

Required 

Stand-alone Select which alarm states require an acknowledgment. 

Out of Range Stand-alone Analog inputs and outputs that have low and high limit 

alarm properties. 

Click  to the left of Out of Range to make changes to 

the alarm messages displayed on the Alarms page > View 

tab. Short text is the message displayed when the alarm is 

not expanded. Long text is the message displayed when the 

alarm is double-clicked and expanded. 

Change of State Stand-alone Binary inputs and alarm microblocks. 

See Out of Range above to change the alarm messages. 

Copy Field Code to 

Clipboard 

Stand-alone To add a field code to any of the message text fields: 

1 Select a field code to copy it. 

2 Click in the appropriate text field where you want the 

field code. 

3 Press Ctrl+V to paste the field code. 

  

 

 
 

Using field codes 

Use field codes to insert live data into:  

 The message on an alarm action  

 Text displayed on the Alarms page > View tab 

 Alarm information archived to a text file when an alarm is deleted 

You can customize the setup of each of these items by appending field codes. For example, to have the 

message in an alarm action include the device that generated the alarm, append the Device field code 

to the action's message.  
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Formatting field codes 

You can type a formatting command after a field code to format the field code in one of the following 3 

ways:  

 Format a number field code (Example: ##.##)  

 Format a date/time field code (Example: MM/dd/yyyy hh:mm:ss)  

 Left, right, or center align a field code and set the field width 

A formatting command must have the following syntax: 

 

Use the table below to determine the format_type and style for a formatting command. 

 

 
 format_type   style 

Example 

To format a 

number 

N  The actual formatting, 

such as ##.##. The basic 

format uses the pound 

sign (#) to represent a 

number. For more 

information, search the 

Internet for "customizing 

number formats with 

java". 

To always round a setpoint 

value to two digits to the right 

of the decimal, the field code 

is: 

$setpoint_value%N:##.##$ 

For example, 78.9935 

becomes 78.99. 

To format 

date/time 

D  The actual formatting, 

such as MM/dd/yyyy 

hh:mm:ss. For more 

information, search the 

Internet for "customizing 

date time formats with 

java".  

To show the date and time 

when an alarm is generated in 

a format like 03/15/2004 

10:50:43, the field code is: 

$generation_time%D:MM/dd/

yyyy hh:mm:ss$  

To set alignment 

and field width  

L for left align 

R for right align 

C for center align  

Indicate the field width by 

number of characters. 

To left align the name of the 

device that generated the 

alarm and set the field width 

to 15 characters, the field 

code is: 

$device%L:15$ 

 

Using multiple formatting commands  

You can type multiple formatting commands for a field code. For example, you can format a number 

and then set the alignment and field width. The syntax for multiple formatting commands is:  

$fieldcode%format_type1:style%format_type2:style$  

EXAMPLE  To format the alarm date and time, center it and set the field at 20 characters, the field 

code is: 

$generation_time%D:MM/dd/yyyy hh:mm:ss%C:20$  

NOTE You must enter the date/time or number formatting command before the alignment/field width 

command. 
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Field codes 

  

Field Code 

Name 

Field Code Description 

Acknowledge 

Operator 

$acknowledge_operator$  The operator who acknowledged the alarm.  

EXAMPLE  John Doe 

Acknowledge 

Time  

$acknowledge_time$  The time when the operator acknowledged the 

alarm.   

EXAMPLE  Nov 12, 2012 6:46:31 PM 

Alarm Category  $alarm_category$  The alarm category that the alarm is assigned to.  

EXAMPLE  HVAC Critical 

Alarm Priority  $alarm_priority$ The priority number associated with the alarm's 

priority (Off-Normal, Fault, or Normal) on the 

controller's Driver > Notification Class page. 

Alarm Template  $alarm_template$  The alarm template that the alarm is assigned to.  

EXAMPLE  Universal 

Alarm Type  $alarm_type$  The alarm type of the alarm source.  

EXAMPLE  CHANGE OF STATE 

Alert Text $alerttext$ For a converted SuperVision® system if the option 

Create a single alarm template... was selected 

during upgrade. Retrieves alarm message text from 

cmnet_alert_text.properties. 

To use this field code: 

1.  Select the Alert Text field code. 

2.  After $alerttext, type one of the following: 

  :normalshort 

  :normallong 

  :alarmshort 

  :alarmlong 

For example, $alerttext:alarmlong$  

Character $c$ A single ASCII character. Often used for form feeds 

and other printer escape sequences. 

EXAMPLE  $C:65$ displays A 

Command Value $command_value$  The commanded value from the alarm source. Valid 

only for alarm type COMMAND FAILURE.     

EXAMPLE  3 

Control Program $equipment$  The display name of the equipment where the alarm 

came from.   

EXAMPLE  Chiller 

Controller $device$  The display name of the device where the alarm 

came from.   

EXAMPLE  SE6104 
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Field Code 

Name 

Field Code Description 

Dead Band  $deadband$  The deadband value from the alarm source. Valid 

only for alarm type OUT-OF-RANGE. 

EXAMPLE  5 

Deletion 

Operator  

$deletion_operator$  The operator who deleted the alarm.   

EXAMPLE  John Doe 

Deletion Time  $deletion_time$  The time the alarm was deleted.   

EXAMPLE  Nov 12, 2012 6:46:31 PM 

Error Limit  $error_limit$  The error limit, from the alarm source. Valid only for 

alarm type FLOATING LIMIT.   

EXAMPLE  90 

Event Values $event_values$ Returns a string of alarm values associated with the 

alarm.    

Exceeded Limit  $exceeded_limit$  The exceeded limit value from the alarm source. 

Valid only for alarm type OUT-OF-RANGE.   

EXAMPLE  90 

Exceeding Value  $exceeding_value$  The exceeding value from the alarm source. Valid 

only for alarm type OUT-OF-RANGE.   

EXAMPLE  91 

Fault  $fault$  The status of the fault condition from the alarm 

source.   

EXAMPLE  True or false 

Field Message  $field_message$  Text generated in the alarm by the controller.   

Feedback Value $feedback_value$  The feedback value from the alarm source. Valid 

only for alarm type COMMAND FAILURE.   

EXAMPLE  10 

From State  $from_state$  The previous state of the alarm source.   

EXAMPLES  NORMAL, FAULT, OFF NORMAL, HIGH 

LIMIT, LOW LIMIT 

Generation 

Operator 

$generation_operator$  The operator who forced the alarm to return to 

normal.   

EXAMPLE  John Doe 

Generation Time  $generation_time$  The time in the controller when the alarm was 

generated.   

EXAMPLE  Nov 12, 2012 6:35:18 PM 

In Alarm  $in_alarm$  The in alarm status from the alarm source.   

EXAMPLE  True or false 

Incident Closed 

Time 

$incident_closed_time$  The time the alarm's entire incident group closed.  

EXAMPLE  Nov 12, 2012 6:46:31 PM 

Latched Data 

Value (Analog)  

$latched_data_analog:x$  "x" ranges from 1 to 10. 

Returns a numerical value. 

Use for legacy systems.  
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Field Code 

Name 

Field Code Description 

Latched Data 

Value (Digital)  

$latched_data_digital:x$ "x" ranges from 1 to 10. 

Returns On or Off. 

Use for legacy systems.  

Location Path  $location_path$  Displays the path display names from root to 

source.  

EXAMPLE  Building B / Basement / VAV AHU B / 

SSP_STOP 

The number of levels in the path is based on the 

System Settings field Levels displayed in paths. To 

override this setting, enter the field code as 

$location_path:#$, substituting # with the number 

of path levels you want to show. For example, 

$location_path:5$ will show 5 levels.  

Long Message  $long_message$ The formatted alarm long text displayed by 

double-clicking the alarm on the Alarms page.     

Message Details $message_details$ The message details displayed on the Alarms page 

View tab.    

Message Prefix $message_prefix$ The message prefix displayed on the Alarms page 

View tab.    

Message Text $message_text$ The message text displayed on the Alarms page 

View tab.    

New State  $new_state$  The status of new state from the alarm source. Valid 

only for alarm type CHANGE OF STATE. 

EXAMPLE  Alarm, Fault 

New Value  $new_value$ The new value from the alarm source. Valid only for 

alarm type CHANGE OF VALUE.   

EXAMPLE  70 

Notification 

Class 

$notification_class$ The notification class assigned denotes how the 

received alarm was generated. For example, if set to 

1, the alarm would typically be sent to WebCTRL by 

Automated Logic® controllers.    

Object ID  $object_ID$  Object ID of the alarm source.   

EXAMPLE  5:26 

Out of Service  $out_of_service$  The status of 'out of service' from the alarm source.   

EXAMPLE  True or false 

Overridden  $overridden$  The status of 'overridden' from the alarm source.   

EXAMPLE  True or false 
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Field Code 

Name 

Field Code Description 

Program ID  $program_id$  The address of the control program that generated 

the alarm. 

BACnet program address format: 

device ID, program number  

EXAMPLE  2423101,1 

SuperVision program address format: 

site, gateway, controller, fb 

EXAMPLE  1, 2, 13, 5  

Receive Time $receive_time$  The time at the workstation when the alarm was 

received.   

EXAMPLE  Nov 12, 2012 6:46:31 PM 

Recipient Device 

ID  

$device_id$ The device ID of the device where the alarm came 

from.  

EXAMPLE  8:2423101 

Record Type  $record_type$ The type of alarm.  

EXAMPLE  BACnet, Supervision®, System 

Reference Path  $reference_path$  Path to alarm source. Available in all alarm actions.  

EXAMPLE  #e_b_vav_ahu_b/ssp_stop 

Reference Value  $reference_value$  The 'reference value' from the alarm source. Valid 

only for alarm type FLOATING LIMIT.   

EXAMPLE  83 

Referenced 

Bitstring 

$referenced_bitstring$  The value of the 'referenced bitstring' value from the 

alarm source. Valid only for alarm type CHANGE OF 

BITSTRING.   

EXAMPLE  1011011101101 

RTN Time $RTN_time$  The time when the alarm returned to normal.  

EXAMPLE  Nov 12, 2012 6:46:31 PM 

Setpoint Value $setpoint_value$  The 'setpoint value' from the alarm source. Valid 

only for alarm type FLOATING LIMIT.   

EXAMPLE  72 

Short Message $short_message$  The formatted alarm short text.     

Site  $site$  The display name of the site the alarm came from.   

EXAMPLE  Kennesaw 

Source  $source$ The display name of the alarm source microblock 

that generated the alarm.   

EXAMPLE  SAT_HI 

Source 

description  

$source:description$  The Description field of the alarm source microblock 

that generated the alarm.  

EXAMPLE  High Cooling Supply Air Temp 
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Field Code 

Name 

Field Code Description 

Source Path $source:<path>$  Substitute <path> with the path to the value you 

want to display. See Defining WebCTRL® paths. 

Example to add text value: 

$source:~equipment.display-name$ 

Example to add a numeric value:  

$source:/trees/geographic/rd_facility/ 

zone_1/lstat/present_value$ 

NOTES   

 You can use Global Modify (page 27) to get the 

path. 

 For legacy systems, use the latched data field 

codes.    

System Directory  $system_dir$  The system folder name.   

EXAMPLE  c:\WebCTRLx.x\webroot\ 

world_corporation 

To State $to_state$ The current state of the alarm source.  

EXAMPLES  NORMAL, FAULT, OFF NORMAL, HIGH 

LIMIT, LOW LIMIT 

 

 

 
 

Time-lapse 

You can replay up to 24 hours of Graphics, Alarms, or Trends pages starting on a specified date and 

time. Time-lapse can be a helpful troubleshooting tool. 

The Graphics page can replay only trended values. Values that are not trended are grayed out. 

Floorplan areas without trend data are dark grey. 

NOTES   

 If a graphic is linked to a microblock value without an embedded trend but a Digital Trend or Analog 

Trend microblock is attached to the linked microblock by a wire, Time-lapse will use the wire trend's 

value. 

When the graphic is viewed in Time-Lapse: 

 The data in a data table or chart will not change.  

 A color map will ignore report data and show thermographic colors. 

  

For Time-lapse to show thermographic colors, the WebCTRL® application polls each router in the 

system at specified intervals and collects color. Color is collected for the router and its downstream 

controllers only if their control program contains a Setpoint, Set Color, or Set Color If True microblock. 

The Server then uses the collected colors to create a trend called Color Trend.  
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To play Time-lapse 

1 Select the location on the tree where you want to see the time-lapse. 

2 Click  at the top of the page. 

3 In the Replay field, select the length of time that you want to replay. The replay will step through the 

data at the interval shown. 

4 In the Start field, select the date and time that you want the replay to begin. You can click: 

○ The  buttons to change the day or time. 

○ The  to select the date. 

○ A date/time field, and then type the new number. 

5 Click Accept. The time-lapse immediately begins to play. 

6 Use the following items to work with the time-lapse. 

  

   

TIP  You can enable historical trending for trended values to have more trend data available in 

Time-lapse and to have the data retrieved faster. 

NOTES 

 While in time-lapse, you can navigate to other locations in the tree. 

 You can select an alarm on the Alarms page and then click the Activate Time-lapse button. This 

changes the time-lapse to the 1-hour period in which the alarm occurred. You can step backward or 

forward through the time-lapse at 1-minute intervals to see what other alarms occurred during that 

hour. You can also go to Graphics or Trends to see what else happened when the alarm occurred.  

 The white horizontal line on a Trends time-lapse indicates where the replay currently is in the 

time-lapse range.  

 

 
 

To change polling interval or duration or to turn off color collection 

1 On the System Configuration  tree, select System Settings. 

2 On the General tab under Trends, do one of the following: 

○ In the Poll Interval field, change the frequency that the server collects color trend data from 

the routers. 

NOTE  Last Poll Duration shows how long the last polling of the routers took. 

○ If directed by Automated Logic® Technical Support, uncheck Enable Server Trending of Color 

to stop color collection. 

3 Click Accept. 
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Reports 

Use WebCTRL® reports to monitor and troubleshoot your system. Your WebCTRL® license and/or 

edition determines which of the following things you can do in the WebCTRL® interface. You can: 

 Run preconfigured reports  

 Run custom reports 

 Schedule reports 

 Create custom reports   

See WebCTRL® editions and optional packages (page 3). 

 

 
 

Preconfigured reports 

The preconfigured reports shown in the Reports button drop-down list vary depending on which tree 

you selected.  

   

In the Geographic  tree: 

  

In the Network  tree: 

  

 

 

              

  

 

  

A preconfigured report shows data for the selected tree item and all of its children. 

  

This preconfigured 

report... 

allows you to... 

  

Alarms 

 

Alarm Actions Create a summary of the information configured on the Alarms > Actions 

(page 67) tab. 

Alarm Prefixes & Details Create a summary of the information configured on the Alarms > 

Messages (page 91) tab. 

Alarm Sources Create a summary of potential alarm sources as configured on the 

Alarms > Enable/Disable (page 88) tab. 

Alarms View, sort, and filter the information on the Alarms View (page 61) tab. 
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Commissioning 

 

Equipment Checkout View the information on the Equipment Checkout tab of the equipment's 

Properties page during commissioning. Also, find equipment that has 

not been fully commissioned. 

Test & Balance View the results of VAV box commissioning. Running this report 

automatically uploads calibration parameters to the WebCTRL® 

application. 

  

Equipment 

 

Locked Values Find all locked points and locked values. 

NOTE  Locks in the Airflow microblock are not reported. 

Network IO Verify the programming and status of all network points—especially 

useful for commissioning controllers used for third-party integration. 

Parameter Mismatch Discover where your system has parameter mismatches that need to be 

resolved. 

Point List View the details of all points. Verify that all points have been checked 

out during commissioning. Also, create custom lists for other 

contractors. For example, create a list of BACnet IDs. 

Trend Usage Creates a summary of the information configured on the Trends > 

Enable/Disable (page 52) tab. 

  

Schedules 

 

Effective Schedules View all equipment that may be scheduled and the net result of all 

schedules in effect for a selected date and time. 

Schedule Instances Find every schedule with its location that is entered at and below a 

selected tree item. This report can help you discover newly added and 

conflicting schedules. 

  

Security 

  

NOTE  You must have the Advanced Security package to run these 

reports.  

Location Audit Log View chronological lists of location-based changes, the operators that 

made them, and the reasons for the changes. This report includes 

changes such as property edits, downloads, driver changes, and view 

changes.  

System Audit Log View chronological lists of system-wide changes, the operators that 

made them, and the reasons for the changes. This report includes 

changes such as any change made on the System Configuration  

tree, login/logout, and scheduled processes like deleting expired trends. 
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Network 

 

Controller Status Discover network communication problems (shown as purple squares on 

the report) that need troubleshooting. The report also shows boot and 

driver version, download information, and if controller has 4.x or later 

driver, the report shows the serial number and Local Access port status.  

Equipment Status Display the thermographic color, status, and prime variable of each 

control program. 

  

 

 
 

To run a preconfigured report 

1 Select an item on the Geographic  or Network  tree. 

2 Click the Reports button drop-down arrow, then select a report. 

3 On the Options tab, define the layout and content of the report. 

NOTES 

○ Changing the size and orientation of the printed page also changes the report layout on the 

View tab. 

○ To create a CSV (Comma Separated Values) file after you run the report, select Support CSV 

text format. See To create a report PDF, XLS, or CSV file (page 141). 

○ The current operator's report options are saved so that when that operator logs in again, the 

same options are used. 

4 Click Run. 

  

NOTE  Click Schedule to schedule the report to run on a recurring basis. See Scheduling reports (page 

142). 

 

 
 

Custom reports 

Custom reports are managed through the WebCTRL® Report Manager that shows a list of all custom 

reports in your system. In the Report Manager, you can: 

 Create a new custom report (page 106) 

 Copy an existing report as a starting point for a new report (page 106) 

 Edit or delete an existing report (page 125) 

 Export report(s) to a file so that it can be imported into another system (page 125) 

  

A custom report can provide data for a data table (page 128), chart (page 132), or color map (page 

136) on a Graphics page.  

  

NOTES   

 A custom report may appear in the Report Manager but not appear in the Reports button menu 

because its only purpose may be to provide data to an item on a Graphics page.  

 To support upgraded systems, you can still create and access legacy (v6.5 and earlier) custom 

reports (page 143). These reports appear only in the Reports button drop-down menu, but not in 

the Reports Manager. 
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Creating a custom report 

1 Click the Reports drop-down arrow, and then select Report Manager. 

2 Click Add. 

 TIPS   

○ To save time when making a report that is similar to an existing report, select the existing 

report in the Report Manager, and then click Copy. The Report Editor opens the new report so 

that you can make changes. 

○ Click on the Display Name or ID heading in the Report Manager to sort the column. 

3 Enter information on the following Report Editor tabs until you have created the report.  

○ Type tab (page 107) 

○ Columns tab (page 109) 

○ Variables tab (page 120) 

○ Where tab (page 121) 

○ Options tab (page 121) 

○ Output tab (page 122) 

  

NOTES   

 As you create your report, you can use the Preview section on each tab to check your work. See To 

preview a report (page 124). 

 After you create the report, you can go to any item in the tree where the report is accessible, and 

run it. See To run a custom report (page 125). 

 A report can have a maximum of 50 columns and 1000 rows. 

  

 CAUTION  As you move from tab to tab in the Report Editor, click Apply to save your changes on a 

tab. If you click Cancel on a tab, all unsaved changes on any tab will be lost. Tabs that have unsaved 

changes have a pencil icon beside the tab name. For example, . 
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Type tab 

1 Enter the necessary information about the report you are creating. See table below. 

2 Click Accept or Apply.  

  

Field Notes 

Display name The name that will appear in the Reports button drop-down list. 

ID A unique ID for the report (letters, numbers, underscores, and hyphens only; 

no spaces or special characters). 

Show in Reports 

menu 

By default, the report name will appear directly in the Reports button 

drop-down list, not in a category. You can: 

 Check this box and then select a category for the report. See To organize 

custom reports by category (page 126). 

 Uncheck this box so that this report does not appear in the Reports button 

drop-down list. For example, you could uncheck this box if the report will 

provide data to a Graphics page but does not provide valuable information 

as a stand-alone report. 

Primary column Select the type of information that you want the report to be based on. 

NOTE  If you change your initial selection, click Change to have your new 

selection take effect. 

 Select... Then... 

 Control Programs Do one or both of the following to create the list of 

control programs. The primary column will list the 

equipment that use those control programs. 

 Enter a control program name, and then click Add. 

You can use wildcards. See the help text to the 

right of this field. 

 Select from the list of existing control programs. 

 Locations Do one or both of the following to create the list of 

locations that will appear on each row in the primary 

column: 

 Select locations in the Geographic  or Network 

 tree. 

 Enter a location name, and then click Add.  

 Reference Names Enter a reference name and then click Add. You can 

use wildcards. See the help text to the right of this 

field.  

Add more reference names, if desired, to build a list of 

reference names. The primary column will list the 

locations that have the reference names. 

Select the type(s) of reference names that you added. 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

108 

 

Field Notes 

 Date Range Choose one of the following: 

 Previous:  A specified number of previous days, 

weeks, months, quarters, or years. You can choose 

to include the current time period. 

 From date:  A specified number of days, weeks, 

months, quarters, or years starting at a specific 

date (yyyy/mm/dd). 

NOTE  You can enter a value or variable name in the 

fields for these 2 options. If you enter a variable, it 

must be defined on the Variables tab (page 120). 

Frequency:  If you choose Months or Days in the 

Previous or From date fields, you can choose how 

often the data is to be reported. For example, if you 

choose a frequency of Every 15 minutes, the primary 

column could look similar to the following: 

 

  

Date Range format in report:  Type the date format 

that you want to see in the report. See Date formats 

(page 109) for a list of supported formats. 

 Existing Report Select an existing report from the drop-down list or 

enter a report name in the text field. The existing 

report will be embedded in the new report so that you 

can add columns to it. Any changes to the existing 

report will also be reflected in the new report. 

 Color Map Select this option to show colors on a Graphics page. 

For example, you could have a campus map where 

each building would show green for good energy 

usage or red for high energy usage. See To produce a 

color map (page 136). 

Hide Primary column 

in report  

Check to have this column not appear in the report. 

Primary column 

header 

If you do not hide the Primary column, type the header that you want to 

appear at the top of this column. 
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Date formats 

If your Primary column is a Date Range, use the following information to enter a format in the Date 

Range format in report field. 

 

 For Type... Example 

Year yyyy 

yy 

2017 

17 

Month MMMM 

MMM 

MM 

September 

Sep 

9 

Week in year w 27 

Week in month W 2 

Day in year D 189 

Day in month d 12 

Day of week in month F 2 (2nd Thursday in June) 

Day name EEEE 

E 

Tuesday 

Tue 

Day number in week u 1 (Monday), 2 (Tuesday), etc. 

 

Examples of combinations: 

yyyy-MM-dd 

MMMM yy 

MMM/yyyy 

MM/dd/yy D 

= 

= 

= 

= 

2017-06-02 

June 17 

Jun/2017 

06/02/17 153 

  

NOTES 

 To include a single quote, type two single quotes. Example:  MMM ''yy = Jun '17 

 To include static text, enclose it in single quotes. Example:  'Year' yyyy = Year 2017 

 For more information on date formats, search the Internet for "java simple date format". 

 

 

 
 

Columns tab 

The Primary column for a table is defined on the Type tab. You define the remaining columns on the 

Columns tab. To define the columns in your report, you can: 

 Add each individual column (page 110) 

 Copy an existing column (page 112) 

 Replicate a column (Trend Data only) (page 112) 
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To add a column 

1 Click Add. 

2 Enter or select options in the first four fields that appear. See table below. 

3 Select an option in the Column data is from field. See the gray rows in the table below for a 

description of the options. 

NOTE  If you change your initial selection, click Change to have your new selection take effect. 

4 Select or enter information for the option you chose in step 1. See table below. 

5 Click Accept or Apply.    

 

Field Notes 

The following four fields are common to all of the options from step 1 above. 

Display name The name that will be shown in the report as the column's header. 

ID A unique ID for the column (letters, numbers, underscores, and 

hyphens only; no spaces or special characters).  

Render data as  Value Shows a value in the report. 

 Hidden Hides the column in the report. The column's data can be 

used to produce a value for another cell.  

 Color Uses the column's value to determine a color on a color map 

(page 136). Set the Column data is from field to Expression 

or Function, and then enter the appropriate information that 

returns a color value.  

 Icon Shows an icon to indicate a certain condition. Set the 

Column data is from field to Expression, and then enter an 

expression that says what icon filename to show for a 

particular condition. You can use the icons included with 

your system or you can create custom icons. See Icons (page 

119) for more information. 

Column format Lets you define the column's alignment, width, and format of digits. 

NOTE  Column format does not apply if you select Hidden or Color in 

the Render data as field.  

 

  

The following fields are based on your selection in the Column data is from field. 

Path The column's output will be based on a path to a value in the 

WebCTRL® system. 

     Path Enter the path to the value you want. See Defining WebCTRL® paths. 

     Show value as text Check to have the value reported as text instead of its numerical 

value. For example, show the word On instead of 1. 
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Expression The column's output will be based on the result of an expression (page 

112). 

  

Trend Data The column's output will be based on a value calculated from a range 

of trend data. 

     Trend path Do one of the following: 

 Click the Select Trend Path button to choose the trended point. 

Typically, you want the full (absolute) path, but if needed, you can 

choose to get the relative path. 

 Type the path to the trend that you want the report to pull data 

from.  

See Defining WebCTRL® paths. 

     Operation Select the type of value or calculation that you want the column to 

show. See Operations (page 118) for a description of each option. 

     Interval sample If the selected operation allows, you can choose how to handle the 

first and last sample of the time period. For example, Include start 

time / exclude end time.  

     Database trends only Check to include only trends saved in the database, not those in the 

controller. 

     Show time of sample Check to include the time of the sample in the column. 

     Time range From primary 

column 

You can use this option if the report's primary 

column is a date range.  

 From column You use this option if your report began with an 

embedded external report that has a column 

containing date ranges. 

 Value A time period specified by entering a Start date and 

End date. 

 Past Enter a number of days, weeks, months, quarters, 

and years in the past. You can select whether or not 

to include the current time period. 

 NOTE  You can use a variable (page 120) for a Time range count or 

date field. The variable must be defined on the Variables tab. 

  

Function The column's output will be based on the value or manipulation of the 

value from another column. 

     Input column The column that you want to perform a function on. 

     Function Select an option in the drop-down list. See Functions (page 116). 

     Arguments A statement that contains the criteria of the function. See Functions 

(page 116) for argument formats and examples.  

NOTE  You can use a variable (page 120) name in the argument. The 

variable must be defined on the Variables tab. 
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NOTES 

 To delete a column, select the column in the table at the top of the page, then click Delete. 

 To change the order of the columns, select a column and then click  or  to move the column. 

  

 

 
 

To copy a column 

1 Select the column you want to copy in the table at the top of the Columns tab. 

2 Click the Copy button. 

3 Change the column's fields as needed. See field descriptions in To add a column (page 110). 

NOTE  The column's ID is incremented by 1. 

 

 
 

To replicate a Trend Data column 

When you have defined all the criteria for a trend column, you can quickly reproduce that column for 

other trend sources. 

1 Select the column in the table at the top of the Columns tab. 

2 Click the Replicate Column button. 

3 Select whether you want the Trend Path for the new columns to be the full (absolute) path or the 

relative path. Typically, you will leave this set on Full path. See Defining WebCTRL® paths. 

4 In the left column, select a location.  

5 The right column displays all trend sources at or below the selected location. Select the trend 

sources that you want. A column will be added for each instance of the selected trend sources at or 

below the selected location. 

6 Repeat steps 4 and 5 for any additional locations and points that you want in you report. 

7 Click Apply. 

8 Click Close. 

9 Change the each column's fields as needed. See field descriptions in To add a column (page 110). 

 

 
 

Expressions 

On the Report Editor's Columns tab, you can specify that a column's data is from an expression. 

WebCTRL® expressions are similar to expressions used in spreadsheet programs. The most basic 

expression is a math calculation, but an expression can also manipulate text.  

An expression generally consists of at least one item in dollar signs and an operator. See table below. 

The item in dollar signs can be:  

 Another column's ID 

 A path to an item in your system 

 A variable defined on the Report Editor's Variables tab 

Static text in an expression must be enclosed with single quotes. Any item that results in text should 

also be enclosed with single quotes. This example shows both situations:   'Filter is ' + '$filter_status$' 
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Example of a simple expression to compute the average value of min_temp and max_temp columns 

Expression:  ($min_temp$ + $max_temp$) / 2 

  

 

To verify that the expression you entered is formatted correctly, click Check Syntax. The result appears 

to the right of the button.  

NOTE  The result of checking an expression with a variable may not be accurate since variables can be 

used in such a wide variety of ways. 

  

Operators 

An operator defines how each piece of an expression is to be handled. The following table lists 

operators that can be used in expressions.  

  

Operators that return true/false (1/0) 

< Less than Compares numeric data. Returns true if the value to the left 

of the operator is smaller than the value to the right. 

> Greater than Compares numeric data. Returns true if the value to the left 

of the operator is larger than the value to the right. 

<= Less than or equal to Compares numeric data. Returns true if the value to the left 

of the operator is smaller than or equal to the value to the 

right. 

>= Greater than or equal 

to 

Compares numeric data. Returns true if the value to the left 

of the operator is larger than or equal to the value to the right. 

! Not Evaluates the expression and returns the opposite.   

Example:  !$zone_temp$ > 72 

If zone_temp is greater than 72, the expression is false. If 

zone_temp is not greater than 72, the expression is true. 

== Equal to Compares data. Returns true if the value on both sides of the 

operator are equal. 

!= Not equal to Compares data. Returns true if the value to the left of the 

operator does not match the value to the right. 

&& And Combines expressions. Returns true if the expressions on 

both sides of && result in true.  

|| Or Combines expressions. Returns true if the expression on 

either side or both sides of the operator results in true.  

Operators that return a numeric value 

+ Add Adds numeric data, expressions, or values. 

- Subtract Subtracts numeric data, expressions, or values. 

* Multiply Multiplies numeric data, expressions, or values. 

/ Divide Divides numeric data, expressions, or values. 

% Modulus Finds the remainder in the division of numeric data, 

expressions, or values. 
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Other operators 

( ) Parentheses Use to nest expressions. Operations in parentheses are 

evaluated before those outside parentheses. 

if   Syntax:  if (expression, true value, false value) 

Expression is evaluated and if 1/true, the true value is 

returned, otherwise the false value is returned 

  

Combining expressions 

Example 1: 

Expression:   $zone_temp$ < 60 || $zone_temp$ > 75 

Translation:  True if the current zone temperature is less than 60 or greater than 75 

Example 2: 

Expression:   ! ( $ai1/locked$ || $ai1/present_value$ > 100 ) 

Translation:  True if ai1 is not locked and al's present value is not greater than 100 

Example 3: 

Expression:   if ($zone_temp$ < 60 || $zone_temp$ > 75, 'out of range', 'good') 

Translation:  If zone temperature is less than 60 or greater than 75, show out of range. Otherwise, show 

good. 

  

Math functions 

   

Function Description 

abs (a) Returns the absolute value of a value. 

acos (a) Returns the arc cosine of a value; the returned angle is in the range 0.0 

through pi. 

asin (a) Returns the arc sine of a value; the returned angle is in the range -pi/2 

through pi/2. 

atan (a) Returns the arc tangent of a value; the returned angle is in the range -pi/2 

through pi/2. 

atan2 (y, x) Returns the angle theta from the conversion of rectangular coordinates (x, y) 

to polar coordinates (r, theta). 

cbrt (a) Returns the cube root of a value. 

ceil (a) Returns the smallest (closest to negative infinity) value that is greater than or 

equal to the argument and is equal to a mathematical integer. 

cos (a) Returns the trigonometric cosine of an angle. 

exp (a) Returns Euler's number e raised to the power of a value. 

floor (a) Returns the largest (closest to positive infinity) value that is less than or 

equal to the argument and is equal to a mathematical integer. 

hypot (x, y) Returns sqrt(x2 +y2) without intermediate overflow or underflow. 
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Function Description 

IEEEremainder (f1, f2) Computes the remainder operation on two arguments as prescribed by the 

IEEE 754 standard. 

log (a) Returns the natural logarithm (base e) of a value. 

log10 (a) Returns the base 10 logarithm of a value. 

max (a, b) Returns the greater of two values. 

min (a, b) Returns the smaller of two values. 

pow (a, b) Returns the value of the first argument raised to the power of the second 

argument. 

random () Returns a value with a positive sign, greater than or equal to 0.0 and less 

than 1.0. 

rint (a) Returns the value that is closest in value to the argument and is equal to a 

mathematical integer. 

round (a) Returns the closest long to the argument, with ties rounding to positive 

infinity. 

sin (a) Returns the trigonometric sine of an angle. 

signum (float f) Returns the signum function of the argument; zero if the argument is zero, 

1.0f if the argument is greater than zero, -1.0f if the argument is less than 

zero. 

sqrt (a) Returns the correctly rounded positive square root of a value. 

tan (a) Returns the trigonometric tangent of an angle. 

toDegrees (angrad) Converts an angle measured in radians to an approximately equivalent angle 

measured in degrees. 

toRadians (angdeg) Converts an angle measured in degrees to an approximately equivalent 

angle measured in radians. 

  

Text functions 

  

Function Description 

char (code) Returns a single character string for the given Unicode character code. For 

example, char(36) will create the string "$". 

charAT (s, pos) Returns the character and the position. 

compareTo (s1, s2) Compares two strings. <0 if s1 <s2, 0 if s1 == s2, >0 if s1 > s2 

compartToIgnoreCase 

(s1, s2) 

Compares two strings ignoring case. <0 if s1 <s2, 0 if s1 == s2, >0 if s1 > s2 

concat (s1, s2, ...) Concatenates the two or more strings together. Same as "s1 + s2 + " 

dateDiff (s1, s2) Returns the difference between two dates, in days. Parameters may be date 

variables or strings of format 'yyyy/mm/dd' 
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Function Description 

endsWith (s1, s2) Returns "1" if s1 ends with the string s2, else "0". 

equals (s1, s2) Returns "1" if strings are equal, else "0". 

equalsIgnoreCase  

(s1, s2) 

Returns "1" if strings are equal ignoring case, else "0". 

indexOf (s1, s2, start) Returns the index (position) of the first occurrence of the second string in the 

first string after "start" position. Use 0 to start from beginning of string. It 

returns -1 if S2 is not found. 

lastIndexOf (s1, s2) Returns the index (position) of the last occurrence of the seconds string in 

the first string. It returns -1 if S2 is not found. 

length (s1) Returns the length of the strings. 

replace (s1, s2, s3) Replaces all occurrences in "s1" of "s2" with "s3". 

startsWith (s1, s2) Returns 1" if s1 starts with s2. 

substring (s1, i2, i2) Returns subset from string s1 starting at index i1 to index i2. (i2 must be >= 

i1) 

toLowerCase (s) Converts string to lower case. 

toUpperCase (s) Converts string to upper case. 

trim (s) Removes white space from the beginning and end of the string. 

 

 
 

Functions 

On the Report Editor's Columns tab, you can specify that a column's data comes from one of the 

following functions that returns another column's value or manipulation of that value.  

  

Function Description 

Valid Column Returns true/false if input column is valid 

Default Value Returns the column's value if it is a valid value, otherwise returns the 

argument. 

Format Formats a value using Java String format function. 

For more information, search the Internet for "string format with java 

8". 

Format Duration Formats a trend duration value. 

Argument formats:      

%d%, %h%, %m%, %s%  (clock based) 

%D%, %H%, %M%, %S%  (total count rounded down) 

Example 1:  %ddd% days %hh%:%mm% = 003 days 13:50 

Example 2:  %M% min = 283 min 
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Function Description 

Convert Values to Text Converts a number to a text value.  

Argument format:   

Define a set of comma separated statements.  

Format of each statement:  lower limit=value 

Example 1:  0=F,60=D,70=C,80=B,90=A,100=A+ 

Example 2:  F,60=D,70=C,80=B,90=A,100=A+ 

(first bucket is default for anything below second bucket's value) 

Example 3:  Cold,68=Perfect,75=Warm 

Example 4:  65=Cold,68=Perfect,74=Perfect,75=Warm,76=Warm 

Convert Integer to Text Converts an integer value to text. If no match, value is empty. 

Argument format:   

Comma separated list of statements. 

Format of each statement:  #=text 

Example:  0=Zero,1=One,2=Two,3=Oops 

Convert Text to Integer Converts text to an integer value. Matching is case insensitive. 

Argument format:   

Comma separated list of statements.  

Format of each statement:  text=# 

Use * to match any letters. 

Example 1:  Off=0,On=1  -or-  off=0  -or-  OFF=0 

Example 2:  a*=1,b*=2 

                  a=1  -or-  APPLE=1 

                  B=2  -or-  Book=2 

Convert to Color Attempts to convert an ALC color value (0 to 15) to a color for a color 

map.   

Color Gradient Converts a defined minimum and maximum number each to a color. It 

then maps numbers between minimum and maximum to colors to 

form a gradient.  

Format:      min,max,color1,color2 

Example 1:  1, 10, red, blue    

Example 2:  1, 10, #FF0000, #0000FF 

Date Range Start Formats the START date/time of a Date Range. 

Examples:   yyyy/MM/dd hh:mm = 2017/07/04 11:30 

                  hh:mm:ss = 08:35:16 

For more information, search the Internet for "customizing date time 

formats with java". 

Date Range End Formats the END date /time of a Date Range. 

Examples:   yyyy/MM/dd hh:mm = 2017/07/04 11:30 

                  hh:mm:ss = 08:35:16 

For more information, search the Internet for "customizing date time 

formats with java". 

Ordinal Value Converts a text enumeration to its integer value when possible.  
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Function Description 

Regular Expression Finds a piece of text from a larger text body. Example:  Finds a piece 

of text in a modstat. 

For more information, search the Internet for "regular expression 

patterns with java 8". 

  

 
 

Operations 

On the Report Editor's Columns tab, you can specify that a column's data comes from trend data. You 

can then specify one of the following operations be performed on the trend data.  

  

This operation... Shows the following for the specified time range 

Average Value The average value. 

Count All Trend Records Number of trend records collected (includes items such as time 

changes and enabling/disabling the trend log). 

Count Trend Samples Only  Number of times the trend value was read. 

First Value w/Time The first trend sample and the time it was read. 

Last Value w/Time The last trend sample and the time it was read. 

Maximum Value w/Time The largest value and the time it was read. 

Minimum Value w/Time The smallest value and the time it was read. 

Aggregate Consumption Total consumption for meter trend data. This operation makes 

appropriate calculations for meters that reset to 0. 

Sum of Values The total of all trend values. 
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This operation... Shows the following for the specified time range 

% Time in Range You can enter 3 types of arguments to determine the percentage of 

time that the trend value was: 

 One or more single values. 

Format:  A comma separated list of values 

Example:  Enter  1,2,3,4  to get the percentage of time that the 

trend value was 1, 2, 3, or 4. 

 

 Between two values 

Format:  A single statement or a comma separate list of 

statements 

Example 1:  Enter the statement  65:75  to get the percentage of 

time that the trend value was 65 to 75. 

Example 2:  Enter the statement  28:30,38:40,48:50  to get the 

percentage of time that the trend value was 28 to 30, 38 to 40, or 

48 to 50. 

 

 Not a specified value or between two values 

Format:  !(value) 

Example 1:  Enter !10 to get the percentage of time that the trend 

value was not 10. 

Example 2:  Enter !28:30,38:40 to get the percentage of time that 

the trend value was not 28 to 30 or 38 to 40. 

 

 
 

Icons 

You can design a report to show icons to indicate certain conditions. You can use the icons included 

with your system or create custom icons. On the Report Editor's Columns tab:  

1 Set Column data is from field to Expression. 

2 Set Render data as field to Icon. 

3 Enter an Expression that contains the icon's file name. See the table below for the file names of 

icons included with your system, or see "Custom icons" below. 

  

Included icons  

  

Color On Off Animated .gif that flashes 

on and off 

Red  
light_on_red.png 

 
light_off_red.png 

 
light_alarm_red.gif 

Blue  
light_on_blue.png 

 
light_off_blue.png 

 
light_alarm_blue.gif 

Light blue  
light_on_ltblue.png 

 
light_off_ltblue.png 

 
light_alarm_ltblue.gif 

Green  
light_on_green.png 

 
light_off_green.png 

 
light_alarm_green.gif 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

120 

 

Color On Off Animated .gif that flashes 

on and off 

Yellow  
light_on_yellow.png 

 
light_off_yellow.png 

 
light_alarm_yellow.gif 

Magenta  
light_on_magenta.png 

 
light_off_magenta.png 

 
light_alarm_magenta.gif 

Orange  
light_on_orange.png 

 
light_off_orange.png 

 
light_alarm_orange.gif 

White  
light_on_white.png 

 
light_off_white.png 

 
light_alarm_white.gif 

 

Custom icons 

If you choose to use a custom icon, put the icon in one of the following places: 

 In WebCTRLX.X\webroot\<system name>\tables. Put only the icon's file name in the expression. 

 Anywhere under the webroot folder. Put the full path from the webroot folder in the expression. 

Example:   /_common/lvl5/skin/graphics/type/area.gif. 

  

 
 

Variables tab 

You can enter a variable in a Report Editor field so that you can edit that field when you run the report. 

For example, if you create a Date Range report for the previous 4 months, you can put a variable 

named number_of_months in the field instead of a 4. When you run the report, you can change the 

variable value to 12 to show the previous 12 months. 

1 Click Add to create a new variable. 

2 Enter the variable's criteria. See table below. 

3 Click Accept or Apply.  

  

Field Notes 

ID This ID is what you will insert in a report field that you want to be able to 

change when you run the report. (Use letters, numbers, underscores, and 

hyphens only; no spaces or special characters). 

Type Select an option from the drop-down list, and then enter a Value. 

  Type Value 

  String A text phrase. Can contain letters, numbers, and special 

characters. 

  Number Can contain any number in any format. 

  Date  Format is yyyy/mm/dd. 

  Time Format is hh:mm:ss. 

User editable 

Display name 

Check to let a user edit the variable's value when they run the report. Enter a 

Display name for the variable that will appear on the page where you run the 

report. 
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NOTE  The table at the top of the Variables tab shows the variables that you defined. Their order in this 

table is how they will appear in on the page where you run the report. To change the order on the 

Variables tab, select a variable in the table and then click  or . 

 

 
 

Where tab 

1 Click the drop-down list for This report can be accessed from, and then select an option.  

2 Click Define Where. 

3 Select or enter information for the option you chose. See table below. 

4 Click Accept or Apply.  

  

Field Notes 

Anywhere The report can be run from anywhere in the system. 

Control Programs Do one or both of the following: 

 Type a control program name, and then click Add.  

NOTE  You can use wildcards. See the examples in the WebCTRL® 

interface. 

 Select existing control program(s) from the list. 

Location Types Select the type(s) of locations where you want the report to be available. 

Locations Select location(s) on the trees, or type a location name in the text box. 

 

 
 

Options tab 

1 Click the drop-down list to the left of the Add button, and select an option. 

2 Click Add. 

3 Select or enter information for the option you chose. See table below. 

4 Click Accept or Apply.  

  

Field Notes 

Show 

Max/Min/Avg/Total 

Check the appropriate boxes to show 

the maximum value, minimum value, 

average, or total at the bottom of the 

columns. Enter the Column ID of the 

column that you want labels to be in.  

 

Show first ___rows Enter the maximum number of rows to be displayed when the report is 

previewed or run. This does not include the Max/Min/Avg/Total rows. 

NOTE  You can enter a value or variable name in this field. If you enter a 

variable, it must be defined on the Variables tab. 
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Field Notes 

Sort column Sorts the specified column(s) from A to Z or 1 to ... 

Example of comma separated list of column IDs: 

date_range, kw_usage, normalizer 

Check Reverse Sort to sort Z to A, ... to 1. 

Filter rows Select Include row when or Exclude row when a specified column (ID) equals 

a specified value. 

  

NOTE  You can use multiple options for your report, but be aware that they will be processed in the 

order that they appear in the table at the top of the Options page. For example, if your first option is to 

Show the first 10 rows and your second option is Filter rows, only the 10 rows will be filtered. To 

change the order of processing, select an option in the table and then click  or . 

 

 
 

Output tab 

On this tab, you can define the criteria for a report PDF or a chart on a graphic. 

1 Select or enter information as needed. See table below. 

2 Click Accept or Apply.  

  

Field Notes 

PDF Output  

Page orientation 

Select Portrait  or Landscape . 

Page size Select the page size that you want for a pdf. 

Ignore page width If the report exceeds the width of the selected Page size, select to ignore that 

width and show all columns in the online PDF. 

Font size You can adjust the font size for the report's body.  

Title font size You can adjust the font size for the report's title. 

Chart These fields apply if you add a Chart control to a graphic in ViewBuilder. See 

To produce a chart (page 132). 

Axis label For a Horizontal Bar Chart, this label will appear below the X axis. 

For a Vertical Bar Chart or Line Chart, this label will appear to the left of the Y 

axis. 

Data series A column or row of numbers that are plotted in the chart. 
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Field Notes 

 Example: For this report... 

 

 
 

A horizontal bar chart will look like this... 

 By column 

 

 By row 

 
  

 NOTE  Pie charts show only one data series. 
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Field Notes 

Show title 

Show legend 

Show chart border 

 
  

Graphics Refresh A chart or data table control will refresh its report data every time you visit the 

Graphics page or at the following refresh rates while the Graphics page is 

displayed.  

  

If the report's primary column is... Default refresh rate is... 

A Date Range with a Frequency of Hourly 

or Every 15 minutes 

Every 5 minutes 

Any other Date Range 0 (never refreshes) 

Anything else Every 30 seconds 
 

Use custom refresh 

rate 

Check this field to change the refresh rate. If your chart or data table shows a 

lot of data, refreshing frequently could slow down your system. If most of the 

data is historical data that does not change, you may want to set a longer 

refresh time.   

Reset to defaults Click Reset to return all fields on the Output tab to their original settings. 

 

 

 
 

To preview a report 

At the bottom of every tab in the Report Editor is a Preview section so that you can check your work. 

Click Show to see the report. If you make changes to the report, click Refresh to update the preview. 

You have the following options when previewing the report: 

  

Show all columns Includes columns defined as hidden and a column with additional 

information about the Primary column. 

Show Column ID Each column header shows the display name and column ID. 

Show Debug Information Gives information for troubleshooting a report. 
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NOTES   

 If the preview shows Error, hover your cursor over the word to see a description of the error. 

 If the preview shows ?, this indicates there is no data. 

 

 
 

To run a custom report 

1 Select an item on the Geographic  or Network  tree where the report you want to run is 

accessible.  

2 Click the Reports button drop-down arrow, and then select the report. 

3 Optional:  If the report was designed with variables (page 120), you can change the variables' 

values at the top of the page.   

NOTE  Click Reset if you want to change the variables back to the value that was assigned when 

the report was created. 

4 Click Run. 

  

NOTES 

 A ? in the report indicates there is no data. 

 Click Edit to change the report's design. See Creating a custom report (page 106) for field 

descriptions. 

 Click Schedule to schedule the report to run on a recurring basis. See Scheduling reports (page 

142). 

  

 
 

To edit or delete a custom report 

NOTE  If you have an i-Vu® Pro 5 or i-Vu® Pro 32 system, you cannot create or edit custom reports. 

  

1 Click the Reports button drop-down arrow, and then select Report Manager. 

 TIP  Click on the Display Name or ID heading to sort the column. 

2 Select the report, and then do one of the following: 

○ Click Edit to open the Report Editor, make changes as needed, then click Accept. See Creating 

a custom report (page 106) for field descriptions. 

NOTE  You can also double-click a report to open it in the Report Editor. 

○ Click Delete, then click OK.  

 

 
 

To export or import a custom report 

You can export one or more reports from one system, copy them to another system, and then import 

the reports into the WebCTRL® interface. 

  

To export reports 

1 Click the Reports drop-down arrow, and then select Report Manager. 

2 Click Export. 

3 Select the checkbox(es) for the report(s) that you want to export, or check Select All. 
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4 Click Export. 

NOTE  A single report is exported as a .table file. Multiple reports are exported as a .zip file. 

 TIP  In the Report Manager or Export Report window, you can click on the Display Name or ID 

heading to sort the column. 

  

To import reports 

1 Copy the .table or .zip file to the computer where you are importing them. 

2 In the WebCTRL® interface, click the Reports drop-down arrow, and then select Report Manager. 

3 Click Import. 

4 Browse to the file that you are importing. 

5 If a report ID that you are importing matches an existing report ID, select how you want to handle 

the situation: 

  

Rename Rename the report that you are importing. 

Replace Replace the existing report with the report you are importing. 

Skip Do not import the report with the duplicate name. 

  

6 Click Import. 

 

 
 

To organize custom reports by category 

When you create a custom report, you can assign it to a category so that the report appears in the 

category in the Reports button drop-down list. 

  

 
  

To create a report category 

1 On the System Configuration  tree, click    to the left of the Categories folder, then click 

Report. 

2 Click Add. 

3 Type the Category Name and Reference Name. 

4 Select a privilege so that only operators with that privilege can access reports in the category. 
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5 Click Accept. 

  

NOTES   

 To edit a category, select the category, make your changes, then click Accept. 

 To delete a category, select the category, click Delete, then click Accept. 

 

 
 

Using a custom report as the source for a Graphics page 

A WebCTRL® custom report can be the data source for the following items on a Graphics page: 

 A data table  

 A chart 

 A color map  

  

For example, this report... 

 

...supplies data to the chart and data table on this graphic 

 

 

NOTE  When the graphic is viewed in Time-Lapse: 

 The data in a data table or chart will not change.  

 A color map will ignore report data and show thermographic colors. 
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To produce a data table 

To produce a data table like the example below, first create the report in the WebCTRL® interface and 

then create the corresponding graphic in ViewBuilder.   

  

 

  

To create the report in the WebCTRL® interface 

   

 Instructions Example 

1.  Click the Reports drop-down 

     arrow, and then select Report 

     Manager. 

 

2.  Click Add. 

3.  On the Report Editor's Type tab, 

     type a Display name and ID for 

     the report. 

4.  In the Primary column field, select 

     the type of information that you  

     want the report to be based on  

     (Control Programs in this  

     example). 
 

5.  On the Type tab (page 107), enter the 

criteria  

     for the option that you selected in  

     step 4.  

6.  In the Primary column header field,  

     enter the heading that you want for 

     that column (Equipment in this 

     example). 
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 Instructions Example 

7.  Define each column in the report on  

     the Columns tab (page 109). See the 

examples  

     on the right. 

8.  Define any other information you  

     may want, and then click Accept. 
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 Instructions Example 

 

 

  

To create the graphic in ViewBuilder 

  

 Instructions Example 

1.  Select File > New > Graphic, and  

     then click OK. 

 

2.  Click the Add Control tab   

     in the Tools window.  

3.  Click the Data Table control and  

     then click in the workspace. 
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 Instructions Example 

4.  In the Properties window, enter the 

     Report ID exactly as it appears in  

     the WebCTRL® Report Editor. 

5.  Resize the control so that it is at least 

     the size that the table will be in the 

     WebCTRL® interface. To resize, 

     enter a specific size in the Properties 

     window or drag the handles on the 

     control. 

     NOTE  If the table is cut off when  

     you view the graphic in the  

     WebCTRL® interface, increase the  

     size of the control in ViewBuilder. 

6.  If you defined variables in the Report  

     Editor and you want to use a  

     different default value for the Data  

     Table, click  in the Properties  

     window, type the variable's ID (from  

     the Report Editor), and then type   

     the new default value. 

NOTE  To have the data table show data 

for a location other than the graphic's 

location, add a variable and type 

location in the ID column. Type the 

path to the location in the Value column. 

 

7.  Save the graphic.  
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To produce a chart 

To produce a bar chart like the example below, first create the report in the WebCTRL® interface and 

then create the corresponding graphic in ViewBuilder.   

  

 

  

NOTE  When a chart that is based on a report is displayed on a Graphics page, you can hover over 

various points on the chart to see values. You can also click on each item in the legend to turn that 

information on and off. See Using a custom report as the source for a Graphics page (page 127) for 

more information on a chart. 
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To create the report in the WebCTRL® interface 

   

 Instructions Example 

1.  Click the Reports drop-down 

     arrow, and then select Report 

     Manager. 

 

2.  Click Add. 

3.  On the Report Editor's Type tab, 

     type a Display name and ID for 

     the report. 

4.  In the Primary column field, select 

     the type of information that you  

     want to report based on (Date  

     Range in this example).  

5.  On the Type tab (page 107), enter the 

criteria  

     for the option that you selected in  

     step 4. 

6.  In the Primary column header field,  

     enter the heading that you want for 

     that column (Date Range in this 

     example). 
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 Instructions Example 

7.  Define each column in the report on 

     the Columns tab (page 109). 

     NOTE  In the example on the right,  

     all four columns have the same  

     criteria. 

 

 

  

8.  Define the Chart options on the 

     Output tab (page 122). 

9.  Define any other information you  

     may want, and then click Accept. 
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To create the graphic in ViewBuilder 

   

 Instructions Example 

1.  Select File > New > Graphic, and  

     then click OK. 

 

2.  Click the Add Control tab   

     in the Tools window.  

3.  Click the Chart control and then 

     click in the workspace. 

 

4.  In the Properties window, enter the 

     Report ID exactly as it appears in  

     the WebCTRL® Report Editor. 

5.  Select the Type of chart you want. 

6.  Resize the control so that it is at least 

     the size that the chart will be in the 

     WebCTRL® interface. To resize, 

     enter a specific size in the Properties 

     window or drag the handles on the 

     control.  

     NOTE  If the chart is cut off when  

     you view the graphic in the  

     WebCTRL® interface, increase the  

     size of the chart control in  

     ViewBuilder. 

7.  If you defined variables in the Report  

     Editor and you want to use a  

     different default value for the chart,  

     click  in the Properties window,  

     type the variable's ID (from the 

     Report Editor), and then type the 

     new default value. 

NOTE  To have the chart show data for a 

location other than the graphic's location, 

add a variable and type location in 

the ID column. Type the path to the 

location in the Value column. 

 

8.  Save the graphic.  
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To produce a color map 

A Graphics page color map shows specified colors for various conditions that are defined in a 

WebCTRL® report. For example, each building on a campus map could show a color that indicates its 

energy usage. See image below. 

A color map can also have an option that lets a user switch between different kinds of information. For 

example, in the image below, a user could click on the MTD kWh drop-down list and select YTD kWh. 

  

 

  

To produce a color map: 

1 Create the graphic in ViewBuilder. 

2 Create the corresponding report in the WebCTRL® interface. 

3 Edit the graphic to add information specific to the WebCTRL® report. 

See instructions below. 
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Create the graphic in ViewBuilder 

  

 Instructions Example 

1.  Add an image (floorplan, campus 

     map, etc.) to the graphic, and then  

     double-click the image to open the 

     Associations window. 

 

2.  Associate each item on your 

     image (zone, building, etc.) just 

     as you would associate zones on a 

     thermographic floorplan. See 

     "Associating zones on a floorplan 

     to equipment" in ViewBuilder 

     Help. 

     NOTE The Variable Color 

     checkbox in the Associations 

     window must be checked.  

3.  Click Save and Close. 

  

   

 

  

  

Create the report in the WebCTRL® interface 

  

 Instructions Example 

1.  Click the Reports drop-down 

     arrow, and then select Report 

     Manager. 

 

2.  Click Add. 

3.  On the Report Editor's Type tab, 

     type a Display name and ID for 

     the report. 

4.  In the Primary column field, 

     select Color Map. 
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 Instructions Example 

5.  Type a location in your system so  

     that you can preview the report  

     (#building_1 in the example).  

     This location is only for testing  

     your entries in the Report Editor. 

     Associations to actual locations  

     in the system will be made in 

     ViewBuilder.  

     NOTE  You can add more than one 

     location if you want to see more in 

     the preview. 

6.  Click Add.  

7.  Optional:  Select Include  

     equipment color column if you 

     want to automatically include a  

     column for WebCTRL®  

     thermographic colors.    

     NOTE  You can see this column in  

     the Preview section if you check  

     Show all columns. 

 

8.  Define each column in the report on 

     the Columns tab (page 109). See 

examples  

     of the first two columns on the  

     right. 
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 Instructions Example 

     A color map can retrieve color 

     information only from a column 

     that has the Render data as field 

     set to Color. 

9.  Define any other information 

     needed on the Report Editor tabs, 

     and then click Accept. 

      

 

  

  

Edit the graphic in ViewBuilder to add report information 

  

 Instructions Example 

Follow steps 1 through 5 if the colormap 

will show information from more than 

one report column. If not, skip to step 6. 

1.  Select Configure > View 

     Properties. 

2.  On the Local Variables tab, click 

     . 

3.  Double-click Boolean in the Type 

     column, and then select Report 

     column in the drop-down list. 

4.  Double-click variable in the Name  

     column, and then replace 

     variable with colormap_column. 

     NOTE  If the Graphic has multiple 

     images that will pull data from  

     different reports, add one variable 

     called colormap_column1, another 

     called colormap_column2, etc.  

5.  Click OK. 
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 Instructions Example 

6.  Double-click the image to open the  

     Associations window. 

7.  Click , and then enter the 

     following information: 

      •  Report ID:  Get the report ID 

          from the WebCTRL® Report 

          Editor. 

      •  Default Column ID:  This is 

          the column whose color is 

          displayed when the graphic 

          first appears. Get the Column 

          ID from the WebCTRL® 

          Report Editor. Leave blank if 

          the graphic will pull data from 

          only one report column. 

      •  Column Name Local 

          Variable:  Type the name of 

          the variable that you created in 

          step 5 above. Leave blank if 

          the graphic will pull data from 

          only one report column. 

 

8.  If a report uses a variable and 

     you want the colormap to use 

     a different default value than 

     what is defined in the 

     WebCTRL® Report Editor, 

     click  in the Report 

     Properties window, type the 

     variable's ID (defined in the 

     Report Editor), and then type the 

     new default value. 

 

9.  If the colormap will show 

     information from more than one 

     report column, add a control 

     (droplist or radio buttons) that will 

     allow the user to select the 

     information they want to see. 

10.  In the Microblock Path field, 

      enter the local variable that you 

      defined in step 4, enclosing it in 

      $$. 

11.  Finish the graphic and then test it 

      in the WebCTRL® interface. 
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Troubleshooting custom reports 

  

 If a Graphics page contains a chart, data table, or color map that is retrieving information from a 

very large report, the graphic may be slow to load or refresh. You can do the following to improve 

this condition: 

○ Verify that your system follows the recommendations in WebCTRL® v7.0 client, server, 

operating system, and database requirements. 

○ Reduce the size of the report by redefining the primary column criteria on the Report Editor's 

Type tab. 

○ Filter the report to show only a portion of the information. You can filter the report on the 

Report Editor's Options tab. 

○ Increase the refresh time (default is 30 seconds). If the chart, data table, or color map is based 

on information that changes infrequently, increase the refresh rate or set it to 0 to turn off 

refreshing. You can adjust the refresh rate on the Report Editor's Options tab. 

○ Reduce the number of controls on the graphic that are pulling data from different reports. 

  

 If an Invalid Report Definitions section appears at the bottom of the Report Manager page, one of 

the following has occurred: 

○ The report's file or file name has been manually manipulated, invalidating the report's digital 

signature. Contact Technical Support to resolve this problem. 

○ The report is set up to have an add-on supply content for the report, but the add-on has not 

been installed in the WebCTRL® interface. Install the add-on to resolve this problem. 

 

 
 

To create a PDF, XLS, or CSV file 

 

These reports... Can be output as... Notes 

v7.0 custom reports  A PDF file 

 A CSV file 
 

Preconfigured reports and 

v6.5 and earlier custom 

reports 

 A PDF file 

 An XLS file 

 A CSV file 

For a v6.5 and earlier CVS file, you must 

enable Support CSV text format on the 

Reports > Options tab before you run the 

report. 

 

To output a file: 

1 Run a report.  

2 Click PDF, XLS, or CSV to download the file. 

NOTE To create a CSV file when using Safari, see instructions below. 

  

To create a CSV file when using Safari  

1 Run a report.  

2 Click CSV. A pop-up displays the results. 

3 Select File > Save As. 

4 In the Format field, select Page Source. 

5 Add the .csv extension to the file name. 
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6 Select the save location in the Where field. 

7 Click Save. 

8 Close the popup. 

 

NOTE  If you need a digitally signed PDF to comply with 21 CFR Part 11, open the PDF in a program that 

supports digital signing such as the Adobe® Acrobat® application, then sign the PDF. The WebCTRL® 

application does not support digital signing because 21 CFR Part 11 requires that the signature be 

added manually, not through an automated process. 

 
 

Scheduling reports 

You can schedule a report so that it runs on a recurring basis. The report is saved as a file (PDF, CSV, or 

XLS), and you can choose to have it automatically emailed to someone. 

  

NOTE  You can also use the following alarm actions to run a report: 

 The Send E-mail alarm action (page 77) can run any WebCTRL® report and attach it to the email.  

 The Write to File alarm action (page 87) can run any WebCTRL® report and save it as a file.  

For both alarm actions, the report can be a PDF, HTML, XLS, or CSV file. 

 

 
 

To schedule a report 

1 Click the Reports drop-down arrow, and then select the report that you want to schedule. 

2 Click the Schedule button. 

3 Enter the information in each field.  

4 Click Accept. 

  

Fields Notes 

Description Enter a brief description of the report or how this schedule will be used. 

Operator The report will be run based on the selected operator's privileges. 

Run report Define when the report will run by selecting options in the drop-down lists. 

At __:__ __ Enter the time of day that you want the report to run. 

Save report as v7.0 reports can be output as a PDF or CSV file. Preconfigured reports and v6.5 

reports can also be output as an XLS file. Select the type of report file that you want.  

NOTE  See Output tab (page 122) for a description of the PDF options that are 

available in the Report Editor. 

Keep latest Enter the number of files and Schedule History entries that you want to keep for this 

report. As a new file or entry is saved, the oldest one is deleted. 

Email report Enter the information needed to email the report each time it runs. 

NOTE  For the WebCTRL® application to email a report, you must define the Email 

Server configuration on the System Settings > General tab (page 181). 
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To manage scheduled reports 

Click the Reports drop-down arrow, and then select Scheduled Reports. The table shows any report 

that was scheduled to run.* 

  

Select a schedule 

and then click... 

To... 

Edit  Change the report's schedule in the Schedule Editor. 

NOTE You can also double-click a schedule in the table to open the Schedule 

Editor. 

View History See when the report ran. Click PDF, CSV, or XLS in the Results column to 

download the report that was produced. 

NOTE  The XLS option is not available for v7.0 custom reports. 

Delete Remove the schedule. This removes its history and all associated files. 

  

*  You can also access this table by going to the System Configuration  tree and selecting Scheduled 

Reports.  

 

If a report fails 

The table below will show a red X and a system alarm will be generated. 

 

Select the schedule in the table above, and then click View History. Hold the cursor over the word 

Failure to see hover text describing what failed. 

 

 
 

Working with legacy (v6.5 and earlier) custom reports 

Although the WebCTRL® v7.0 interface has a new method of creating and managing reports, you can 

still create or edit the following reports that were available in WebCTRL® v6.5 and earlier systems. 

These reports will be accessible from the Reports button drop-down list, but not the Report Manager. 

  

This report... allows you to... 

Equipment Summary View the following information for equipment at or below the location 

where the report was created: 

 Color 

 Active alarm 

 Locked values 

 Current value of selected points 

 Combined schedule 

See To create an Equipment Summary report (page 144). 
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This report... allows you to... 

Equipment Values Compare point information. See To create an Equipment Values report 

(page 145). 

Trend Samples View trend values for a particular time frame. See To create an Trend 

Samples report (page 147). 

  

NOTES 

 You can display icons and hover text on the Geographic  tree that show where custom reports 

have been created. See Tree icons and hover text (page 10). 

 You can schedule a report to run on a recurring basis. See Scheduling reports (page 142). 

  

 

 
 

To create an Equipment Summary report 

An Equipment Summary report can provide the following information for equipment at or below the 

location where the report is created. 

 Color 

 Active alarm 

 Locked values 

 Current value of selected points 

 Effective schedule 

  

To create an Equipment Summary report: 

1 On the Geographic  tree, select the location where you want to view the report. 

2 Click the Reports button drop-down arrow, then select Add Legacy Report. 

3 Select Equipment Summary. 

4 Optional:  Select a Category. 

NOTE  The Category field is visible only if you have defined report categories. See To organize 

custom reports (page 126). 

5 Type a name for the report. 

6 Click Create. 

7 Define the Title, Page Size and orientation, and the Maximum number of rows. 

8 Check or uncheck the Optional Sections checkboxes as needed. 

9 Optional:  Check Include only specific control programs at or below this location, then type the 

names of the control programs. 

10 Select Available Points that you want to include in the report. Use Ctrl+click, Shift+click, or both to 

select multiple items. 

11 Click Add. 

12 Click Accept. 

13 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button 

drop-down arrow, select the report, then click Run. 
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To create an Equipment Values report 

NOTE  To see if your system has this optional package, click , then select About. You have this 

package if Enabled Features shows Adv. Reporting. 

  

An Equipment Values report allows you to compare point information. 

To create an Equipment Values report: 

1 On the Geographic  tree, select the location where you want to view the report. 

2 Click the Reports button drop-down arrow, then select Add Legacy Report. 

3 Select Equipment Values. 

4 Optional:  Select a Category. 

NOTE  The Category drop-down list is only visible if you have defined report categories. See To 

organize custom reports (page 126). 

5 Type a name for the report. 

6 Click Create. 

7 Do one of the following: 

○ Select Include only specific control programs at or below this location, then type the control 

program names. 

○ On the selection tree, select the pieces of equipment you want to view in the report. (Use 

Ctrl+click, Shift+click, or both to select multiple items.) Then click Add. 

8 Optional: Check Highlight alternate rows to make the report easier to analyze. 

9 Click Next or  next to Columns. 

10 Verify or change the report Title, Page units of measure for defining column widths, and Outer 

border characteristics. 

11 Select a column in the report preview.  

NOTE The selected column is light blue. 

12 Under Column Header, define how you want the column header to look. 

13 Under Column Data, define the data you want in the column and how you want it to look. See table 

below. 

NOTE  Select General from the Format drop-down list unless you want to define the number of 

places to the right of the decimal point for the displayed value. 

14 Optional:  Use the Add, Delete, and arrow buttons below the report preview to manipulate the 

columns. 

15 Optional:  Click  next to Page to change the page size and orientation. 

NOTE  Changing the size and orientation of the printed page also changes the report layout on the 

View tab.  

16 Click Accept. 
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17 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button 

drop-down arrow, select the report, then click Run. 

  

Type of Column Data 

Point Displays point data in the column. 

  Display Select the property to show in this column. 

  Data is named 

differently in some 

control programs 

Select this checkbox if similar points have different names 

in different control programs. Then add each of the names 

to the Name to use list. 

For example, if a point is named Zone Temp in one control 

program and Zone Temperature in different control 

program, add both names to the list. 

  Point to use Select the name of the point to show in the column.  

Trend Sample Display Select First, Minimum, Maximum, or Last recorded trend 

value. 

  Data is named 

differently in some 

control programs 

Select this checkbox if similar points have different names 

in different control programs. Then add each of the names 

to the Name to use list. 

For example, if a point is named Zone Temp in one control 

program and Zone Temperature in different control 

program, add both names to the list. 

  Trend to use Select the name of the point to show in the column. 

  Set Click to have all columns in the report use the same time 

range. 

  Time Range Select the time range to run the report for. 

Trend 

Calculation 

Display Select the type of calculation to show in the column, 

Average or Total. 

  Data is named 

differently in some 

control programs 

Select this checkbox if similar points have different names 

in different control programs. Then add each of the names 

to the Name to use list. 

For example, if a point is named Zone Temp in one control 

program and Zone Temperature in different control 

program, add both names to the list. 

  Trend to use Select the name of the point to show in the column. 

  Set Click to have all columns in the report use the same time 

range. 

  Time Range Select the time range to run the report for. 

Control Program Display Select Color, Display Name, Display Path, Notes, Prime 

Variable, or Reference Name to show in the column. 
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Type of Column Data 

Expression Data is named 

differently in some 

control programs 

Select this checkbox if similar points have different names 

in different control programs. Then add each of the names 

to the Name to use list. 

For example, if a point is named Zone Temp in one control 

program and Zone Temperature in different control 

program, add both names to the list. 

  Expression Type the path relative to the current control program. The 

path must return a string value. See Defining WebCTRL® 

paths for more information on paths. 

To display the Notes on an equipment's Properties page, 

type .notations in this field. 

 

 

 
 

To create a Trend Samples report 

NOTE  To see if your system has this optional package, click , then select About. You have this 

package if Enabled Features shows Adv. Reporting. 

  

A Trend Samples report provides trend values for a particular time frame. 

To create a Trend Samples report: 

1 On the Geographic  tree, select the location where you want to view the report. 

2 Select the Reports button drop-down arrow, then select Add Legacy Report. 

3 Select Trend Samples. 

4 Optional:  Select a Category. 

NOTE  The Category drop-down list is only visible if you have defined report categories. See To 

organize custom reports (page 126). 

5 Type a name for the report. 

6 Click Create. 

7 Select a Time Range from the drop-down list, then refine that option by selecting an option from 

the drop-down list(s) to the right. 

8 Define the trend data. 

NOTES   

○ Calculate values for missing samples calculates a value based on the 2 closest values to the 

time interval. 

○ Find the closest sample displays the value closest to the time interval selected.  

9 Optional:  Check Highlight alternate rows to make the report easier to analyze. 

10 Click Next or  next to Columns. 

11 Verify or change the report Title, Page units of measure for defining column widths, and Outer 

border characteristics. 

12 Select a column in the report preview.  

NOTE  The selected column is light purple. 

13 Under Column Header, define how you want the column header to look. 
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14 Under Column Data, select the source of the trend data and how you want the data to look. 

NOTE  Select General from the Format drop-down list unless you want to define the number of 

places to the right of the decimal point for the displayed value. 

15 Optional:  Use the Add, Delete, and arrow buttons below the report preview to manipulate the 

columns. 

16 Optional:  Click  next to Page to change the page size and orientation. 

NOTE  Changing the size and orientation of the printed page also changes the report layout on the 

View tab.  

17 Click Accept. 

18 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button 

drop-down arrow, select the report, then click Run. 

 

 
 

To save a v6.5 or earlier custom report's design for use in another location or system 

You can save the design of an Equipment Values report or a Trend Samples report for reuse in another 

location or in another system. Or, you can create a library of different report designs to pull from as 

needed. 

To save a report's design 

1 Create the Equipment Values (page 145) or Trend Samples (page 147) report. 

2 On the Reports > Design tab, click the Save Report Design button. The design is saved to 

WebCTRLx.x/webroot/<system>/Reports/<report name>.reportdesign. 

NOTE  The .reportdesign file includes the report name. If you save multiple report designs in your 

system, each of those reports must have a unique name. 

To use the report design at a different location in the system 

1 Select the location in the Geographic  tree. 

2 Select Reports > Add Legacy Report. 

3 In step 1, select Report design, then select the report name in the drop-down list. 

4 In step 2, type a report Name. 

5 In step 3, click Create. 

To copy individual report design file(s) to another system  

1 In Windows Explorer, go to the WebCTRLx.x/webroot/<system>/Reports/ folder. 

2 Copy the *.reportdesign files that you want. 

3 In the new system, paste the copied files in the WebCTRLx.x/webroot/<system>/Reports/ folder. 

4 Follow the steps above in "To use the report design at a different location in the system". 

 

 

 

 

 

 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

149 

 

To create a .zip file to import into another system 

NOTE  The import process will not import a file if it has the same name as a file in the other system. 

Make sure your file names are unique. 

1 Do one of the following: 

○ Create a .zip file that contains the *.reportdesign files that you want. These files may be in the 

WebCTRLx.x/webroot/<system>/Reports/ folder, or in a library that you created. 

○ On the System Settings > General tab, under Source Files, click Export. 

NOTE  Export creates a .zip file that contains all of the system's source files (control programs, 

drivers, view files, touchscreen or BACview files, report design files). 

2 In the new system, go to the System Settings > General tab. 

3 Under Source Files, click Import. 

4 Browse to the .zip file. 

5 Click Continue. 

6 Click Close. The WebCTRL® application will put the imported files in the correct folder. 

 

 
 

To edit or delete a v6.5 or earlier custom report 

1 Select the item on the Geographic  tree where the report was created.  

2 Click the Reports button drop-down arrow, then select the report you want to edit or delete. 

3 Do one of the following on the Design tab: 

○ Edit the report, then click Accept. 

○ Click the Delete Report button, then click OK.  

 

 

 
 

Operator access 

Privileges control which parts of the WebCTRL® system an operator can access. Privileges also control 

what an operator can do and what he can change. 

To set up operator access to your system: 

1 Log in to the WebCTRL® application as the administrator operator. See Operators and operator 

groups (page 153). 

2 Define privilege sets by job function. See Privilege sets (page 150). 

3 Enter each operator in the system by assigning him privilege sets and entering settings that apply 

only to him. If you need to assign the same privilege set to multiple operators, you can create an 

operator group and assign the privilege set to the group. See Operators and operator groups (page 

153). 

An operator can change many of his operator settings on the My Settings page (page 156). 

To access the WebCTRL® interface, an operator must enter his user name and password. You can 

change the rules for passwords in the advanced password policy (page 157). 
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Restricting operator access 

To restrict access to your system, you can: 

 Restrict an operator's privileges 

 Use location-dependent operator access (page 158) (available with the optional Advanced Security 

package) 

 Change a microblock's Editing Privilege from Preset to a specific privilege. The microblock's 

properties will be editable only by an operator that has that privilege. 

 CAUTION  Each microblock property has a default Editing Privilege (represented by the Preset 

option) that is appropriate for that property. Changing Preset to a specific privilege changes every 

property in the microblock to the same privilege which may produce undesirable results. 

 

 
 

Privilege sets 

A privilege set is a group of one or more privileges (page 150). The Administrator creates privilege sets 

and assigns them to operators and operator groups.  

 

 
 

Privileges 

 

This privilege... allows an operator to... 

System Administration Privilege  Add, edit, and delete operators, operator groups, and privilege 

sets. 

 Update the WebCTRL® system with service packs and 

patches. 

 Register the WebCTRL® software. See To register your 

WebCTRL® software (page 191). 

 Enable and set up advanced security features such as 

location-dependent operator access (page 158).  

 Add and remove WebCTRL® add-ons such as EnergyReports. 

 

This Access privilege... allows an operator to access (but not edit)... 

Access Geographic Locations pages from the Geographic  tree. 

Access Network Items pages from the Network  tree. 

Access Groups pages from the Schedule Groups  tree. 

Access Config Items pages from the System Configuration  tree. 

Access Alarms alarms. 

Access Logic Pages Logic pages. 

Access User Category 1-5 anything in a category that has the same privilege assigned to it. 

See "To create a custom privilege" below. 
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This Parameter privilege... allows an operator to edit properties such as... 

Edit Setpoint Parameters occupied and unoccupied heating and cooling setpoints. 

Edit Setpoint Tuning Parameters demand level setpoint offsets, thermographic color band offsets, 

heating and cooling capacities and design temperatures, color 

hysteresis, and learning adaptive optimal start capacity 

adjustment values. 

Edit Tuning and Logic 

Parameters 

gains, limits, trip points, hysteresis, color bandwidths, design 

temperatures, and optimal start/stop. 

Edit Manual Override Parameters locks on input, output, and network points. 

Edit Point Setup Parameters point number, type, range, and network source and destination. 

Edit Restricted Parameters properties the installer restricted with this privilege. 

Edit Category Assignments Alarm, Graphic, Trend, and Report category assignments. 

Edit History Value Reset elapsed active time and history resets, and runtime hours. 

Edit Trend Parameters enable trend logging, log intervals, and log start/stop times. 

Edit Calibration Parameters point calibration offsets. 

Edit Hardware Controller 

Parameters 

driver properties. 

Edit Critical Configuration critical properties the installer protected with this privilege. 

Edit Area Name area display names. 

Edit Control Program Name control program display names. 

Edit Alarm Configuration enabling/disabling alarms and editing alarm messages, actions, 

categories, and templates. 

InterOp Privilege 1 - 10 those protected by password levels 1-10 in SuperVision. 

 

This Functional privilege... allows an operator to... 

Manage Alarm Messages 

and Actions 

add, edit, and delete alarm messages and actions. 

Maintain System Parameters edit all properties on the System Settings page. 

Maintain Schedules add, edit, delete, and download schedules. 

Maintain Schedule Group 

Members 

add, edit, and delete schedule groups. 

Maintain Categories add, edit, and delete categories. 

Maintain Alarm Templates edit Alarm Template and Reporting Action Templates. 

Acknowledge Non-Critical Alarms acknowledge all non-critical alarms. 

Acknowledge Critical Alarms acknowledge all critical alarms. 

Force Normal Non-Critical Alarms force non-critical alarms to return to normal. 
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This Functional privilege... allows an operator to... 

Force Normal Critical Alarms force critical alarms to return to normal. 

Delete Non-Critical Alarms delete non-critical alarms. 

Delete Critical Alarms delete critical alarms. 

Execute Audit Log Report run the Location Audit Log and System Audit Log reports. 

Download Controllers mark equipment for download and initiate a download. 

System Shutdown issue the Shutdown manual command that shuts down the 

WebCTRL® Server application. 

Engineer System  log in and make database changes in SiteBuilder. 

 use the copy, notify, reload, and revert manual commands. 

 access the Configure and Set up Tree right-click menus in the 

WebCTRL® interface. 

 Add text in the Notes field on an equipment's Properties page. 

Access Commissioning Tools access: 

 Equipment Checkout 

 Airflow Configuration 

 Trend, Report, and Graphic categories that require this 

privilege 

 Discovery tool 

Maintain Graphs and Reports add, edit, and delete trend graphs and reports. Also required for 

Time-lapse. 

Maintain Connections edit Connections page properties. 

Remote File Management access files using a WebDAV utility. 

Remote Data Access-SOAP retrieve WebCTRL® data through an Enterprise Data Exchange 

(SOAP) application. 

Do not audit changes made 

using SOAP (Web services) 

not have his SOAP (web services) changes recorded in the Audit 

Log. 

Manual Commands/Console  

Operations 

access the manual command dialog box and issue basic manual 

commands. 

Manual Commands/File IO execute manual commands that access the server's file system. 

Manual Commands/Adv Network execute manual commands that directly access network 

communications. 

Manual Commands/Unrestricted execute manual commands that bypass all safeguards and may 

cause unpredictable results if used incorrectly. 

Change My Settings edit his preferences on the My Settings page. 

 

 

To create a custom privilege 

You can assign a privilege to a Graphic, Property, Trend, or Report category so that only operators with 

that privilege can access the category. You assign a category privilege on the page where you create or 

edit categories. 
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If all the other privileges are too widely used to accomplish the results you want, you can assign one of 

the five Access User Category privileges to the operator(s) and category. 

For example, your system has 2 graphics categories, HVAC and Lighting/Security. You want HVAC 

technicians to see only the HVAC graphics and security personnel to see only the Lighting/Security 

graphics. To do this: 

  

Assign... To... Results 

Access User 

Category 1 

HVAC graphics category 

and 

HVAC technicians only 

The security personnel cannot see the HVAC 

graphics because they do not have Access User 

Category 1. 

Access User 

Category 2 

Lighting/Security Graphics 

category 

and 

Security personnel only 

The HVAC technicians cannot see the 

Lighting/Security graphics because they do not 

have Access User Category 2. 

 

 
 

To add or edit a privilege set 

1 On the System Configuration  tree, select Privilege Sets. 

2 Click Add to create a new privilege set, or select a privilege set to edit. 

3 Type the Name and Reference Name for the privilege set. 

4 Check each privilege (page 150) that you want to include in the privilege set. 

5 Click Accept. 

 CAUTION  Include all required access privileges in a privilege set. For example, if you add 

Acknowledge Non-Critical Alarms to a privilege set, also add Access Alarms to that privilege set. 

 TIP (Location-independent security only)  To create a privilege set that is similar to an existing set, 

select the existing set, then click Add. The privileges that are initially selected are identical to those of 

the existing set.  

 

 
 

To delete a privilege set 

1 On the System Configuration  tree, select Privilege Sets. 

2 Select the privilege set to be deleted. 

3 Click Delete. 

4 Click OK. 

5 Click Accept. 

 

 
 

Operators and operator groups 

When you create a new system in SiteBuilder, you assign a login name and password to the 

administrator operator. This administrator operator sets up each operator in the WebCTRL® interface 

by entering the necessary settings and assigning one or more privilege sets (page 150) to the operator. 

Operator groups give you the ability to assign privilege sets to a group of operators instead of the 
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individual operators. Operator groups are useful if you have multiple operators who need the same 

privilege set or you have positions with high turnover rates. You can assign an operator to a group when 

you enter the operator or when you create the operator group. 

NOTE  When using hierarchical servers, you must create identical operators on each server in order to 

navigate across servers. 

  

 

 CAUTION  Passwords can be forgotten. To ensure access to the WebCTRL® administrative 

functions, assign the Admin privilege set to at least 2 operators.  

 

 
 

To add or edit an operator 

1 On the System Configuration  tree, select Operators. 

2 Click Add to enter a new operator, or select an operator to edit his settings. 

3 Enter information on this page as needed. See table below. 

4 Click Accept. 

 

Field Notes 

Login Name The name the operator must type to log in to the system. This name must be 

unique within the system. 

Change password Enable this field, then type the current and new passwords.  

NOTE  An operator can change his password on the My Settings page (page 

156). 

Force User to 

Change Password at 

login? 

Forces the operator to change his password immediately after his next login. 

NOTE  Use this field with the Change Password field to create a temporary 

password that the operator must change after his next login. 

Exempt From 

Password Policy 

If Use advanced password policy is enabled on the System Settings > 

Security tab (page 184), select this option if you do not want the policy to 

apply to this operator. 

Logoff options If Log off operators after __ of inactivity is enabled on the System Settings > 

Security tab (page 184), select one of the 3 logoff options. 

Personal Information You can enter contact information for this operator. 

NOTE  An operator can enter contact information on the My Settings page 

(page 156). 

Starting Location 

and 

Starting Page 

The WebCTRL® location and page that will be displayed after the operator 

logs in. 
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Field Notes 

System-wide 

Privilege Sets 

Select the privilege set(s) that you want to assign to the operator. The 

Effective System-wide Privileges list show which privileges the operator will 

have. 

NOTES   

 Click Show current privileges only to see only the selected privilege sets 

and privileges. 

 A grayed out privilege set with a group name beside it indicates the 

operator is inheriting that privilege set from the group.  

   

 TIP  To test the settings and privileges that you gave to an operator, you can open a second browser 

session on your computer and log in as the operator. For instructions on opening a second session in 

the browser you are using, see Setting up and using a web browser to view the WebCTRL® interface 

(page 176). 

 

 
 

To delete an operator 

1 On the System Configuration  tree, select Operators. 

2 Select the operator. 

3 Click Delete. 

4 Click Accept. 

 

 
 

To add or edit an operator group 

1 On the System Configuration  tree, select Operator Groups. 

2 Click Add to create a new operator group, or select an operator group to edit it. 

3 Type the Display Name and Reference Name for the operator group. 

4 Under Members, select the operators and/or groups that you want to add to the new group.  

5 Under Privilege Sets, select the privilege sets (page 150) that you want to assign to the new group.  

NOTE  To see what privileges are included in a privilege set, go to the Privilege Sets page and then 

select the privilege set in the table. 

6 Click Accept. 

 TIP  Every operator is automatically a member of a permanent default group called Everybody. You 

can assign privilege sets to this group. 

 

 
 

To delete an operator group 

1 On the System Configuration  tree, select Operator Groups. 

2 Select the operator group. 

3 Click Delete. 
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4 Click Accept. 

 CAUTION  When you delete an operator group, its individual members lose the privilege sets that 

were assigned to the group. 

 

 
 

To change My Settings 

On the My Settings page, you can change settings, such as your: 

 Password 

 Viewing preferences 

 Contact information 

 

NOTE  The System Administrator can also change these settings on the Operators page. 

 

To change your settings: 

1 On the System Configuration  tree, select My Settings. 

2 Make changes on the Settings or Contact Info tab. See table below. 

3 Click Accept. 

 

Field Notes 

Change password Enable this field, then type your current and new passwords. 

Starting Location and 

Starting Page 

The WebCTRL® location and page that will be displayed after you log in. 

Language The language and formatting conventions you want to see in the 

WebCTRL® interface. 

NOTES   

 If you will be using a language other than English, see Setting up 

your system for non-English languages (page 206) for additional 

requirements. 

 If support for your selected language is removed in SiteBuilder, the 

WebCTRL® application will automatically assign the System 

language to you. 

Automatically collapse 

trees 

Expands only one tree branch at a time. 

Automatically download 

schedules on each 

change 

Select to automatically download all new schedules that you create and 

schedules that you change. 
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Play sound at browser 

when server receives 

Check Non-critical alarms or Critical alarms if you want the system to 

audibly notify you when that type of alarm is received.  

You can specify a different sound file.   

• Internet Explorer®, Firefox®, and Safari® support .wav, .mp3, or .au 

files. 

• GoogleTM ChromeTM supports .wav or .mp3 files. 

1 Put your file in the webroot\_common\lvl5\sounds folder.  

2 In the Sound File field, replace normal_alarm.wav or 

critical_alarm.wav with the name of your sound file.  

NOTE  You can put your sound file anywhere under the WebCTRLx.x 

folder, but you must change the path in the Sound File field. 

 

 
 

Advanced password policy 

This feature lets you define the requirements for operator passwords.  

1 On the System Configuration  tree, select System Settings. 

2 On the Security tab under Operators, enter information in the fields described below.   

NOTE  See System Settings (page 181) for information on all the other fields. 

 

Field Notes 

Use advanced password policy Enable this field to define rules for passwords. 

An operator’s login name and password must be different when 

this policy is enabled. 

After you change the password policy, any operator whose 

password doesn't meet the new requirements will not be locked 

out of the system, but will be prompted to create a new password. 

Passwords must contain You can specify how many characters and which of the following 

types of characters a password must contain: 

 Numbers 

 Special characters—any keyboard character that is not a 

number or letter. 

 Letters—uppercase, lowercase, or both. 

Cannot be changed more than 

once every __ days. 

Enter a number to limit how often users can change their 

passwords. When set to 0, users can change them as often as 

they want. 

May not be reused until __ 

different passwords are used. 

Enter a number between 1 and 20. Enter 0 to reuse passwords 

without a delay. 

Expire after __ days Enable to set the number of days an operator can use his 

password before the system requires him to change it. Enter a 

number between 1 and 999. 

Force expiration Click this button to force every user's password to expire. Each 

user will be prompted to change their password when they next 

attempt to log in to the WebCTRL® interface. 
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NOTE  The Advanced password policy settings do not synchronize across hierarchical servers. You 

should set up each system with the same advanced password settings to avoid problems when 

navigating between the systems. 

  

 
 

Advanced security 

Location-dependent operator access 

 

 With the Advanced Security package, you can set up operator access to your system to be 

location-dependent. This type of operator access lets you assign privileges to an operator only at 

locations in the system where he needs them. For example, you could assign an operator mechanic 

privileges in one building in a system, view-only privileges in another building, and no privileges in a 

third building. 

New and converted WebCTRL® systems default to location-independent operator access in which an 

operator’s privileges apply throughout the system. You should understand this type of operator access 

before switching to location-dependent. See Operator access (page 149) for more information on 

location-independent operator access. 

NOTE  When using hierarchical servers, the security policy and privilege sets are local to each server, so 

you can have location independent security on one server but not on another. 

 
 

To switch to location-dependent access 

 CAUTIONS   

 Create a backup of your system before you begin. Switching to location-dependent operator access 

changes the configuration of operators and privilege sets. If you need to revert to 

location-independent operator access, your previous configuration cannot be automatically 

restored. 

 If you change the policy after you create and assign privilege sets to operators, you may need to 

reconfigure your operators’ privileges. 

  

To switch to location-dependent operator access: 

1 On the System Configuration  tree, select System Settings. 

2 On the Security tab under Security Policy, click Change Policy. 

3 Follow the on-screen instructions. 
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Privileges and privilege sets 

When using location-dependent operator access, privileges are either system-wide or local. 

System-wide privileges allow an operator to perform functions throughout the entire system, such as 

accessing the Configuration tree or performing a system shutdown. 

Local privileges allow an operator to perform functions in a specific area of the system, such as editing 

setpoints or viewing alarms. Assigning any local privilege to an operator also allows him to change his 

password and set preferences on his My Settings (page 156) page. 

You assign system-wide privileges to system-wide privilege sets and local privileges to local privilege 

sets. Use the following table in planning which privileges to assign to a privilege set. For a description of 

each privilege, see Privileges (page 150). 

  

System-wide privileges Local privileges 

Access Groups 

Access Config Items 

Maintain System Parameters 

Maintain Schedule Group Members     

Maintain Categories 

Maintain Trends Display and Print Setup 

Maintain Alarm Templates 

Acknowledge Non-Critical Alarms 

Acknowledge Critical Alarms 

Force Normal Non-Critical Alarms 

Force Normal Critical Alarms 

Delete Non-Critical Alarms 

Delete Critical Alarms 

Execute Audit Log Report 

Download Controllers 

System Shutdown 

Engineer System 

Access Commissioning Tools 

Maintain Graphs and Reports 

Maintain Connections 

Remote File Management 

Remote Data Access-SOAP 

Do not audit changes made using SOAP (Web services) 

Manual Commands/Console Operations 

Manual Commands/File IO 

Manual Commands/Adv Network 

Manual Commands/Unrestricted 

Change My Settings 

Access Geographic Locations 

Access Network Items 

Access Alarms 

Access Logic Pages 

Access User Category 1 - 5 

Edit Setpoint Parameters 

Edit Setpoint Tuning Parameters 

Edit Tuning and Logic Parameters     

Edit Manual Override Parameters 

Edit Point Setup Parameters 

Edit Restricted Parameters 

Edit Category Assignments 

Edit History Value Reset 

Edit Trend Parameters 

Edit Calibration Parameters 

Edit Hardware Controller Parameters 

Edit Critical Configuration 

Edit Area Name 

Edit Control Program Name 

Edit Alarm Configuration 

InterOp Privilege 1 - 10 

Manage Alarm Messages and Actions 

Maintain Schedules 

  

NOTES 

 For an operator to add, edit, or delete schedule groups, he must have the system-wide privilege 

Maintain Schedule Group Members. He must also have the local privileges Access Geographic 

Locations and Maintain Schedules at each location that is a member of the schedule group. 

 If you switch to location-dependent operator access in a system that has operators and privileges 

set up, the WebCTRL® application splits any existing privilege set containing local and system-wide 

privileges into 2 separate privilege sets - one local and one system-wide. Operators’ system-wide 

privilege sets still apply throughout the system. The operators’ local privilege sets are automatically 

assigned at the system level. You can then reassign the local privilege sets to the operators at the 

locations where they need them.   
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To add a privilege set 

Adding a privilege set using location-dependent operator access is the same as using 

location-independent operator access except that you must select whether you are adding a 

system-wide or local privilege set. See Privilege sets (page 150).  

 

 
 

To assign privilege sets to an operator 

Assign a system-wide privilege set to an operator on the Operators page in the same way you would 

assign privilege sets in a system using location-independent operator access. See Operators and 

Operator Groups (page 153). 

Assign a local privilege set to an operator at locations on the Geographic  or Network  tree 

where he needs the privileges. 

1 Select a location on the Geographic  or Network  tree. 

2 Click Privileges. 

3 On the Configure tab, click Add. 

4 Select the operator or operator group. 

5 Click OK. 

6 Select the privilege set(s) that you want the operator to have. 

7 Click Accept. 

  

NOTE  You can display icons and hover text on the Geographic  tree that show where privileges 

have been assigned. See Tree icons and hover text (page 10). 

 

 
 

To delete a local privilege set assignment 

1 On the Geographic  or Network  tree, select the location where the assignment was made. 

2 Click Privileges. 

3 Select the assignment under Privilege Set Assignments at this Level.  

4 Click Delete. 

5 Click Accept. 

 

 

 

 

 

 

 

 

 
 

Restricting access in the system 

Restricting an operator’s access to areas of the system 
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You can give an operator access to only a specific area of the system. All other areas will be either 

grayed out or not visible when the operator logs in to the WebCTRL® interface. 

EXAMPLE  If you give an operator the Access Geographic Locations privilege only at the first floor of the 

system shown below, he will see a navigation tree like the one on the left. The areas above the first 

floor are visible because he needs them to navigate to the first floor, but grayed out because he cannot 

access them. The operator does not see Dallas, New York, or San Francisco because he can’t access 

them and does not need them to navigate. 

Restricted access 

 

Full system access 

 

  

Restricting all operator access to a location 

To remove all operators’ local privileges from a location so that you can assign access only to a specific 

operator(s), navigate to the location, select Privileges, then uncheck Inherit security privileges from 

above this level. 

 

 
 

Security Assignments Report 

A Security Assignments Report shows an operator’s local and system-wide privileges and privilege sets 

at a specific location. 

1 Select the location on the Geographic  or Network  tree. 

2 Click the Reports button drop-down arrow, then select Security > Security Assignments. 

3 On the Options tab, select an operator. 

4 Click Run. 

 

 

 

 

 

 

 
 

Recording reasons for edits (21 CFR Part 11) 
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The Advanced Security package provides support for 21 CFR Part 11. With this feature enabled, the 

WebCTRL® application can require an operator to record a reason for changing an equipment property, 

or acknowledging an alarm, before it accepts the change. The WebCTRL® Audit Log report then 

displays the operator's name and the recorded reason for making the change.  

   

To set up equipment to require reasons for changes 

1 On the WebCTRL® Geographic  or Network  tree, right-click the equipment, then select 

Configure. 

2 Check Require operator to record any changes to control program and when acknowledging 

alarms. 

3 Click Accept. 

NOTE  You can also turn this setting on in SiteBuilder in the equipment's properties dialog box. 

  

To view reasons for changing equipment properties 

1 On the WebCTRL® tree, select a piece of equipment that requires reasons for change. 

2 Click the Reports button drop-down arrow, select Security > Location Audit Log or System Audit 

Log. 

3 On the Options tab under Display the following columns, check Reason. 

Click Run. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Cost-saving strategies 

HVAC equipment runs to maintain adequate zone temperatures. Some zones, like classrooms, must 

maintain a comfortable temperature only while people occupy them. When a zone is no longer 

occupied, you can define different setpoints that require less energy to maintain. Use WebCTRL® 
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Schedules for these occupied/unoccupied zones so that equipment runs only as needed to reduce 

energy consumption, but not comfort. 

Other zones, like computer server rooms and production floors, must maintain particular cooling and 

heating setpoints 24 hours a day, 7 days a week. Schedules would have no cost-saving effect on them. 

Use one of the other cost-saving strategies to reduce energy consumption and equipment repairs for 

these kinds of zones.  

You can realize the greatest savings by using Schedules. Then fine tune Optimal Start, Demand Control, 

and Setpoint Optimization. Each strategy depends on a particular microblock. 

  

Microblock Strategy Description 

 

Schedules (page 43) Define when a building or zone is occupied and 

whether or not equipment should run, depending on 

the occupied setpoints. 

 

Optimal Start (page 38) Ensures that a zone’s ideal comfort range is reached 

just as the zone becomes occupied. 

 

Demand Control (page 

40) 

Relaxes heating or cooling setpoints when a certain 

level of energy use is reached in order to avoid peak 

demand, ratchet, or time of use electric charges. 

 

Setpoint  

Optimization 

(Trim and Respond) 

Calculates a piece of equipment’s setpoint based on 

the number of heating or cooling requests it receives 

from other equipment. 
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Advanced topics 

 

 
 

Manual commands 

To run a manual command:  

1 Click , then select Manual Command. 

2 Type the manual command in the dialog box, then click OK. 

 TIP   Ctrl+Shift+M also opens the dialog box. 

  

You must have the Manual Commands/Console Operations privilege to access the manual commands 

dialog box. The descriptions below tell you if you need an additional privilege to run the corresponding 

command. 

  

Command Description 

addon Opens a dialog box where you can upload, start, stop, or remove an 

add-on program such as Trend Export. 

arcnet Run this command each time you plug a device, such as a laptop, 

into a controller using an ARCNET card. The arcnet command 

configures the WebCTRL® application to recognize your device as 

the WebCTRL® server. Run this command from the equipment, 

controller, or network level on the Network  tree. 

autopilot location In Internet Explorer® only–Displays the full path for the current 

location. You can copy and paste the path into the autopilot.xml file 

that runs the WebCTRL® autopilot. See Running the WebCTRL® 

autopilot (page 170). 

bacnet bind show Shows the selected device's current BACnet bindings. 

bacnet bind clear Clears the selected device's BACnet bindings so that they can be 

rediscovered. 

bacnet showindex Displays all files (file name, size, date) downloaded to the selected 

controller. 

bbmd commands: You must have the Manual Commands/Adv Network privilege to run 

bbmd commands. 

   bbmd read <IP address> Reads the BBMD table of the controller at the given IP address. 

For example, to display the BBMD table in the BACnet device router 

at IP address 154.16.12.101, type:  

       bbmd read 154.16.12.101 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

165 

 

Command Description 

   bbmd update <network  

        number> 

Selects BBMDs on the specified network and marks them for 

download. If no network is entered at the end of the command, all 

networks in the system are scanned.  

For example, if the network number is 888, type: 

       bbmd update 888 

   bbmd view <network  

       number> 

Views the list of BBMDs that have been selected for the network 

number at the end of the command. Assumes the update has been 

run. 

For example: 

       bbmd view 888 

   bbmd write <table file> <IP  

        address>  

Writes the BBMD table into the controller at the given IP address. 

See To set up BBMDs through the WebCTRL® interface. 

For example, to write the BBMD table in dallasbbmd.bdt into the 

BACnet device router at IP address 154.16.12.101, type: 

       bbmd write dallasbbmd.bdt 154.16.12.101 

   bbmd clear <IP address> Clears the BBMD for the specified controller. 

For example: 

       bbmd clear 154.16.12.101 

   bbmd dump <network>  

       <file> 

Writes to a file the BBMD from the specified controller. 

For example: 

       bbmd dump 888 dallasbbmd.bdt 

checkurls 1 Finds all network point exp: expressions for the selected item on 

the Geographic  or Network  tree. 

2 Converts the exp: expressions to bacnet:// equivalent 

expressions that the controllers use. 

3 Compares the equivalent bacnet:// expressions to the bacnet:// 

expressions currently downloaded in the controllers. 

4 Displays any mismatches. 

checkurls -p Does the same as checkurls, then adds any mismatches to the 

download queue as parameter downloads. 

checkurls -v Does the same as checkurls, but displays the exp: and bacnet:// 

expressions for all network points that were checked. 

commstat Gives a complete set of diagnostic information for all defined 

connections as well as information regarding all modems in the 

system. 

copy Displays a global copy utility that allows you to selectively copy trend 

graphs, custom reports and all editable properties from the selected 

equipment to other equipment in the system with the same control 

program. See To use Global Copy (page 29). 

download commands: Each of these commands performs an immediate download to a 

controller for the selected control program, device, or driver. 

   download m Downloads all content, including parameters, schedules, and 

BBMDs (if applicable). 

   download p Downloads parameters only. 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

166 

 

Command Description 

   download s Downloads schedules only. 

go commands:  

   go <refname or path> Goes to the point in the system that is referenced.  

For example: 

       go #oa_conditions 

or 

       go vav_1/m28 

See Defining WebCTRL paths. 

   go ~net Takes you from a piece of equipment on the Geographic  tree to 

the same equipment on the Network  tree. 

   go ~geo Takes you from a piece of equipment on the Network  tree to 

the same equipment on the Geographic  tree. 

   go ~device Takes you to the controller for a point or piece of equipment on the 

Network  tree. 

   go ~network Takes you to the network the selected object’s controller is 

associated to. 

   go -logicpopup <refname> Goes to the microblock pop-up for the microblock that is referenced. 

You must run this command from the microblock’s equipment in the 

navigation tree. 

For example: 

      go -logicpopup lstat 

   go <device ID> Goes to a device on the Network  tree. 

For example, to go to device 301205 referenced in a dead module 

alarm, type: 

      go 301205 

   go <device ID>/<object  

        ID> 
Goes to a device and object on the Geographic  or Network  

tree. 

For example: 

      go 300550/AI:3 

   go <object ID> Goes to an object for the current device on the Geographic  or 

Network  tree. 

For example, if a module alarm reports a control program Locked 

I/O Alarm and references an error in program 11, click the link to go 

to the device, then go to the object by typing: 

      go PRG:11 

   go <s.g.m.p> (site, gateway, controller, program) Goes to the item that the s.g.m.p 

address references. Use this command for legacy equipment only. 

For example: 

      go 2,1,4,1 
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Command Description 

localhost Shows the IP address of the WebCTRL® server 

logoffuser Logs off a user (without warning the user). 

Type a whoson manual command to view the IDs of logged in 

operators, then type logoffuser x, where x is the user's ID. 

markdownload commands: These commands place the controller for the selected tree item on 

the list to download at a later time. The download list can be viewed 

at Network  tree > Downloads. 

   markdownload Marks for an All Content download, that includes parameters, 

schedules, and BBMDs (if applicable). 

   markdownload p Marks for a Parameters download. 

   markdownload s Marks for a Schedules download. 

memory Shows the amount of server memory allocated for the WebCTRL® 

application and the amount being used.  

memory -free Releases unused server memory, then shows the WebCTRL® 

memory usage before and after the release.  

modstat commands: These commands display a Modstat report. 

NOTE  It is not necessary to download a controller before running a 

Modstat on it. Binding takes place when you run the modstat. 

   modstat Displays status of the controller at the current location, including: 

 Hardware components of the device 

 Software components of the device 

 Error conditions that may exist in the device 

 Date and time the device is using 

   modstat 8:<device instance  

        number> 

Displays status for a specific controller in the IP network using the 

controller’s ID. Your location in the system does not have to be the 

controller you are querying. 

For example: 

       modstat 8:489202 

   modstat mac:<network  

   number>,<media type>: 

   <mac address> 

Displays a Modstat for a specific controller in the system using the 

controller’s MAC address. Network number is the number of the 

network this controller is on as specified in SiteBuilder; media type 

is the type of network the controller is on; MAC address can be 

either the controller address or the IP address and depends on the 

controller’s media type.  

For example: 

       modstat mac:48161,ms/tp:2 

                   or 

       modstat mac:888,bacnet/ip: 172.16.101.119 
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Command Description 

notify Sends a message to all operators currently logged in to the system. 

For example, "The server is going to shut down in 5 minutes. Please 

log off." To run this command, type:   notify <your message>. 

The message must use only alphanumeric characters. You must 

have the Admin privilege set or the Engineer System privilege to run 

this command. 

paramupload Uploads parameters (editable properties) to the WebCTRL® 

application from the equipment or driver at the current location and 

below. If you want to upload editable properties for all equipment on 

a floor, navigate to the floor level on the Geographic  tree. If you 

want to do this for everything under a particular router, navigate to 

the router or the network on the Network  tree. You must have 

the Manual Commands/Adv Network privilege to run this command. 

ping Ping to verify communication between to IP devices. You cannot 

ping devices on non-IP networks. To run this command type: ping 

<hostname> where <hostname> is the IP address or device name. 

For example: 

       ping 192.168.168.1 

(will ping the IP address 4 times)       

rebootserver Restarts the WebCTRL® Server application. You must log back in to 

the WebCTRL® interface if you want to continue. You must have the 

System Shutdown privilege to run this command. 

rebuild Rebuilds a Properties page. If you make changes to control program 

property text in the EIKON® application, navigate to a control 

program in the WebCTRL® tree, and then run this command to see 

your changes. 

reload Reloads a control program. Use if you make changes to control 

program in the EIKON® application. Reloading updates all instances 

of the control program throughout the system and marks the 

controller(s) for download. The WebCTRL® application determines 

the type of download based on what changed in the control 

program. You must have the Engineer System privilege to run this 

command. 

restartmodule Restarts the current controller. You must have the Manual 

Commands/Adv Network privilege to run this command. 

rnet here Overrides the address configuration of the Rnet host controller to 

allow a subsequent All Content or Parameters download. Run this 

command if you experience communication problems with the 

controller because the controller’s network number does not agree 

with SiteBuilder’s network number. Run this command from a 

control program, device or driver. 

revert Resets the selected driver or control program to its default values. 

setdefault Sets the current page as the default view for the selected action 

button and the selected tree location. You must have the Engineer 

System privilege to run this command. 
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Command Description 

setgcm Initializes any LANgate (gateway) from a converted SuperVision® 

system. 

After downloading to the LANgate, run setgcm if you: 

 Added a controller to a CMnet where the address is set higher 

than any other address on the CMnet  

 Changed the 3-letter system name 

 Changed the Generate controller alarm after no communication 

for ___ minutes (dead module timeout value) on the System 

Settings page  

 Changed the site number in SiteBuilder (previously referred to 

as the line number) 

setgcm sends the following information from the WebCTRL® 

database to the LANgate: 

 Maxnet (the highest addressed controller plus one) 

 3-letter system name 

 Site number 

 Dead module timeout value 

NOTES 

 You can send this command over network, direct or modem 

connections, but not over a direct network (access port). 

 In Supervision®, the command set the workstation phone 

number in the LANgate. You must now type the LANgate’s phone 

numbers on the LANgate’s parameter pages. 

 You must have the Manual Commands/Adv Network privilege to 

run this command.  

showhistory Gives historical information on the system, such as when it was 

created and updated. You must have the Manual 

Commands/Unrestricted privilege to run this command. 

shutdown Shuts down the WebCTRL Server application. This stops 

communication between the server and the client, but does not 

close any open WebCTRL® pages. You must have the System 

Shutdown privilege to run this command. 

storetrends Uploads trend data from the controller(s) to the database for all 

equipment at and below the selected item on the Geographic  

tree. This command stores trend data for points that have Trend 

Historian enabled. 

timesync Synchronizes the time on all controllers at the current location and 

below to the time on the server. Run this command only from a 

location on the Network  tree. 

NOTE  For CMnet networks, executing a timesync on a controller 

sends the timesync to its gateway, and all the controllers under that 

gateway. 

You must have the Manual Commands/Adv Network privilege to run 

this command. 
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Command Description 

updatedriver commands: You must have the Engineer System privilege to run updatedriver 

commands. 

   updatedriver Updates the selected controller to the latest version of its driver. 

   updatedriver net Updates the selected controller to the latest version of its driver and 

any other controllers on the same network that use that driver. 

   updatedriver all Updates the selected controller to the latest version of its driver and 

all other controllers in the system that use that driver. 

upgradejsp commands: Upgrading to a v6.0 or later system automatically upgrades any .jsp 

graphics created in WebCTRL® Extensions for FrontPage. If you edit 

one of the .jsp files after upgrade, you must run one of the following 

commands. These commands could take several minutes to 

complete. A message is displayed when finished. 

   upgradejsp <absolute path> Use to update a single graphic. For example: 

c:\webctrlx.x\webroot\<system>\graphics\lvl5\sitea\building1.jsp 

   upgradejsp <folder path> Use to update all graphics in a folder. For example: 

c:\webctrlx.x\webroot\<system>\graphics\lvl5\sitea 

   upgradejsp all Use to update all graphics in 

c:\webctrlx.x\webroot\<system>\graphics\lvl5 

whereami Displays the full path for the current location and gives the display 

and reference names of the action button, category, instance and 

tab. If the selected tree location differs from the location shown in 

the action pane (for example, a point trend page), whereami returns 

information on both locations. 

Use this command when you create links in ViewBuilder. 

whoson Shows the list of users currently logged in to the WebCTRL® system, 

the IP addresses from where they are logged on, what kind of 

interface they are using (for example, lvl5 for a web browser on a 

computer), and how long it has been since they have actively 

interfaced with the WebCTRL® system. 

zap Restarts the current controller. You must have the Manual 

Commands/Adv Network privilege to run this command. 
 

Running the WebCTRL® autopilot 

To monitor your WebCTRL® system, you can run the autopilot to display specified WebCTRL® pages at 

regular intervals. You can run the autopilot on the WebCTRL® server or on one or more client 

computers. Each computer can display a different set of pages. 

REQUIREMENT  You must have the Internet Explorer® web browser installed on any computer that will 

run the autopilot. Autopilot is not supported on other web browsers. 
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To set up the WebCTRL® autopilot 

1 Copy the WebCTRLx.x\autopilot folder from the WebCTRL® system to any location on the 

computer where you will be running the autopilot. 

2 In a text editor such as Windows® Notepad, open the autopilot.xml file in the new folder you 

created in step 1.   

 CAUTION  Do not open or edit the original autopilot.xml file in the WebCTRL® system. Keep 

this file to set up the autopilot on other computers. 

3 In the row that begins with <script, replace the highlighted text shown below with the information 

needed to start your system. 

  

 

  

NOTES   

○ The Attribute list near the top of the file describes each field. 

○ To prevent exposing someone's password in this file, create a generic user and password in 

the WebCTRL® interface. 

  

4 Each pair of rows beginning with <navigate and <delay define a page in WebCTRL® and how many 

seconds the page should display. Follow the steps below to replace each <navigate line with 

information specific to your system. Add or delete rows as needed.  

a) In the WebCTRL® interface, go to the page you want to display. 

b) Press Ctrl+M. 

c) Type autopilot location. 

d) Click OK.  

e) Copy the path to the Windows clipboard. 

f) In the autopilot.xml file, highlight a <navigate row, then press Ctrl+V to replace the highlighted 

text with the copied WebCTRL® path. 

NOTE  To have the autopilot run a report, define the path to the report's View tab.  

5 In the <delay row below each path, change 20 to the number of seconds you want to display the 

WebCTRL® page. 

6 Save the file. 

 

 
 

To run the WebCTRL® autopilot 

NOTE  If your computer is running Windows Vista®, see To run autopilot with Windows Vista (page 172) 

before starting the autopilot. 

  

1 Start the WebCTRL Server application. 

2 Run the autopilot.bat file that you created in step 1 of To set up the WebCTRL® autopilot (page 

171). 

  

NOTES   

 To stop the autopilot, do one of the following: 

○ Close the web browser. 
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○ Close the Command Prompt window that is running the autopilot.bat file to stop the autopilot 

but leave the WebCTRL® interface running in the web browser. 

 If the autopilot does not start, open autopilot.log to see the error. 

 

 
 

To run autopilot with Windows Vista 

To run the autopilot with the Windows Vista® operating system, you must add the WebCTRL® URL to 

your web browser's trusted sites. 

1 In Internet Explorer®, select Tools or  > Internet Options. 

2 On the Security tab, select the Trusted Sites icon, then click the Sites button. 

3 Under Add this Web site to the zone, type the url that autopilot uses to start your system. See step 

3  in To set up the WebCTRL® autopilot (page 171).  

4 Uncheck Require server verification (https:) for all sites in this zone. 

5 Click Add. 

6 Click OK to close both windows. 

7 Close Internet Explorer to have the changes take effect. 

 

 

 
 

System database maintenance 

You should perform the following system maintenance on a regular basis. See To safely shut down the 

WebCTRL® application for database server maintenance (page 174) before doing any maintenance on 

your database server. 

 

 

 

 

 

 

 
 

To back up a system 

The type of database your system uses determines the method you use to back up the system. In 

WebCTRL®, you can find the database type on the System Settings (page 181) > General tab. 

 CAUTION  Do Not use SiteBuilder's Replicate feature to back up your database. 

  

For Apache Derby or SQL Server Express 

1 Shut down the SiteBuilder and WebCTRL Server applications. 

2 In the WebCTRLx.x\webroot folder, copy your system folder. 

3 Paste the copy to a new location. 

 TIP  Zip the copy before transporting it over a network or to a CD.  
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For MySQL, MS SQL Server, Oracle, or PostGreSQL 

1 Follow the instructions above to copy your system folder in WebCTRLx.x\webroot. 

2 Use the database management system's backup method. See To safely shut down the WebCTRL® 

application for database server maintenance (page 174) before doing any maintenance on your 

database server. 

 

 
 

To compact and defragment 

In a new WebCTRL® system, the records in a database are contiguous. As records are added, deleted, 

and modified, the records become scattered in the database. This condition, called fragmentation, can 

slow down system performance and increase the database size. Compact the database to correct this 

situation.  

The files on the server's hard drive can also become fragmented. Defragment the hard drive to correct 

this situation. 

You should compact and defragment on a regular schedule such as once a month. But, you may need 

to do these more often, depending on how often the data or files change.  

NOTE Compacting a database may take several minutes to several hours, depending on its size. 

 TIP  To minimize the effects of fragmentation, you should maintain at least 20% free disk space on 

the server. 

  

  

Compacting the database 

The following databases are compacted dynamically—compacting occurs in the background when a 

database is open.  

 MySQL 

 MS SQL Server 

 MS SQL Server Express 

 Oracle 

 PostGreSQL  

  

 

To compact a Derby database: 

1 Shut down the SiteBuilder and WebCTRL® Server applications. 

2 Open the computer's Command Prompt application and type cd c:\WebCTRLx.x, replacing x.x 

with your system version number. 

3 Click Enter. 

4 Type "Derby Compression Tool.exe" <system name>. 

5 Click Enter. 

6 When compacting finishes, close the command window. 

   

Defragmenting the server's hard drive 

For all database types, use a defragmentation utility such as Windows® Disk Defragmenter. 
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NOTE  If you are using a single computer as both the WebCTRL® server and the client, you must 

defragment the disk more often than the disk of a dedicated server—especially if people access the 

Internet from this computer. 

 

 
 

To minimize the database size 

The larger a database is, the less responsive it may become. Deleting closed alarm incident groups, 

expired schedules, and expired historical trends on a regular basis will reduce the database size. You 

can set up your WebCTRL® application to automatically delete these. See "System Settings > 

Scheduled Tasks tab (page 187)" in WebCTRL® Help. 

 

 
 

To safely shut down the WebCTRL® application for database server 

maintenance 

Occasionally, the database server is shut down for maintenance or backups. If this is done without 

shutting down the WebCTRL® Server first, the database may get locked and the WebCTRL® application 

may not be able to reconnect. 

1 Shut down the WebCTRL® application.   

2 Shut down the database server. 

3 Perform the maintenance or repair needed on the server. 

4 Restart the database server. 

5 Restart the WebCTRL® application.  

 

 

 

 

 

 

 
 

Setting up WebCTRL® client devices and web browsers 

The WebCTRL® system can be viewed on the following client devices and web browsers. 

  

Computers  

The client computer should have at least: 

•  Dual core processor  

•  1.5 GB RAM 

•  Communications link of 10 Mbps or higher 

  

The WebCTRL® application will work with slower computers and slower links, but the results may not 

be satisfactory. 

  

A computer with this 

operating system... 

Supports these web browsers... 
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Windows® GoogleTM ChromeTM v66.0 or later 1 

Internet Explorer® v11 Desktop 

Microsoft® Edge v40 or later 

Mozilla® Firefox® v60.0 or later 

Mac® OS X® 

(Apple® Mac only) 

Safari® v11 or later 2 

Google Chrome v66.0 or later 

Mozilla Firefox v60.0 or later 

Linux® Google Chrome v66.0 or later 

Mozilla Firefox v60.0 or later 

1 Best performance 

2 Best performance unless browser is running on a Mac® Mini or a MacBook: 

 WARNING If machine is running Mountain Lion 10.8x with an integrated Intel HD 400 

graphics card, it will experience display issues. Use one of these workarounds for better 

performance: 

 If an additional NVIDIA graphics card is available, manually switch the graphic card setting in 

MAC® OS X® to use that card. 

 If not, use GoogleTM ChromeTM v66.0 or later. 

 

 

Mobile devices 

   

Device type Platform support 

Smart phone AndroidTM, iOS 

Tablet AndroidTM, iOS, SurfaceTM 

 

NOTE  Some functionality may be limited by the capability of the mobile device and operating system. 
 

Setting up and using a computer with the WebCTRL® system 

  

 Set the monitor's screen resolution to a minimum of 1920 x 1080 with 32-bit color quality 

 You may want to disable the computer's navigation sounds. 

  

Mac only 

NOTE  The instructions below are for a Mac OS X 10.8. Other versions may vary slightly. See your 

computer's Help if necessary. 

  

Computer settings To change setting... 

Enable right-clicking to see 

right-click menus: 
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      On a Mac 1 Select System Preferences > Mouse. 

2 Click the drop-down list that points to the mouse's right-click 

button, then select Secondary Button. 

      On a MacBook 1 Select System Preferences > Trackpad. 

2 Enable Secondary click.  

 

The instructions in Help are for a Windows computer. For instructions that include the Ctrl key, replace 

Ctrl with Command. For example, replace Ctrl+click with Command+click.  

 

 
 

Setting up and using a web browser to view the WebCTRL® interface 

To set up and use Internet Explorer 

NOTES 

 The instructions below are for Internet Explorer® 11. Other versions may vary slightly. See your web 

browser's Help if necessary. 

 If the menu bar is not visible, right-click on the window's header, and then select Menu bar. 

   

Web browser settings To set in Internet Explorer... 

Accept First-party and  

Third-party cookies 

Tools > Internet Options > Privacy > Advanced button 

Automatically check for newer 

versions of stored pages 

Tools > Internet Options > General > Browsing history > Settings 

button 

Load ActiveX Control Tools > Internet Options > Security > Custom Level button. 

Under ActiveX controls and plug-ins, set the following: 

 Download signed ActiveX controls > Prompt 

 Download unsigned ActiveX controls > Disable 

 Run ActiveX controls and plug-ins > Enable 

 Script ActiveX controls marked safe for scripting > Enable 

Select Play animations in web 

pages 

Tools > Internet Options > Advanced > under Multimedia  

Disable all the options on the 

Explorer Bar 

View > Explorer Bars 

Disable web browser's pop-up 

blockers 

Tools > Pop-up Blocker > Turn Off Pop-Up Blocker 

Disable external toolbar  

pop-up blockers 

Varies 

Hide the web browser's toolbars View > Toolbars 

  

To... Do the following... 

Maximize the web browser 

window 

Press F11 to turn full-screen mode on\off, or use the 

minimize/maximize button in the top right corner of the browser 

window. 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

177 

 

To... Do the following... 

Have 2 different users logged in 

to the WebCTRL® system on the 

same computer 

Start a new web browser session. Select File > New Session. 

Clear browser cache 1 Select Tools > Internet Options. 

2 Click Delete. 

3 If you had the WebCTRL® system saved as a Favorite, 

uncheck Preserve Favorites website data. 

4 Click Delete again. 

  

 
 

To set up and use Microsoft Edge 

The instructions below are for Microsoft® Edge. 

  

Web browser settings To set in Microsoft Edge... 

Do not block cookies More Actions > Settings > View Advanced Settings > Cookies 

Disable web browser's pop-up 

blockers * 

More Actions > Settings > View Advanced Settings > Block 

pop-ups  

  

To... Do the following... 

Maximize the web browser 

window * 

Use the minimize/maximize button in the top right corner of the 

browser window. 

Have 2 different users logged in 

to the WebCTRL® system on the 

same computer * 

More Actions > New Window  

Clear browser cache More Actions > Settings > Clear browsing data > Clear 

* Does not apply to Microsoft Edge on a phone. 
 

To set up and use Mozilla Firefox 

NOTES 

 The instructions below are for Mozilla® Firefox® v60.0 on a Windows operating system. Other 

versions may vary slightly. See your web browser's Help if necessary. 

 If the menu bar is not visible, right-click on the window's title bar, and then select Menu bar. 

 If a message appears in the WebCTRL® interface that includes the checkbox Prevent this page 

from creating additional dialogs, DO NOT check this box. 

  

Web browser settings To set in Firefox... 
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Web browser settings To set in Firefox... 

Disable Pop-up blocker 1 Click Tools > Options > Privacy & Security.  

2 Under Permissions, click Exceptions next to Block pop-up 

windows.  

3 Type http:// (or https://) and then the server name or 

IP address of your system.  

4 Click Allow and then Save Changes. 

Enable JavaScript 

 

1 In the address bar, type about:config, and then press 

Enter. 

2 Click I accept the risk. 

3 In the Search bar, type javascript.enabled. 

4 If the value field shows true, JavaScript is enabled. If it shows 

false, right-click javascript:enabled, and then select Toggle. 

 Add-ons Manager 

 

Select Tools > Add-ons > Extensions. On this page, you can 

enable/disable installed add-ons such as: 

 Adobe® Acrobat® Reader (to view PDF's) 

 QuickTime Plug-in (to play audible alarms) 

Only installed Firefox add-ons will show up in the list.  

  

To... Do the following... 

Maximize the web browser 

window 

Press F11 to turn full-screen mode on\off. 

Clear browser cache 1 Click Tools > Options > Privacy & Security. 

2 Under Cookies and Site Data, click Clear Data. 

3 Click Clear. 

Have 2 different users logged in 

to the WebCTRL® system on the 

same computer 

Start a new web browser session. Select File > New Private 

Window. 

 

 

 

 

 
 

To set up and use Google Chrome 

NOTES   

 The instructions below are for GoogleTM ChromeTM v66.0. Other versions may vary slightly. See your 

web browser's Help if necessary.  

 If a message appears in the WebCTRL® interface that includes the checkbox Prevent this page 

from creating additional dialogs, DO NOT check this box. 

  

On a computer 



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

179 

 

Web browser settings To set in Chrome... 

Enable pop-ups 1 Click  on the browser toolbar.  

2 Select Settings.  

3 Click Advanced at the bottom of the page. 

4 Under Privacy and security, click Content settings.  

5 Under Pop-ups > Allow, click ADD, and then type http:// (or 

https://) and then the server name or IP address of your 

system. 

  

To... Do the following... 

Clear browser cache 1 Click  on the browser toolbar.  

2 Select More tools > Clear browsing data.  

3 Select a time range in the drop-down list. 

4 Check the types of information that you want to remove.  

5 Click CLEAR DATA. 

Maximize the web browser 

window 

Press F11 on your keyboard to turn full-screen mode on/off. 

Have 2 different users logged in 

to the WebCTRL® system on the 

same computer 

Start a new web browser session. Click , then select New 

incognito window. 

  

On a Google Nexus 

Web browser settings In the Chrome menu... 

Turn off desktop mode Uncheck Request desktop site 

Disable pop-up blocker Settings > Advanced > Content Settings > uncheck Block  

pop-ups 

Enable JavaScript Settings > Advanced > Content Settings > check Enable 

JavaScript 

Enable Cookies Settings > Advanced > Content Settings > check Accept Cookies 

  

To... In the Chrome menu... 

Clear browser cache Settings > Advanced > Privacy > CLEAR BROWSING DATA 

 

 
 

To set up and use Safari 

NOTES   

 The instructions below are for Safari® v11. Other versions may vary slightly. See your web 

browser's Help if necessary. 
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 We recommend that you do not run Safari in full-screen mode. If you do, WebCTRL® pop-ups will 

open full-screen, covering the main application window. 

  

On an Apple® computer (Mac®) 

Web browser settings To set in Safari... 

Disable pop-up blocker Preferences > Security > uncheck Block pop-up windows 

Enable JavaScript Preferences > Security > check Enable JavaScript 

Enable Plug-ins Preferences > Security > check Enable plug-ins 

Prevent pop-ups from opening in 

a new browser tab 

Preferences > Tabs > uncheck Command-click opens a link in a 

new tab 

Prevent Safari from automatically 

opening zip files exported from 

the WebCTRL® application 

Preferences > General > uncheck Open "safe" files after 

downloading 

  

To... Do the following... 

Clear browser cache History > Clear History 

Have 2 different users logged in 

to the WebCTRL® system on the 

same computer 

Start a new web browser session. Select Safari > Private 

Browsing > File > New window 

  

On an Apple® iPad 

Web browser settings To set on the iPad... 

Disable pop-up blocker Settings> Safari > set Block pop-ups to Off 

Enable JavaScript Settings > Safari > set JavaScript to On 

  

To... Do the following... 

Clear browser cache Settings > Safari > Clear History 

  

On an Apple® iPhone 6 

Web browser settings To set on the iPad... 

Enable JavaScript Settings > Safari > Advanced  
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Setting up a system in the WebCTRL® interface 

System Settings 

The System Settings page contains information that you must enter before the WebCTRL® application 

can run properly. 

1 On the System Configuration  tree, select System Settings. 

2 Click each tab, then enter the necessary information. Tab details are described below. 

 

 
 

General tab 

The General tab presents the following system information: 

 System Directory Name 

 Path to the Webroot Directory 

 Database Type 

 System Language - The language to be used for: 

○ The default language for new operators 

○ Alarms logged to the database 

○ State text and object names downloaded to the field 

○ The login page 

NOTE  Language also refers to formatting conventions. For example, English uses the date format 

mm/dd/yy, but English (International) uses the date format (dd/mm/yy). 
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You can edit or use the following fields and buttons.  

  

Field Notes 

System Information  

System Statistics button Click to see the following system information: 

 Number of controllers 

 Number of controllers that can run control programs 

 Number of points, regardless of vendor 

 Number of trend sources in database 

 Number of trend samples in database 

Levels displayed in paths The number of levels displayed in WebCTRL® paths. For example, 

if Node Name Display Depth is set at: 

    2, a typical path might be  ..\AHU-1\RA Temp 

    3, a typical path might be  ..\Atlanta R&D\First Floor\AHU-1 

NOTE  Changing this field does not take effect until you restart the 

WebCTRL Server application. 

Logs  

Select a week of logs to review For troubleshooting, you can download a zip file that contains logs 

of system activity. 

Time  

Time Sync Click to immediately synchronize the time on all IP network 

controllers in the system database to the WebCTRL® server's 

time.  

Time synchronization occurs daily if the Enable time 

synchronization of controllers daily at____ field on the Scheduled 

Tasks tab (page 187) is enabled. (Click this link for more 

information on time synchronization.) 

Time Format Select one of the following for the system's time: 

 12-hour clock (Example:  4:34 pm) 

 24-hour clock (Example:  16:34) 

Date Format Select the format you want the system to use. 

Alarms  

Use a single alarm template for 

CMnet alarms 

If your system is an upgraded legacy system: 

 Check to have alarms for CMnet equipment use only the 

alert_auto alarm template. 

 Uncheck to allow multiple alarm templates. 

Enable support for Alarm 

Notification Clients to connect to 

this server 

Check to use the Alarm Notification Client application. See Alarm 

Popup (page 68) alarm action. 

Restrict to IP Address If the server has more than one network interface adapter, type 

the IP address of the server's network connection that the Alarm 

Notification Client application will connect to. 
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Field Notes 

Port Change this field if the Alarm Notification Client application will 

use a port other than 47806 on the server.  

Current client connections Shows any workstation whose Alarm Notification Client is actively 

connected to this server. 

Schedules  

Disable Schedules  If your system has no need to run schedules, check this box so 

that the Schedules feature is no longer visible in WebCTRL® 

interface. 

Trends  

Keep historical trends for ___ 

days 

Stores trend data in the WebCTRL® database for the time you 

specify. This is a default setting that you can change when you set 

up trends for an individual point. Specify the time of day that the 

trends are deleted on the Scheduled Tasks tab. 

Display gap in graph line for 

missing data 

Check to show a gap if trend data is missing. 

Enable Server Trending of Color Leave this checked unless directed otherwise by Technical 

Support. 

Poll Interval  The frequency that the server polls routers for color trend data. 

Increase this field only if Last Poll Duration exceeds the Poll 

Interval. 

Source Files  

All Source Files Use to export source files to a .zip file that can be imported into 

another WebCTRL® or Field Assistant system. Source files 

include: 

 Control programs (.equipment files only) 

 Drivers 

 Graphics (.view files only) 

 Touchscreen files 

 BACview® files 

 Report design files for Equipment Values or Trend Sample 

reports 

NOTE  If import detects a difference between a database file and 

an import file with the same name, import does not overwrite the 

database file. A message lists any file differences so that you can 

resolve them. 

See Commissioning equipment using Field Assistant. 

Email Server Configuration The information in this section is used by the Send email alarm 

action (page 77) and used to email a Scheduled Report (page 

142). 

From Enter a valid address if required by your mailserver. 

Mail Host The mailserver's address. This can be an IP address or a system 

name, such as mail.mycompany.com. 
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Field Notes 

Mail Host Port Change this field if using a port other than the default port 25. 

Mail Host Security Options Select the type of security the mailserver uses. 

 Cleartext (SMTP) – Uses the SMTP protocol to send as clear 

text over TCP/IP 

 Secure SSL (SMTP with SSL) – Uses SSL, a communication 

protocol that provides data encryption 

 Secure TLS (STARTTLS) – Uses TLS, but does not begin 

encryption until the WebCTRL® application issues STARTTLS 

command 

Specify Mail User for Mail Host 

Authentication 

Select if your mailserver requires a username and password. 

Test connection Click to have the WebCTRL® application try to connect to the 

email server. A message will appear below this button stating if 

the connection was successful or if it failed. 

 

 

 
 

Security tab 

  

Field Notes 

Logging  

Log audit data to file Records operator activities and some system activities (such as 

opening and closing the database or automatic deletions) in a text 

file. 

The default file is auditlog.txt stored in 

WebCTRL\webroot\<system_name>. You can change the file name 

and include a different path. 

To prevent the file from growing too large as new data is appended, 

you can archive the data to another text file by selecting an archive 

frequency in the Archive log file contents field. The archive file is 

auditlog_yyyy_mm_dd.txt, where yyyy_mm_dd is the creation date of 

the archive file. This file is created in the same location as 

auditlog.txt. 

NOTE  If you do not archive the log file contents, you should manually 

delete the oldest entries. 

Log audit data to database Records audit data in a database named audit.mdb that can be 

accessed by third-party software. 

NOTE  For Access, MSDE, and Derby, the database is automatically 

created. An Access database is named audit.mdb; a MSDE database 

is named audit.mdf. The Derby database consists of multiple files in 

a folder called audit. For MySQL, SQL Server, PostgreSQL, or Oracle, 

you must create the database manually. 

Delete database entries 

older than ____ days 

Automatically deletes entries in the database that are older than the 

number of days you specify. 
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Field Notes 

Log errors for invalid URLs Check this field to write to the core.txt log any time an external 

source sends a request to the WebCTRL Server application.  

NOTE  Regular maintenance scans by external software can cause 

the log files to grow large. 

Security Policy  

Change Policy See Location-dependent operator access (page 158) for information 

on Change Policy. 

Remote Access  

Allow remote file 

management 

Lets you access the system using WebDAV. 

Operators  

Return operators to previous 

locations when server 

reconnects 

Returns operators to current tree locations when the server 

reconnects. 

Log off operators after _:_ 

(HH:MM) of inactivity 

The system automatically logs off an operator who has had no activity 

in the system for the time period specified. 

This is a default setting for the system. The System Administrator can 

change this setting for an individual operator on the Operators page. 

Lock out operators for __ 

minutes after __ failed login 

attempts 

Clear Lockouts removes lockouts for all users. 

NOTE  Restarting the WebCTRL Server application will remove 

lockouts. 

Use advanced password 

policy 

You can place specific requirements on passwords to increase 

security. See Advanced password policy (page 157). 

Do not synchronize operator 

and privileges 

If using hierarchical servers, the WebCTRL® application automatically 

synchronizes the operator/privilege settings on the child servers with 

those on the parent server. You have the following options: 

 Check this field on all servers to stop the synchronization 

process. 

 Check this field on a child server to remove it from the 

synchronization process so that you can manage that server's 

settings locally.  

Synchronize Now Click this button on the parent server for immediate synchronization 

of operator/privilege settings.  
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Permissions  

Permissions When control programs, views, and touchscreen and BACview® files 

are created by an original equipment manufacturer (OEM), they 

cannot be used in a WebCTRL® system without the creator's 

permission. However, the creator can produce a key for a system with 

a different license that will grant permission to the key's recipient. 

If you receive a key, put it in the WebCTRL X.X\resources\keys 

folder. The table in the Permissions section of the Security page 

shows all keys in the that folder. To activate a key, click Add, then 

browse to the key.  

To delete a key from your system, select the key in the table, then 

click Delete. 

Red text in the table indicates the key has a problem such as it does 

not apply or has expired. See the Notes column for an explanation. 

 

 
 

Communications tab 

The fields on this tab let you define controller communication with the WebCTRL Server application and 

BACnet network communication. 

  

Field Notes 

WebCTRL Server BACnet 

Controller Instance 

and 

BACnet Alarm Recipient 

Instance 

The BACnet identifier for the system's server and the alarm recipient. 

You enter these system properties in SiteBuilder. 

Always upload properties 

from controllers to WebCTRL 

database on mismatch 

Automatic uploads are listed in the Audit Log. 

If you do not check this field, properties must be manually uploaded 

or downloaded by the operator when a mismatch occurs. 

NOTE  If an automatic upload fails and the operator chooses to do 

nothing at that time, the upload will be attempted again when he 

returns to the page where he encountered the mismatch. 

Ignore incoming alarms from 

sources not in this database 

The WebCTRL® application will ignore alarms from third-party 

devices not in the database or devices from other WebCTRL® 

systems on the same network. 

BACnet Settings Native WebCTRL® system only 

Log BACnet Binding Conflicts The WebCTRL® application uses BACnet (dynamic) binding for 

communication between devices unless your system uses NAT 

routing. If using NAT, the WebCTRL® application uses information in 

its database to bind to BACnet devices. 

When checked, the WebCTRL® application logs binding conflicts that 

result from duplicate network numbers or device IDs. 
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Scheduled Tasks tab 

 

Field Notes 

Automatically delete alarm 

incident groups which have 

been closed for more than 

___ days 

An incident group is all alarms related to a particular incident, such as 

Off Normal, Fault, and Return to Normal. 

NOTE  Alarms in an incident group are not deleted until all alarms in 

the group have been closed. 

Archive alarm information 

upon alarm deletion 

Writes alarm information to a text file. 

Archive file The default file is eventdel.txt stored in 

WebCTRL\webroot\<system_name>. You can change the file name 

and include a different path. 

Archive file format The alarm information to be written to the archive file. To add 

information, select field codes in Append Field Code. To delete field 

codes, highlight them in the Archive file format box and press Delete. 

Automatically delete expired 

schedules daily at ___ 

To ensure there are no time zone conflicts, the WebCTRL® 

application waits 2 days after a schedule expires to delete it. 

Remove expired historical 

trends daily at ____ 

Deletes trend data that has been in the database longer than the 

time specified in the Keep historical trends for ___ days field on the 

General tab. 
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Field Notes 

Enable time synchronization 

of controllers daily at____ 

Automatically synchronizes the time on all equipment to the time on 

the server, adjusting for different time zones and Daylight Saving 

Time. We recommend that you check this field. 

The WebCTRL® application will send a daily time sync message to 

each IP network device that is in the system database. IP devices not 

in the database will not be synchronized. For all ARC156 or MS/TP 

networks in the database, the WebCTRL® application will send a 

broadcast time sync message. All devices on these networks will be 

synchronized, regardless of whether or not the devices are in the 

database. 

 CAUTIONS   

 Make sure that your server’s time and time zone setting are 

correct.  

 Make sure that each site’s time zone setting in SiteBuilder is 

correct. 

 To prevent time sync problems when the transition to and from 

Daylight Saving Time occurs, set the time sync to occur at least 1 

hour after the last controller in the system is adjusted for DST. 

For example, your server and part of your system is in the Eastern 

Standard Time zone, but you also have controllers in the Pacific 

Time zone. Your server is adjusted for DST at 2:00 a.m. Eastern 

Standard Time, but the controllers in the Pacific Time zone are 

not adjusted until 3 hours later. So you would set the time sync to 

occur daily at 6:00 a.m. or later. 

NOTES   

 You can disable this function for an individual site on the site’s 

Properties page. See To set up site properties (page 190). 

 You can perform system-wide time synchronizations using the 

Time Sync button on the General tab (page 181). Or, you can 

synchronize individual devices using the Time Sync button on the 

devices' Properties page. 

 Between time sync broadcasts, Automated Logic® routers 

include time sync information in each color request to the devices 

below the router. This ensures devices without a battery-backed 

clock will get the time shortly after powering up. 

  

 

 
 

Daylight Saving tab 

On this tab, you can adjust the Daylight Saving Time settings for WebCTRL Server.  

Click Update to automatically set the table's Begin and End dates for the next 10 years based on the 

system's timezone. This marks all controllers with ExecB drivers for a Parameters download. 

If the updated dates are incorrect 

If you clicked Update but the dates are incorrect, your system's Java timezone data may be out-of-date. 

Do the following: 

1 Go to the Oracle Java SE Download site (http://java.sun.com/javase/downloads). 

http://java.sun.com/javase/downloads
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2 Download the JDK DST Timezone Update Tool (tzupdater-< version >.zip) and unzip the file.  The 

zip file contains 2 items: 

○ tzdata.tar.gz 

○ tzupdater.jar 

3 In the WebCTRL® interface, go to System Settings > Daylight Saving, then click Import. 

4 Browse to the tzupdater.jar file, select it, then click Open. 

5 Click Continue. This restarts the WebCTRL Server application. 

6 After the restart, in the WebCTRL® interface, go to System Settings > Daylight Saving, and then 

click Import. 

7 Browse to the tzdata.tar.gz file, select it, and then click Open. 

8 Click Continue. This restarts the WebCTRL Server application. 

9 On the System Settings > Daylight Saving tab, click Update. 

  

NOTE  If you have sites in different time zones that use Daylight Saving Time, you can click View DST 

Dates on the site's Properties page to see DST information and time change dates. 

 

 
 

Add-ons tab 

A WebCTRL® system supports add-ons, such as EnergyReports, that retrieve and use the WebCTRL® 

data.  

By default, the WebCTRL® application allows only signed add-ons that are supported by Automated 

Logic®. If needed, you can override this setting in SiteBuilder by going to Configure > Preferences > 

Web Server, and checking Allow unsigned add-ons. 

  

To install an add-on 

1 Save the add-on's file (.addon or .war) to your computer.  

2 On the System Settings > Add-ons tab, click Browse, and then open the file.  

3 Click Install. After a few seconds, the add-on will appear in the Installed table, and will be enabled. 

The table below gives a description of each column. 

  

Column Notes 

Name The add-on's name. 

Path To open the add-on in a web browser, append this path to your 

WebCTRL® system's address. 

For example, to open EnergyReports, type: 

http://<system_name>/EnergyReports, or 

http://<system_IP_address>/EnergyReports 

Version The version is shown if the author provided the information in the 

add-on. 

Status If this column shows: 

•  Running, you can open the add-on in a web browser. 

•  Disabled, click Enable to run the add-on. 

•  Startup error, select the table row to see an  

    explanation of the error under Details. 
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4 Select an add-on in the Installed table to disable or enable it, or to see the following Details. 

  

Add-on  

main page 

Click the main page link to open the add-on, if the author provided 

a main page. 

Description A description of the add-on, if the author provided one 

Vendor Name The add-on's author 

Public Data Directory This public directory contains data generated by the add-on. This 

data is visible in a web browser. 

Private Data Directory This private directory contains information such as configuration 

data. 

  

To back up the add-on's private and public data directories 

NOTE  This procedure will not back up data stored in an external database. For example, EnergyReports 

uses an external database. 

1 Select the add-on in the table. 

2 Click Save Data. 

3 Click OK. 

4 Click Save. 

5 Select the location where you want to save the data, then click Save. 

  

To update an add-on 

NOTE  Add-ons for WebCTRL® v6.0 or later systems have a different folder structure than previous 

versions. 

1 Select the add-on in the table. 

2 Click Remove Add-on and Keep Data  

3 Follow the procedure above to install the new version of the add-on.  

   

To uninstall an add-on 

1 Select the add-on in the table. 

2 Click Remove Add-on and Data. 

 

 
 

To set up site properties 

1 On the Network  tree, select the site. 

2 Click Properties. 
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3 Configure site properties. 

 

Field Notes 

Enable Timesync Daily synchronizes the time in the site's controllers with the server's time, 

adjusting for different time zones and Daylight Saving Time. Synchronization 

occurs each day at the time specified in the field Enable time synchronization 

of controllers daily at on the System Settings > Scheduled Tasks (page 187) 

tab. 

 CAUTION  Make sure that your server’s time and time zone setting are 

correct. Also, make sure that the site’s time zone setting is correct in 

SiteBuilder. 

View DST Dates If the site's time zone (set in SiteBuilder) uses Daylight Saving Time, you can 

click View DST Dates to see DST information and time change dates.  

Group Cache 

Controller 

The designated router where colors are cached when peer caching is enabled 

in SiteBuilder. 

 

 
 

To register your WebCTRL® software 

To register your software, you must obtain a registered license from Automated Logic® and then apply 

it in the WebCTRL® interface. You can apply it when you install the software or at a later time. 

1 Go to http://accounts.automatedlogic.com. 

2 Select Support > Software Licenses > BAS License Manager - For WebCTRL 2.5 and later. 

3 Your unregistered license will show  on the right side of the blue bar. Expand the blue bar.  

4 Click on the row that shows unregistered in the Registration Status column. 

5 Fill in the fields under Owner Information and Site Information. 

6 Click Register License. 

7 Check I agree to the terms of use. 

8 Click Download License, then save the license file to a disk or to your hard drive. 

9 Apply your license: 

○ During the WebCTRL® installation—The installation requests the location of your license file.  

Browse to location where you saved it in step 4 above. 

○ After the installation— 

a.  On the WebCTRL® System Configuration  tree, select License Administration. 

b.  Browse to the license file. 

c.  Click Apply. 

d.  Restart the WebCTRL Server application. 

  

NOTES 

 Do not edit any part of this registered license file. Editing a license file invalidates the license. 

 Store the license in a safe location. 

 

 
 

To replace the license when adding features 
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You can add any of the following optional WebCTRL® packages to your system: 

 Advanced security:  Location-dependent operator access, configurable password policies, and 

required operator comments/verification for system changes 

 Advanced reporting:  Custom reports 

 Advanced Alarming:  Additional alarm actions 

  

You can purchase an optional package at http://orders.automatedlogic.com. Select Options under 

Software Products. 

  

To obtain an updated license and then apply it in the WebCTRL® interface: 

1 Go to http://accounts.automatedlogic.com. 

2 Select Support > Software Licenses > WebCTRL 2.5 and later (BAS License Manager). 

3 Your unregistered license will show  on the right side of the blue bar. Expand the blue bar.  

4 Click on the row that shows unregistered in the Registration Status column. 

5 Fill in the fields under Owner Information and Site Information. 

6 Click Register License. 

7 Check I agree to the terms of use. 

8 Click Download License, then save the license file to a disk or to your hard drive. 

9 To replace your license, on the WebCTRL® System Configuration  tree, select License 

Administration. 

10 Browse to the license file. 

11 Click Apply. 

12 Restart the WebCTRL Server application. 

  

 TIP  Back up your system (page 172) before replacing your license. 
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Adding links or text to the WebCTRL® login page 

You can add links or text, such as a disclaimer, to the login page. 

 

 

 
 

To add links to the login page 

1 In a text editor such as Notepad, type 2 lines for each link that you want on the login page.  

Line 1:   link#.text=<the link text that is to appear on the login page>  

Line 2:   link#.url=<the link's address> 

NOTE  link#.text and link#.url must be lowercase. 

  

Example to add links shown above: 
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2 Save the file with the following name and location. 

File name:   extra_login_links.properties 

Location:     WebCTRLx.x\webroot\<system_name> 

 

 
 

To add text to the login page 

1 In a text editor such as Notepad, type the text that you want on the login page.  

  

Example to add text shown above: 

 
  

2 Save the file with the following name and location. 

File name:   legal_disclaimer.txt 

Location:     WebCTRLx.x\webroot\<system_name> 

 

 

 
 

Editing a system remotely 

 

 
 

Editing the Geographic or Network tree 

In the WebCTRL® interface, you can edit the Geographic  or Network  tree that was originally 

set up in SiteBuilder. The system database is updated immediately. 

Right-click an item on the Geographic  tree, then select Set up Tree. Click Geographic  or 

Network  to display the tree you want to edit.   

  

Click this 

button... 

Or use this 

shortcut... 

To... 

 
 Add an area as a child of the selected area. (Geographic tree only) 

 
 Import a clipping that was saved in SiteBuilder. See To import a 

clipping (page 195) below. 

 
Ctrl+X Cut a selected item so it can be pasted in another location in the 

tree. (Geographic tree only) 
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Click this 

button... 

Or use this 

shortcut... 

To... 

 
Ctrl+V Paste an item that was previously cut from another location in the 

tree. The item will be pasted as a child to the selected item. 

(Geographic tree only) 

 
Up arrow, 

or 

Drag and drop in 

new location 

Move the selected item up the tree to a new location. (Geographic 

tree only) 

 
Down arrow, 

or 

Drag and drop in 

new location 

Move the selected item down the tree to a new location. 

(Geographic tree only) 

 
 Rename the selected item.  

 
Delete  Delete the selected item. The item and all of its children will be 

deleted. 

 
Double-click the 

tree item 

Edit the item's features such as: 

 names  

 view—See To attach a graphic in the WebCTRL® interface (page 

18) 

 control program—See Working with control programs in the 

WebCTRL® interface (page 200) 

  

 CAUTIONS   

 Make a backup of your system before making changes. 

 Make changes carefully as they cannot be undone.  

  

NOTES   

 You can also right-click items in the Set up Tree dialog box to perform the above tasks. 

 You can perform some of the above actions on multiple tree items simultaneously. Use Ctrl+click, 

Shift+click, or both to select multiple items. 

 

 
 

To import a clipping 

You can export a clipping (a portion of a system) in SiteBuilder and then import it in the WebCTRL® 

interface. The following items are imported: 

 One or more selected Geographic and Network tree items including attached control programs, 

graphics, and drivers 

 Reports 

 Trend data (if included in the clipping) 

 Alarm templates and categories 

 Location-dependent security information 

 Schedules and schedule group membership (including the entire schedule group and schedules, if 

it does not exist in the target system) 
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 Alarm actions 

 Alarm message prefixes and suffixes 

 Source tree relationships (including source tree rules if the source tree does not exist in the target 

system) 

 

To import a clipping: 

1 Right-click an item on the Geographic  tree, then select Set up Tree. 

2 Click the Import clipping button . 

3 Browse to and select the clipping you want to import, then click Next. 

4 Optional:  If necessary, you can change the location path where the clipping will be imported. Select 

the system fragment, then select the import location in the tree below. 

5 Click Next. 

6 If asked if you want to replace event templates, follow the on-screen instructions. 

7 If asked if you want to overwrite components, follow the on-screen instructions. 

8 The interface shows any conflicts and problems that were found during the import. Make any 

needed corrections in SiteBuilder.  

NOTE  Click Copy to Clipboard and then paste the list into another program such as Notepad for 

viewing or printing. 

9 Click Next. 

10 Click Finish. 

11 Do any of the following that apply. 

  

If you imported... Do the following in the SiteBuilder 

application... 

Do the following in the 

WebCTRL® application... 

Another site into the system Change the new site's BACnet/IP 

network number to be the same as 

the other BACnet/IP network(s). 

  

 

Download All Content to all 

Automated Logic® IP routers in 

the system. 
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If you imported... Do the following in the SiteBuilder 

application... 

Do the following in the 

WebCTRL® application... 

A second BACnet/IP network 

into a site 

Move the items under the new 

network to the original BACnet/IP 

network, then delete the new 

network. 

  

 

Download Parameters to any 

controllers that you moved. 

Any controllers that use the 

SiteBuilder option 

Automatically Configure My 

BBMDs 

N/A Download BBMDs to the routers. 

Any controllers that use 

manually configured BBMD 

tables 

N/A Update the routers' BBMD tables.  

See "To set up BBMDs through 

the WebCTRL® interface"  

or  

"To set up BBMDs using the 

BBMD Configuration Tool"  

in WebCTRL® Help. 

A clipping without trends into 

a system using NAT 

N/A 

  

Restart IP connection(s) to new 

devices. 

 

 
 

Managing files on a remote WebCTRL® server 

The WebCTRL® application supports WebDAV, a network protocol designed for managing remote 

server files through an Internet connection. Use a third-party WebDAV client application, such as 

WebDrive, to access the Internet from anywhere in the world and manage your system files residing on 

a distant WebCTRL® server. 
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Running WebCTRL Server as a Windows® service 

For Windows 7, 8, 10, 2008, 2012, and Vista 

Run WebCTRL Server as a Windows service if you want WebCTRL Server to automatically start up when 

the server computer is restarted.  

  

NOTE  If your WebCTRL® system uses a database other than Derby and the database is located on the 

same computer as WebCTRL Server, you must set up Windows to delay starting WebCTRL Server until 

the database service has started. See "How to delay loading of specific services" 

(http://support.microsoft.com/kb/193888) on the Microsoft® website. 

 

 
 

To install WebCTRL® Server service 

NOTE  If you are not sure if the service was previously installed, see To determine if WebCTRL Server 

service is installed (page 200). 

   

1 In the Windows Start menu, select All Programs > Accessories. 

2 Right-click Command Prompt, then select Run as administrator. 

3 Select Yes in the User Account Control message. 

4 In the Command Prompt window, type:  cd <path to the WebCTRL install directory> 

For example, type:  cd c:\WebCTRLx.x 

replacing x.x with your current version number. 

5 Press Enter. 

6 Type:  "WebCTRL Service.exe" 

7 Press Enter. 

 

 
 

To start WebCTRL® Server as a Windows service 

1 In the Windows Start menu, select Control Panel. 

2 Select Administrative Tools, then double-click Services. 

3 In the Services (Local) list, double-click WebCTRL Service X.X. 

4 In the Startup type drop-down list, select Automatic. 

5 On the Log On tab, do one of the following: 

○ For Windows Vista, 2008, 2010, and 2012, select This account, and then browse to select a 

user who is a member of the Administrator Group on that computer. 

○ For Windows 7 and 8, select Local System account. 

http://support.microsoft.com/kb/193888
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6 Optional:  If you selected Local System account in step 5 and you want to be able to access 

WebCTRL Server on the server computer's desktop, check Allow service to interact with desktop.  

NOTES   

○ If you do not check this field, the computer screen will give no indication that WebCTRL Server 

is running; you must view the computer's Services page to see if it is running. 

○ This checkbox applies only to a user logged in on the server. A Windows Remote Desktop user 

cannot access WebCTRL Server running as a service. 

○ If you check this field, you cannot use the instructions below to set up printing to a network 

printer. Ask your Network Administrator to set up Local System account to use a network 

printer. 

○ If you check this field and the WebCTRL® application is to run email alarm actions, ask your 

Network Administrator to set up Local System account to send emails. 

7 On the General tab, click Start. 

8 Click OK. 

NOTE    If WebCTRL Server does not start after you click Start, you may have a Windows permissions 

problem. Follow the procedure below in To set up the WebCTRL service for network printing (page 199) 

to set up the Windows user name and password. 

 

 
 

To set up the service for network printing 

If WebCTRL Server runs as a service on a computer that is using a network printer, you must set up the 

Windows user name and password for the service. The Print alarm action requires this setup to be able 

to print. 

1 In the Windows Start menu, select Control Panel. 

2 Select Administrative Tools > Services. 

3 Double-click WebCTRL Service x.x. 

4 On the Log On tab, select This account. 

5 Browse to the computer's domain, then select the user that the service will log in as. 

NOTE  Contact your network administrator if you need help determining the domain. 

6 Type the user's password in the Password and Confirm password fields. 

 

 
 

To stop or uninstall WebCTRL® Server service 

To stop WebCTRL Server service 

1 In the Windows Start menu, select Control Panel. 

2 Select Administrative Tools, then double-click Services. 

3 In the Services (Local) list, double-click WebCTRL Service X.X (where x.x is the WebCTRL version 

number. 

4 In the WebCTRL Service x.x Properties dialog box, click Stop on the General tab. 

5 Click OK. 
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To uninstall WebCTRL Server service 

1 In the Windows Start menu, right-click Command Prompt, then select Run as administrator. 

2 Select Yes in the User Account Control message. 

3 In the Command Prompt window, type:  cd <path to the WebCTRL install directory> 

For example, type:  cd c:\WebCTRLx.x 

4 Press Enter. 

5 Type:  "WebCTRL Service.exe" -remove 

6 Press Enter. 

 

 
 

To determine if WebCTRL® Server service is installed 

If you do not know if the service was previously installed, follow the appropriate steps below. 

   

1 In the Windows Start menu, right-click Command Prompt, then select Run as administrator. 

2 Select Yes in the User Account Control message. 

3 In the Command Prompt window, type:  cd <path to the WebCTRL install directory> 

For example, type:  cd c:\WebCTRLx.x 

4 Press Enter. 

5 Type:  "WebCTRL Service.exe" -check 

6 Press Enter. 

 

 

 
 

Working with control programs in the WebCTRL® interface 

A control program is typically defined in SiteBuilder when the system is engineered, but you can do the 

following in the WebCTRL® interface. These changes require you to download (page 30) the controller. 

  

 Add a control program to a controller (page 201) 

 Replace an existing control program (page 201) 

 Retrieve a control program from the WebCTRL®, edit it in EIKON®, and then return the edited 

program to the server (page 202) 

 Reload a revised control program located in webroot\<system>\programs. 

On the WebCTRL® Geographic  tree, right-click the equipment, then select Reload Control 

Program. Reloading updates all instances of a control program throughout the system and marks 

the controller(s) for download. WebCTRL® determines the appropriate download option (page 31) 

based on what changed in the control program.  

   

NOTE  If you change a control program in the EIKON® application and it does not display correctly in 

the WebCTRL® interface, Ctrl+right-click the WebCTRL® action pane, and then select Refresh. 
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To add a control program to a controller 

1 Select the controller on the WebCTRL® Network  tree. 

2 On the Devices page > Manage tab, click the Add Control Program button. 

3 Type a Display Name for the control program. 

4 Select the Controller that you are adding the program to. 

5 Optional:  You can change the control program's Reference Name if needed. 

6 Optional:  You can select a different Icon. 

7 Do one of the following: 

  

If the control program is...  

In the Control Program drop-down list Select the control program. 

Not in the Control Program 

drop-down list 

a.  Click Add New. 

b.  Browse to select the control program. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

   

8 Optional: Check Require operator to record any changes to control program. See Recording 

reasons for edits (21 CFR Part 11) (page 161). 

9 Click Accept. 

10 Download All Content (page 30) to the controller. 

  

NOTES   

 You can click Delete Unused in the Control Programs section to delete all unattached control 

programs and any supporting files with the same name from the programs folder. 

 In the Add Control Program dialog box, you can also attach or remove a .view file that will be 

displayed in the WebCTRL® interface for the control program. 

 If you need to change a control program's Object Instance number, right-click the control program 

in the navigation tree, and then select Configure. Click  next to the field for additional 

information. 

 

 
 

To replace an existing control program 

1 Right-click the control program on the WebCTRL® navigation tree, then select Configure. 

2 The following steps are optional: 

a) Change the Display Name for the control program. 

b) Change the control program's Reference Name if needed. 

c) Select a different Icon. 
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3 If the system has other control programs of this type, select which control programs you want to 

change.  

 

NOTES   

○ If you are changing an IP router's control program, the second option will change all control 

programs of this type only on the IP network. 

○ If you are changing a control program on the network below an IP router, the second option will 

not change control programs of this type in the router. 

4 Do one of the following: 

  

If the control program is...  

In the Control Program drop-down list Select the control program. 

Not in the Control Program 

drop-down list 

a.  Click Add New. 

b.  Browse to select the control program. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

   

5 Optional: Check Require operator to record any changes to control program. See Recording 

reasons for edits (21 CFR Part 11) (page 161). 

6 Click Accept. 

7 Download All Content (page 30) to the controller. 

  

NOTES   

 You can click Delete Unused in the Control Programs section to delete all unattached control 

programs and any supporting files with the same name from the programs folder. 

 In the Add Control Program dialog box, you can also attach or remove a .view file that will be 

displayed in the WebCTRL® interface for the control program. 

 

 
 

To edit a control program 

On a WebCTRL® client, you can get a copy of a control program from the server, edit it, then put it back 

on the server. 

To get the control program 

1 Right-click the equipment on the WebCTRL® Geographic  or Network  tree, then select 

Configure. 

2 In the Control Programs section, click Edit Existing. 

3 Click Save as. 

4 Browse to the folder you want to put the file in. 

5 Click Save. 
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6 Click Close. 

  

To put the edited control program back on the server 

1 Right-click the equipment on the WebCTRL® Geographic  or Network  tree, then select 

Configure. 

2 In the Control Programs section, click Add New. 

3 Browse to select the control program. 

4 Click Open. 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 

 

 

 
 

Working with drivers in the WebCTRL® interface 

A controller's driver is defined in SiteBuilder when the system is engineered, but you can make the 

following changes in the WebCTRL® interface.  

 Change the driver settings. See "Setting up the driver" in the controller's Technical Instructions. 

 Change or upgrade a driver. See topic below. 

 Reload a driver if it becomes corrupt (for example, a driver page is missing in the WebCTRL® 

interface). On the WebCTRL® Network  tree, right-click the controller or driver, then select 

Reload Driver. Reloading updates all instances of the driver throughout the system and marks the 

controller(s) for an All Content download. Changes you made on the driver pages in the WebCTRL® 

interface remain in effect.  

After you make these changes, you must download All Content (page 30) to the affected controller(s). 

NOTE  You can also make these changes in SiteBuilder. See "To change or upgrade a driver" in 

SiteBuilder Help. 

 

 
 

To change or upgrade a driver 

1 On the WebCTRL® Network  tree, right-click the controller, then select Configure. 

2 If other controllers in the system use this driver, select which controllers you want to change.  
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3 Do one of the following: 

  

If the driver is...  

In the Driver Version drop-down list a.  Select the driver. 

b.  Click Accept. 

Not in the Driver Version drop-down list a.  Click Add. 

b.  Browse to select the driver. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

   

4 Download All Content (page 30) to the controller. 

  

NOTE  You can click Delete Unused in the Controller section to delete all unused drivers in 

WebCTRLx.x\webroot\<system_name>\drivers. 

 

 

 
 

Working with touchscreen or BACview® files in the WebCTRL® 

interface 

To use a touchscreen device or BACview® device to view or edit a controller's property values, you must 

download a screen file (.touch, .bacview, .S37, or.kpd) to the controller. The screen file is typically 

defined in SiteBuilder and downloaded with the initial download to the controller, but you can select a 

different file in the WebCTRL® interface. 

 

 
 

To select a different screen file 

1 On the WebCTRL® Network  tree, right-click the controller, then select Configure. 

2 If other controllers in the system use the current screen file, select which controllers you want to 

change.  

 
  



 

WebCTRL® v7.0 ALC Proprietary and Confidential © 2019 Automated Logic Corporation  

Rev. 5/9/2019  All rights reserved 

205 

 

3 Do one of the following: 

  

If the screen file is...  

In the Screen file drop-down list a.  Select the file.  

b.  Click Accept. 

Not in the Screen file drop-down list a.  Click Add. 

b.  Browse to select the screen file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

   

4 Download All Content (page 30) to the controller. 

  

NOTE  You can click Delete Unused in the Screen File section to delete all unused screen files in: 

 WebCTRLx.x\webroot\<system_name>\views 

 WebCTRLx.x\webroot\<system_name>\programs 

 

 
 

To edit a screen file on a WebCTRL® client 

On a WebCTRL® client, you can get a copy of a screen file from the server, edit it, then put it back on 

the server. 

To get the screen file  

1 On the WebCTRL® Network  tree, right-click the controller that uses the screen file, then 

select Configure. 

2 Under Screen File, click Edit. 

3 Click Save as. 

4 Browse to the folder you want to put the file in. 

5 Click Save. 

6 Click Close. 

  

To put the edited file back on the server 

1 On the WebCTRL® Network  tree, right-click the controller that uses the screen file, then 

select Configure. 

2 Under Screen File, click Add. 

3 Browse to select the file. 

4 Click Open. 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 
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Setting up a system for non-English languages 

English is the WebCTRL® default language, but you can set up your system to display a different 

language. You can also set up multiple languages so different operators can view the system in 

different languages. 

Follow the procedures below to display the WebCTRL® interface in non-English languages. 

1 Install a language pack (page 206). 

2 Prepare your workstation for non-English text (page 206). 

3 Create control programs and translation files (page 208). 

4 Create graphics (page 210). 

5 Create your system in SiteBuilder (page 212). 

6 Set an operator’s language in the WebCTRL® interface (page 213). 

 

 
 

Installing a language pack 

A language pack translates the text in the WebCTRL® interface. A WebCTRL® system is installed with 

an English language pack. To download other language packs: 

1 Go to http://accounts.automatedlogic.com/download. 

2 Under Software Products and Updates, select v# language packs, where # is your WebCTRL 

version. 

3 Select the language you want. 

4 Follow the instructions under To install this language pack. 

NOTE  If you create a system by copying an existing system that uses language packs, install the same 

language packs on the new system. 

 

 
 

Preparing your workstation for non-English text 

NOTE  The instructions below are for a Windows XP operating system. If you have a different operating 

system, see your system's Help for instructions. 

  

Set up your workstation so you can type international characters in control programs, graphics, or 

SiteBuilder.  

1 Install the appropriate fonts for the languages you will be using. In the Windows Control Panel, 

open Fonts, select File > Install new fonts.  

2 In the Control Panel, open Regional and Language Options, then select the Input language.  
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3 Install an Input Method Editor (IME) for non-alphanumeric characters. 

  

 

See your operating system's Help for more information. 
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Creating control programs and translation files for a non-English system 

To have the WebCTRL® interface display a control program’s user-defined text (such as microblock 

names and property text) in a non-English language, you must: 

1 Create the control program using key terms instead of the text.  

2 Create translation files of key terms and their language-specific equivalents. 

In the WebCTRL® interface, the key term is replaced with its equivalent in the translation file for the 

current operator language. If a WebCTRL® Properties page or Logic page shows ??key term??, the key 

term is missing from the translation file.  

 

NOTE  To edit existing control programs or translation files, see Editing translation files or control 

programs for a non-English system (page 214). 

 

 
 

To enter a key term in the EIKON® application 

In the EIKON® Property Editor, type @ before each key term.  

  

  

NOTES 

 Type only the key term in the EIKON® application. Expressions such as $present_value$ are put in 

the translation file as part of the translated text. See EXAMPLES in "Translation files" below. 

 Key terms can contain only alphanumeric characters and underscores (no spaces) and cannot 

start with a number.  

 

 
 

Translation files 

Translation files are used to translate key terms in control programs. A translation file contains key 

terms and their language-specific equivalents.  

For a non-English system, you must create an English translation file and a non-English translation file* 

for each of the following: 

 Each control program 

 Key terms used in multiple control programs  
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EXAMPLES  

Translation files Key term=Language-specific equivalent 

English This_value=This value is $present_value$ 

Zone_temp=Zone temperature 

Spanish     This_value=Este valor es $present_value$ 

Zone_temp=Temperatura de zona 

*If the WebCTRL® interface will display multiple non-English languages, create a translation file for 

each language. 

 

 
 

To create and implement a translation file 

Create your translation file in a text editor, such as Microsoft® Word, that supports the character 

encoding you need. 

1 Type one key term and language equivalent per line, left justified, starting in column 1. Do not put 

spaces on either side of the equal sign.   

2 Save the file using the appropriate file name and location in the table below. 

  

If key terms are used 

in... 

the file name is... File location 

A single control program <any_name>_xx.native* Any location 

Multiple control 

programs 

equipment_xx.native* WebCTRL\webroot\ 

<system_name>\resources 

*  xx = the language extension code. See "Extension codes and encoding" below. 

  

If you are using: 

○ the English character set, save the file as Text only. 

○ a non-English character set, save the file as Encoded text . (See your application’s help for 

information on saving files as encoded text.) When prompted for the language and encoding, 

see “Extension codes and encoding” below. 

  

3 Open the control program in the EIKON® application, then select Control Program > Bundled 

Resources.  

4 Click  , locate and select the translation file(s) for this control program, then click Open. 

NOTES   

○ Do not add equipment_xx.native files that you created for multiple control programs. 

○ You can use Ctrl+click or Shift+click to select multiple files. 
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5 Save the control program. The translation files are embedded in the control program; the original 

files are no longer necessary. 

  

Extension codes and encoding 

Language Extension codes   Encoding* 

Brazillian Portuguese 

 

English 

 

Canadian French 

 

French 

 

German 

 

Italian 

 

Japanese 

 

Korean 

 

Russian 

 

Spanish 

 

Swedish 

 

Simplified Chinese 

 

Traditional Chinese 

 

Thai 

 

Vietnamese 

pt_BR 

 

en 

 

fr 

 

fr_FR 

 

de 

 

it 

 

ja 

 

ko 

 

ru 

 

es 

 

sv 

 

zh 

 

zh_TW 

 

th 

 

vi 

ISO-8859-1 

 

ISO-8859-1 

 

ISO-8859-1 

 

ISO-8859-1 

 

ISO-8859-1 

 

ISO-8859-1 

 

EUC-JP 

 

EUC-KR 

 

KOI8_R 

 

ISO-8859-1 

 

ISO-8859-1 

 

GB2312 

 

Big5 

 

TIS620 

 

Cp1258 

* Encoding is used when you create the translation file. 

 

 
 

Creating graphics for a non-English system 

To create a non-English graphic in ViewBuilder: 

1 Set the language font (page 211). 

2 Create the graphic. (page 211) 

3 Save the .view file. 

NOTE  The names of your .view file and any inserted image files must contain only ASCII characters. 
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Setting the language font 

If your system has language packs installed, you can select a font for each language. Your selection 

affects only how text in your graphic appears in ViewBuilder.  

To set the font for each language 

1 Select Configure > Preferences > Graphic (.view). 

2 On the Language tab, check the language that you want to be the default for all new graphics. 

  

To select the default language font for all new graphics 

In the Preview Font column, click the font name to select a different font.  

  

To select the active language when creating a view 

If you will use multiple language fonts in a single view, you can switch to a different language font as 

follows: 

1 Select Configure > View Properties. 

2 In the Language field, select the language you want to use.  

3 Click OK. 

 

 
 

To create a Non-English graphic 

The method you use to create a graphic that will be displayed in a non-English WebCTRL® system 

depends on the following: 

 If the WebCTRL® system will display only a single non-English language, create the graphic in that 

language.  

  

 If the WebCTRL® system will display multiple non-English languages, use either of the following 

methods: 

○ Create the graphic in layers (one layer for each language), and then assign a show/hide 

conditional expression (see format below) to each layer so that it displays in WebCTRL® based 

on the operator language. See "To show/hide a layer in the WebCTRL® interface" in 

ViewBuilder Help. 

○ Create each piece of the graphic in the different languages, and then assign a show/hide 

conditional expression (see format below) to each piece so that it displays in WebCTRL® based 

on the operator language. See "Setting objects on a graphic to show/hide in the WebCTRL® 

interface" in ViewBuilder Help. 
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Show/Hide conditional expression format 

$$operator_language$$='language' 

where language is the language code from the list below. 

 

For example, the conditional expression to display French would be: 

$$operator_language$$=='fr_FR' 

 

Language Language code 

Brazillian Portuguese 

 

English 

 

Canadian French 

 

French 

 

German 

 

Italian 

 

Japanese 

 

Korean 

 

Russian 

 

Spanish 

 

Swedish 

 

Simplified Chinese 

 

Traditional Chinese 

 

Thai 

 

Vietnamese 

pt_BR 

 

en 

 

fr 

 

fr_FR 

 

de 

 

it 

 

ja 

 

ko 

 

ru 

 

es 

 

sv 

 

zh 

 

zh_TW 

 

th 

 

vi 

 

 
 

Creating a non-English system in SiteBuilder 

To choose the language(s) for your system 

1 In SiteBuilder, select Configure > Preferences. 

2 Select the Language tab. 

3 Under Supported Languages, select each language that you want to be available in your system.  

NOTE  This list shows all installed language packs. To install additional languages, see Installing a 

language pack (page 206). 

4 In the System field, select the system Language (page 213). 

5 Click OK. 

6 Save your database. 
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To create your system 

To create your system in each language that the system will display: 

1 In SiteBuilder, select Configure > Preferences. 

2 Optional:  The Font tab shows the font that will be displayed in SiteBuilder for each language that 

you selected on the Language tab. To change a font, click on the name in the Preview Font column, 

then make a new selection. 

3 On the Language tab, select a language in the Current Session field. 

4 Click OK. 

5 Create your system. 

6 Save your database. 

7 If your system will display multiple languages: 

a) Select Configure > Preferences, select the Language tab, and select another language in the 

Current Session field. 

b) Re-enter all node names and display names in the current language. 

c) Save your database. 

d) Repeat steps a. through c. for each additional language the system will display. 

 

 
 

System language 

The system language is used for: 

 The default language for new operators 

 Alarms sent to the database 

 State text and object names downloaded to the field 

 The default login page * 

All other information is displayed in the operator’s language, which may be different than the system 

language. See To set an operator’s language in the WebCTRL® interface (page 213). 

*  You can change the language shown on the WebCTRL® login page by selecting a different language 

from the list below the Password field. 

 

 
 

To set an operator’s language in the WebCTRL® interface 

An operator can change their language preference in the WebCTRL® interface. 

1 On the System Configuration  tree, select My Settings. 

2 Under Preferences, select the Language in the drop-down list. 

3 Click Accept. 
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Editing translation files or control programs for a non-English system 

If you add or edit a key term in a control program, be sure to make the same change in the translation 

file. See Creating control programs and translation files (page 208). 

If you make changes after attaching a control program in SiteBuilder, do one of the following: 

 If you changed text only in a control program or its translation file, right-click the control program on 

the Geographic tree, then select Rebuild Equipment Pages. 

 If you changed logic in the control program, right-click the control program on the Geographic tree, 

then select Reload Control Program. 

 

 
 

To edit a bundled resource 

The EIKON® application bundles (embeds) the translation file(s) for a control program into the 

.equipment file. See steps 3 through 5 in To create and implement a translation file (page 209). To edit 

a bundled translation file:  

1 Open the control program in the EIKON® application.  

2 Select Control Program > Bundled Resources.  

3 Select the file, then click  to save it to your hard drive.  

4 Edit the translation file. 

5 In the Bundled Resources dialog box in the EIKON® application, click  and select the edited file. 

6 Click OK to overwrite the existing file. 

 

 
 

Editing an EIKON® for WebCTRL control program in the EIKON® application 

To edit a non-English control program that you created in the EIKON® for WebCTRL application: 

1 Open the .eiw or .equipment file in the EIKON® application, then make your edits. 

2 Select Control Program > Bundled Resources. 

3 Verify that the list shows all translation files specifically for the control program. Use the plus or 

minus button to add or delete translation files. 

NOTE  This list shows the translation files in the WebCTRL\webroot\<system_name>\programs 

folder. This list should not include translation files for multiple control programs. 

4 Click OK. 

5 Save the control program. The translation files are bundled with the control program; the original 

files are no longer necessary. 

  

NOTE  If you need to change a translation file after you save the control program, see To edit a bundled 

resource (page 214). 

 

 

 

 

 

 
 

Copying translation files to another system 
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To copy most translation files from one system to another, you copy the files in the source system and 

paste them into the same folders in the destination system. 

However, if your source system and destination system have translation files with the same name, 

copying and pasting would overwrite the file(s) in the destination system. In this case: 

1 Open the source system’s translation file in a text editor, then copy the key terms and translations. 

2 Open the destination system’s translation file in a text editor, then paste into it the key terms that 

you copied. Remove any duplicate key terms. 
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Document revision history 

 

Important changes to this document are listed below. Minor changes such as typographical or formatting 

errors are not listed. 

  

Date Topic Change description Code* 

4/24/19 Daylight Saving Tab Updated steps to require unzipping the file X-AE-EH-BR-R

B 

4/16/19 Recording reasons for edits Added acknowledging alarms AOC-R-TC-O 

11/14/1

8 

What's new in WebCTRL®  

Using a custom report as the 

source for a Graphics page 

Added note that when a color map graphic is viewed in 

Time-Lapse, the color map will ignore report data and 

show thermographic colors. 

AO-R-DD-O 

11/13/1

8 

What's new in ViewBuilder  

Creating a data table, chart, or 

color map from a WebCTRL® 

report 

Added note that when a color map graphic is viewed in 

Time-Lapse, the color map will ignore report data and 

show thermographic colors. 

AO-R-DD-O 

10/31/1

8 

To produce a color map Added a new optional step 7 describing the Include 

equipment color column checkbox. 

X-R-TC-O-DD 

9/27/18 What's new in SiteBuilder Added description of the new field Redirect HTTP 

requests to HTTPS. 

A-O-CY-BR 

9/25/19 Setting up BACnet Broadcast 

Management Devices (BBMDs) 

Changed 50 IP subnets to 100 IP subnets. X-D 

9/19/18 What's new in the WebCTRL® 

application 

Added security enhancement regarding Login page X-O-CY-E 

8/13/18 Formatting field codes The example for "To format a number" in the table stated 

"To always truncate a setpoint value…".  Changed to "To 

always round a setpoint value…". 

X-O-JD-E 

  

*  For internal use only 
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